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•	 Blu-ray is a trademark of Blu-ray Disc Association

•	 CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other 
countries.

•	 Other product and company names mentioned in this user’s manual may be the trademarks or registered trademarks 
of their respective holders.

NOTES
(1)	The contents of this user’s manual may not be reprinted in part or whole without permission.

(2)	The contents of this user’s manual are subject to change without notice.

(3)	Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable 
points, errors or omissions, please contact us.

(4)	Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed 
to result from using the Projector.
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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily 
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical 
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this 
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regula-
tions.
Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.
Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic prod-
ucts carrying the mark (left) must be disposed of separately from normal household waste. This includes 
projectors and their electrical accessories or lamps. When you dispose of such products, please follow the 
guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us 
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health 
and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member 
States.

WARNING
This is a Class A product. In a domestic environment this product may cause radio interference in which case the 
user may be required to take adequate measures.

CAUTION
•	 In order to reduce any interference with radio and television reception use a signal cable with ferrite core attached.

Use of signal cables without a ferrite core attached may cause interference with radio and television reception.
•	 This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radi-
ate radio frequency energy and, if not installed and used in accordance with the installation manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his own expense
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California 
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them 
carefully and heed all warnings.

 Installation
•	 Do not place the projector in the following conditions:

-	 on an unstable cart, stand, or table.
-	 near water, baths, or damp rooms.
-	 in direct sunlight, near heaters, or heat radiating appliances.
-	 in a dusty, smoky or steamy environment. 
-	 on a sheet of paper or cloth, rugs or carpets.

•	 If you wish to have the projector installed on the ceiling:
-	 Do not attempt to install the projector yourself.
-	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 

of bodily injury.
-	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 

with any local building codes.
-	 Please consult your dealer for more information.

WARNING
•	 Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of 

the cap due to the heat emitted from the light output.

•	 Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead 
to the object melting from the heat that is emitted from the light output. 

Orientation and Fan Mode

•	 Do not tilt the projector to the left or right. Doing so may result in malfunction. There is no limit on the tilt angle 
upward or downward. Select the appropriate option for [FAN MODE] according to the installation angle. 

	 Tilting the front of the projector up or down by more than 10° from level could reduce lamp life by up to 20%.

•	 When changing the projector orientation or installation angle, also change the [SETTING] option of [FAN MODE] 
accordingly. Failure to do so may cause product malfunction. (→ page 123, 124, 129)
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 Fire and Shock Precautions 
•	 Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your 

projector. Allow minimum spaces between your projector and a wall. (→ page v and vi)
•	 Do not try to touch the ventilation outlet on the rear side of the cabinet as it can become heated while the projector is 

turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if 
the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector 
operation. 

	 Use caution when picking up the projector.

	
•	 Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve 

any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your 
projector. If something should fall into your projector, disconnect it immediately and have the object removed by a 
qualified service personnel.

•	 Do not place any objects on top of the projector.
•	 Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
•	 The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply 

fits this requirement before attempting to use your projector.
•	 Do not look into the lens while the projector is on. Serious damage to your eyes could result.

	
•	 Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the 

lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause 
an unpredictable outcome such as a fire or injury to the eyes.

•	 Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent.
	 Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the ex-

haust.
•	 Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.

-	 Do not use any power cord other than the one specified by the manufacturer.
-	 Do not bend or tug the power cord excessively.
-	 Do not place the power cord under the projector, or any heavy object.
-	 Do not cover the power cord with other soft materials such as rugs.
-	 Do not heat the power cord.
-	 Do not handle the power plug with wet hands.

•	 Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under 
the following conditions:
-	 When the power cord or plug is damaged or frayed.
-	 If liquid has been spilled into the projector, or if it has been exposed to rain or water. 
-	 If the projector does not operate normally when you follow the instructions described in this user’s manual.
-	 If the projector has been dropped or the cabinet has been damaged.
-	 If the projector exhibits a distinct change in performance, indicating a need for service.

•	 Disconnect the power cord and any other cables before carrying the projector.
•	 Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
•	 Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
•	 When using a LAN cable:
	 For safety, do not connect to the connector for peripheral device wiring that might have excessive voltage.
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 CAUTION
•	 A minimum of two persons are required to carry the projector. Otherwise the projector may tumble or drop, caus-

ing personal injury.
•	 Keep hands away from the lens mounting portion while the lens shift is in operation.
	 Failure to do so could result in hands being pinched by the moving lens.
•	 Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hang-

ing on the wall can cause damage to the projector.
•	 Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the 

soft case could be damaged.
•	 Set [LAMP SELECT] and [LAMP INTERVAL MODE] if you continue to use the projector for consecutive days.

(From the menu, select [LAMP MODE] → [LAMP SELECT] and [LAMP INTERVAL MODE].)
•	 Before using Direct Power Off, be sure to allow at least 20 minutes immediately after turning on the projector and 

starting to display an image. 
•	 Do not unplug the power cord from the wall outlet or projector when the projector is powered on. Doing so can 

cause damage to the AC IN connector of the projector and (or) the prong plug of the power cord. 
	 To turn off the AC power supply when the projector is powered on, use the projector's main power switch or a 

power strip equipped with a switch and a breaker.
•	 Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blink-

ing blue. Doing so could cause premature lamp failure.
•	 Use of a wall outlet with a 20 A or more circuit breaker is recommended.

Performing Lens Calibration After Installation of the Optional Lens
Be sure to perform [CALIBRATION] after installation or replacement of the lens. (→ page 17, 126) Calibration corrects 
the adjustable zoom and focus range.
The following lenses need calibration:
•	 NP26ZL, NP27ZL, NP28ZL, NP29ZL

Caution on Carrying the Projector/Handling the Optional Lens
When shipping the projector with the lens, remove the lens before shipping the projector. Always attach the dust cap 
to the lens whenever it is not mounted on the projector. The lens and the lens shift mechanism may encounter damage 
caused by improper handling during transportation. 

Remote Control Precautions

•	 Handle the remote control carefully.

•	 If the remote control gets wet, wipe it dry immediately.

•	 Avoid excessive heat and humidity.

•	 Do not short, heat, or take apart batteries.

•	 Do not throw batteries into fire.

•	 If you will not be using the remote control for a long time, remove the batteries.

•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.

•	 Do not use new and old batteries together, or use different types of batteries together.

•	 Dispose of used batteries according to your local regulations.

Note for US Residents
The lamps in this product contain mercury. Please dispose according to Local, State or Federal Laws.
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Lamp Replacement
•	 Use the specified lamp for safety and performance.
•	 To replace the lamp, follow all instructions provided on page 185.
•	 Be sure to replace the lamp when the message [THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. 

PLEASE REPLACE THE LAMP 1 (or 2). USE THE SPECIFIED LAMP FOR SAFETY AND PERFORMANCE.] 
appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may 
shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause 
injury.

	 If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on 
and off will increase the possibility of its lower brightness.

 CAUTION:
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off 

and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
•	 When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass 

fragments could fall if the lamp has been burned out.

Clearance for Installing the Projector
Allow ample clearance between the projector and its surroundings as shown below.
Avoid installing the projector in a place where air movement from the HVAC is directed at the projector.
Heated air from the HVAC can be taken in by the projector's intake vent. If this happens, the temperature inside the 
projector will rise too high causing the over-temperature protector to automatically turn off the projectors power.

Example 1 – If there are walls on both sides of the projector.

50 cm/19.7" or greater 30 cm/12" or greater

NOTE:
The drawing shows the proper clearance required for the front, back and top of the projector.
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Example 2 – If there is a wall behind the projector.
(1) For floor installation:

70 cm/27.6" or greater

Lens

NOTE:
The drawing shows the proper clearance required for the back, sides and top of the projector.

(2) For ceiling mounting:

30 cm/12" or 
greater

70 cm/27.6" or greater

Lens

NOTE:
1.	The drawing shows the proper clearance required for the front, sides, back and bottom of the projector.
2.	If suspending the projector 30 cm/12 inches away from the ceiling, allow ample clearance for all four sides and the under the 

projector.

About High Altitude mode

•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters 
or higher.

	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] 
can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and 
turn on the projector.

•	 Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] 
can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

•	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of internal parts 
such as the lamp.
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About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue 
such as a coffee shop or hotel and employing compression or expansion of the screen image with the following func-
tions may raise concern about the infringement of copyrights which are protected by copyright law.
[ASPECT RATIO], [3D REFORM], [D-ZOOM] feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.
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Projector

Dust cap for lens
*	 The projector is shipped without a lens. For the types of 

lens and throw distances, see page 215.

1. Introduction
1 What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

NEC Projector CD-ROM
User’s manual (PDF)
(7N951663)

•	 Important Information (7N8N2114)
•	 Quick Setup Guide (7N8N2122/7N8N2132)
•	 Limited warranty (for North America)

For customers in Europe: 
You will find our current valid Guarantee Policy on our Web Site: 
www.nec-display-solutions.com

Remote control
(7N900961)

AA alkaline batteries 
(x2)

Power cord × 3

(79TM1021) (79TM1001 for AC 120 V) (79TM1011 for AC 200 V)

For Europe/Asia/South America For North America

Power cord stopper (79TM1111)
Anti-theft cap for LAN unit (for optional wireless LAN unit) (79TM1091)
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 Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector
This projector is one of the very best projectors available today. The projector enables you to project precise images up 
to 500 inches (200 inches on NP25FL) across (measured diagonally) from your PC or Macintosh computer (desktop 
or notebook), VCR, DVD player, or document camera.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, 
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1	Do not attempt to mount the projector on a ceiling yourself.

	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.

	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes. Please consult your dealer for more information.

 
Features you’ll enjoy:

•	 DLP® projector with high resolution and high brightness 

	 High resolution display – WUXGA (1920 × 1200) native resolution (16:10)

•	 Wide range of optional lenses selectable according to the place of installation

	 This projector supports 5 types of optional lenses, providing a selection of lenses adapted for a variety of instal-
lation requirements.

	 In addition, the lenses can be mounted and removed easily.

	 Note that no lens is mounted upon shipment from the factory. Please purchase optional lenses separately.

•	 Dual Lamp system

	 Two lamp system offers increased lamp life and energy savings along with redundancy.

•	 Double stackable for built in redundancy and high light output requirements

	 Double stacking projectors increase the brightness and visibility.

•	 EDGE BLENDING function

	 The EDGE BLENDING function allows a multi-screen image with high resolution to be displayed on a large 
screen.

•	 Powered Lens Shift, Zoom, and Focus offer installation flexibility

	 Powered Horizontal and Vertical lens shift provides the ability to project from off center screen installations. Powered 
zoom and focus provide quick and easy adjustment.

	 Note that focus can be adjusted manually on the NP25FL lens.

•	 360° installation angle (tilt-free)

	 The projector can be installed at any angle (360°).

	 Note, however, that the lamp life could be reduced depending on what angle the projector is tilted.

	 Also, the “FAN MODE” setting must be changed according to the angle of installation. The projector cannot be 
installed tilted to the left or right.

•	 Wide range of input/output connectors (HDMI, DisplayPort, BNC, etc.) 

	 The projector is equipped with a variety of input/output connectors: computer (analog), 5 BNC, HDMI, DisplayPort, 
Video, S-Video, etc. (The computer (analog) and BNC connectors also support component inputs.)

	 The projector’s HDMI and DisplayPort input connectors support HDCP.

•	 Slot for optional board

	 The projector has a slot for the optional board (SB-01HC or other NEC’s interface boards).
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•	 High picture quality processing circuit

	 The Reon-VX video processor is used to project high quality images.

•	 Energy-saving design with a standby power consumption of 0.5 Watts or less

	 When the on-screen menu’s standby mode is set to “Power Saving”, the power consumption in the standby mode 
is 0.5 W.

•	 “Eco mode” for low power consumption and “Carbon Meter” display

	 The projector is equipped with an “eco mode” for reducing power consumption during use. Furthermore, the 
power-saving effect when the eco mode is set is converted into the amount of reductions of CO2 emissions and 
this is indicated on the confirmation message displayed when the power is turned off and at “Information” on the 
on-screen menu (CARBON METER).

•	 Seamless switch function for smoother screen changes when switching the signal

	 When the input connector is switched, the image displayed before switching is held so that that projector can write 
the new image without going to black.

•	 Simultaneous display of 2 images (PIP/PICTURE BY PICTURE)

	 Two images can be projected simultaneously with a single projector.

	 There are two types of layouts for the two images: “picture-in-picture” in which a sub-picture is displayed on the 
main picture, and “picture-by-picture” in which the main and sub pictures are displayed next to each other.

•	 Security function for preventing unauthorized use

	 This projector is equipped with the following security functions:

-	 Password security: When a password is set in the on-screen menu, a screen to input the password appears 
when the projector’s power is turned on.

•	 Wired/wireless LAN compatibility (wireless LAN unit sold separately)

	 The projector is equipped with a LAN port (RJ-45) for connection to a wired LAN for transferring images from a 
computer to the projector, controlling the projector from a computer, etc.

	 Furthermore, the projector can be used in a wireless LAN by mounting the separately sold wireless LAN unit 
(NP02LM).

•	 Convenient utility software downloadable from the web

	 Five utility software programs (Image Express Utility 2.0, PC Control Utility Pro 4, Image Express Utility 2 for Mac, 
Virtual Remote Tool, and Viewer PPT Converter 3.0.) can be downloaded from our website.

•	 LAN-compatible viewer function

	 Still and moving images in shared folders on a computer connected by wired or wireless LAN can be projected 
with the projector’s viewer.

-	 The viewer supports the Windows Media Player 11’s “media sharing” function.

•	 CRESTRON ROOMVIEW compatibility

	 The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed 
and controlled from a computer or controller.

About this user’s manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to 
review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find 
an overview. If the section doesn’t apply, you can skip it.
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 Part Names of the Projector
Front/Top
The lens is sold separately. The description below is for when the NP27ZL lens is mounted.

Control Panel
(→ page 6)

Lens

Ventilation (inlet)

Filter Cover

Handle

Lens Hood

Security Locking Pin

Stacking Column

Lens Shroud

Remote Sensor (located on the 
front and the rear)

(→ page 9)

Terminal Panel
(→ page 7)

LED Lights (six locations)

Indicator Section
(→ page 6)

Lens Release Lever/Safety Lever 
(both levers are located inside the 

lens shroud.)
(→ page 163)

AC Input
Connect the supplied power cord's 
three-pin plug here, and plug the 
other end into an active wall outlet. 
(→ page 13)

Main Power Switch

USB (LAN) Port (for optional Wire-
less LAN Unit) (→ page 174)

Lens Cap
(The lens cap is attached to the 

lens.)

VOLTAGE SELECT Switch 
Use this switch according to the 
voltage being used. 
(→ page 13)

Adjustable Tilt Foot
(→ page 22)

Slot for Power Cord Stopper (→ 
page 14)



5

1. Introduction

Rear

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.

Remote Sensor (located on the 
front and the rear)

(→ page 9)

Ventilation (inlet)

Horizontal Adjustment Knob

Filter Cover (→ page 180, 188)

Ventilation (outlet)
Heated air is exhausted from here.

Lamp Cover (1)
(→ page 186, 187)

Lamp Cover (2)
(→ page 186, 187)

Stacking Column

Security Locking Pin

Adjustable Tilt Foot
(→ page 22)

Handle
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Control Panel/Indicator Section

1.	  (POWER) Button (→ page 17, 31)

2.	 POWER Indicator (→ page 17, 31, 228)

3.	 STATUS Indicator (→ page 228)

4.	 LAMP 1 and LAMP 2 Indicators (→ page 185, 228)

5.	 TEMP. Indicator (→ page 229)

6.	 SHUTTER Indicator (→ page 229)

7.	 SOURCE Button (→ page 20)

8.	 AUTO ADJ. Button (→ page 30)

9.	 3D REFORM Button (→ page 40)

10.	ORIENTATION/CALIBRATION Button (→ page 17, 19)

11.	SHUTTER/HOME POSITION Button (→ page 24, 34)

NOTE: The “home position” for lens shift position is not the center position of the adjustable lens shift range. The home position 
should be used for lens installation. 

12.	MENU Button (→ page 100)

13.	 Buttons (→ page 100)

14.	ENTER Button (→ page 100)

15.	EXIT Button (→ page 100)

16.	LENS SHIFT  Buttons (→ page 24)

17.	FOCUS +/− Buttons (→ page 26)

18.	ZOOM +/− Buttons (→ page 27)

19.	Light button 

	 Illuminates the control panel and the terminal panel.

219 3 4 5 6

1

12 13 1514 16

7 8 9 10 11

17 18
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Terminal Panel Features

1.	 COMPUTER 1 IN/ Component Input Connector (Mini D-Sub 15 Pin) (→ page 13, 166, 171)

2.	 COMPUTER 2 IN / Component Input Connector (Mini D-Sub 15 Pin) (→ page 166, 171)

3.	 COMPUTER 3 IN/Component (R/Cr, G/Y, B/Cb, H, V) Connectors (BNC × 5) (→ page 166, 171)

4.	 HDMI IN Connector (Type A) (→ page 167, 168, 172)

5.	 DisplayPort IN Connector (DisplayPort 20P)(→ page 167)

6.	 MONITOR OUT (COMP 1) Connector (Mini D-Sub 15 Pin) (→ page 169)

7.	 VIDEO IN Connector (BNC) (→ page 170)

8.	 S-VIDEO IN Connector (Mini DIN 4 Pin) (→ page 170)

9.	 LAN Port (RJ-45) (→ page 173)

10.	USB Port (Type A) (→ page 78)

11.	PC CONTROL Port (D-Sub 9 Pin) (→ page 233)

	 Use this port to connect a PC or control system. This enables you to control the projector using serial communica-
tion protocol. If you are writing your own program, typical PC control codes are on page 233.

12.	REMOTE Connector (Stereo Mini) 

	 Use this connector for wired remote control of the projector using the NEC optional remote control. 

	 Connect the projector and optional remote control using a commercially available wired remote control cable.

NOTE: 
•	 Connecting the remote cable to the REMOTE mini jack on the terminal panel will make the wireless operation unavailable.

13.	USB (LAN) Port  (for optional Wireless LAN Unit) (→ page 174)

14.	Optional Slot (SLOT) (→ page 219) 

9 4 5 3 810 2 1 7

13 11 12 14 6
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 Part Names of the Remote Control

1.	 Infrared Transmitter
	 (→ page 9)

2.	 POWER ON Button
	 (→ page 17)

3.	 POWER OFF Button
	 (→ page 31)

4, 5, 6. COMPUTER 1/2/3 Button
	 (→ page 20) 
7.	 AUTO ADJ. Button
	 (→ page 30)

8.	 VIDEO Button
	 (→ page 20)

9.	 S-VIDEO Button
	 (→ page 20)

10.	HDMI Button (→ page 20)

11.	DisplayPort Button (→ page 20)

12.	VIEWER Button (→ page 20, 74)

13.	NETWORK Button (→ page 20)

14.	SOURCE Button (→ page 20)

15.	PIP Button (→ page 20, 43)

16.	ID SET Button (→ page 128)
17.	Numeric Keypad Button/CLEAR Button
	 (→ page 128)

18.	MENU Button (→ page 100)
19.	EXIT Button (→ page 100)

20.	 Button (→ page 100)

21.	ENTER Button (→ page 100)

22.	L-CLICK Button* (→ page 39)
23.	R-CLICK Button* (→ page 39)
24.	VOLUME (+)(−) Button (Not available)
25.	D-ZOOM (+)(−) Button (→ page 35)
26.	PAGE / Button* (→ page 39)
27.	PICTURE Button (→ page 109, 111)
28.	ECO Button (→ page 36)

29.	ASPECT Button (→ page 114)
30.	AV-MUTE Button (→ page 34)
31.	3D REFORM Button (→ page 40)
32.	FREEZE Button (→ page 34)
33.	SHUTTER Button (→ page 34)
34.	LENS SHIFT Button (→ page 24)
35.	FOCUS/ZOOM Button (→ page 26, 27)
36.	HELP Button (→ page 134)

*	 The PAGE /, , L-CLICK and R-CLICK buttons work only when a USB cable is connected with your com-
puter.

1

3
5
4
8
9

12
13

2
6
7
11
10
15
14

17

16

18

22

24

25
27
28

21

19

20

23

26

29

30

33
34

32
31
36
35
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Battery Installation

Remote Control Precautions
•	 Handle the remote control carefully.
•	 If the remote control gets wet, wipe it dry immediately.
•	 Avoid excessive heat and humidity.
•	 Do not short, heat, or take apart batteries.
•	 Do not throw batteries into fire.
•	 If you will not be using the remote control for a long time, remove the batteries.
•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.
•	 Do not use new and old batteries together, or use different types of batteries together.
• 	 Dispose of used batteries according to your local regulations.

7 m/22 feet 7 m/22 feet

30°

30°

30°

30°

30°

30°

30°

30°

7 m/22 feet7 m/22 feet

Remote control

Remote sensor on projector cabinet

Operating Range for Wireless Remote Control
•	 The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of 

the remote sensor on the projector cabinet.
•	 The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls 

on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

1 Press the catch and remove 
the battery cover.

2 Install new ones (AA). Ensure 
that you have the batteries’ polar-
ity (+/−) aligned correctly.

3 Slip the cover back over the batteries until it 
snaps into place.
NOTE: Do not mix different types of batteries or 
new and old batteries.

1

2 1
2
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 Operating Environment for Downloadable Software
The following software programs can be downloaded from our website.

Name of software program Features

Image Express Utility 2.0 •	 This is a software program used to send the screens of your personal comput-
ers to the projector via wired/wireless LAN (Meeting mode).

	 Projected images can be transferred and saved to personal computers.
	 When “Meeting Mode” is used, projected images can be sent and saved to 

the personal computers. Images can be sent from a personal computer to 
not only one projector but also to two or more projectors at the same time. 
(→ page 194)

PC Control Utility Pro 4 This is a software program used to operate the projector from the computer when 
the computer and the projector are connected with LAN (wired or wireless) or 
a serial cable. (→ page 205)

Image Express Utility for Mac •	 This is a software program used to send the Mac’s screen image to the projec-
tor over a network (wired or wireless LAN). For Mac’s operating environment, 
see page 206.

Virtual Remote Tool When the computer and projector are connected using a network (wired/wireless 
LAN), such operations as turning the projector’s power on and off and switching 
the signal can be performed. It is also possible to send an image to the projector 
and register it as the background logo. Once the image is registered, it can be 
locked to prevent the logo from being overwritten. (→ page 210)

Viewer PPT Converter 3.0 This is a software program used to convert files created with PowerPoint into 
JPEG files that can be displayed with the viewer function of the projector when 
a USB memory device is inserted into the projector. (→ page 213)

* A separately sold wireless LAN unit is required to use a wireless LAN.

NOTE:
•	 Image Express Utility for Mac does not support “Meeting Mode” which is provided in Image Express Utility 2.0.

Download service
For downloading or updating these software programs, visit our website:
URL: http://www.nec-display.com/dl/en/index.html
 

http://www.nec-display.com/dl/en/index.html
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Operating Environment
The following is the operating environment for Image Express Utility 2.0. For the operating environment of other soft-
ware program, refer to the help function of each software program.

Supported OS Windows 7 Home Basic
Windows 7 Home Premium
Windows 7 Professional
Windows 7 Ultimate
Windows 7 Enterprise
Windows Vista Home Basic
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise
Windows XP Home Edition Service Pack 2 or later
Windows XP Professional Service Pack 2 or later
Windows XP Tablet PC Edition 2005 or later (Windows XP Tablet PC Edition Service 
Pack 2 or later)
•	 Only 32-bit version
*	 “Easy Connection” supports the Administrative privileges of Windows XP and Windows 7/ 

Windows Vista only
•	 Windows power-saving function is not supported.

Processor •	 Windows 7/Windows Vista
Pentium 4/Pentium M 800 MHz equivalent or higher required
Dual core 1 GHz or higher recommended

•	 Windows XP
Pentium III 800 MHz or higher required
Pentium 4 1.6 GHz or higher recommended

Memory •	 Windows 7/Windows Vista
512 MB or more required
1 GB or more recommended

•	 Windows XP
128 MB or more required
192 MB or more recommended
* More memory may be required to run additional applications simultaneously.

Graphic processor •	 Windows 7/Windows Vista
The “Graphics” score 3.0 or more of “Windows Experience Index” recommended.

Network environment TCP/IP-compatible wired LAN or wireless LAN
(* Use a wireless LAN unit complying with the Wi-Fi standard.)

Resolution •	 Windows 7/Windows Vista 
SVGA (800 × 600) or higher required
XGA (1024 × 768) recommended 

•	 Windows XP 
VGA (640 × 480) or higher required
XGA (1024 × 768) recommended

Screen Colors High Color (15 bits, 16 bits)
True Color (24 bits, 32 bits) (recommended)
•	 256 or fewer colors are not supported.
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This section describes how to turn on the projector and to project a picture onto the screen.

 Flow of Projecting an Image

Step 1
•	 Connecting your computer / Connecting the supplied power cord (→ page 13)

	

Step 2 
•	 Turning on the projector (→ page 16)

	

Step 3 
•	 Selecting a source (→ page 20)

	

Step 4
•	 Adjusting the picture size and position (→ page 21)

•	 Correcting keystone distortion [KEYSTONE] (→ page 28)

	

Step 5
•	 Adjusting a picture

-	 Optimizing a computer signal automatically (→ page 30)

	

Step 6
•	 Making a presentation

	

Step 7
•	 Turning off the projector (→ page 31)

	

Step 8
•	 Carrying the projector (→ page 33)

2. Projecting an Image (Basic Operation)
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 Connecting Your Computer/Connecting the Supplied Power 
Cord
NOTE:
•	 Install a lens before performing the following steps. (→ page 163)
1.	 Connect your computer to the projector.

	 This section will show you a basic connection to a computer. For information about other connections, see “(2) 
Making Connections” on page 166.

	 Connect the computer cable (VGA) between the projector’s COMPUTER 1 IN connector and the computer’s port 
(mini D-Sub 15 Pin). Turn two thumb screws of both connectors to fix the computer cable (VGA).

2.	 Connect the supplied power cord to the projector.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

•	 Use the VOLTAGE SELECT switch according to the voltage being used. Select “100V” for 100 to 130V and “200V” 
for 200 to 240V. 

	 Important Information:

•	 When plugging in or unplugging the supplied power cord, make sure that the main power switch is pushed to 
the off [O] position. Failure to do so may cause damage to the projector.

•	 Do not use a three-phase power supply. Doing so may cause malfunction.

	 First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other 
plug of the supplied power cord in the wall outlet.

COMPUTER 1 IN

Make sure that the prongs are fully inserted into 
both the AC IN and the wall outlet.

Main power switch

To wall outlet

Using the Supplied Power Cords
Select the power cord suitable for your country or region.

For Europe/Asia/South America For North America

(120 V) (200 V)

(→ page 225)
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Using the Power Cord Stopper
To prevent the power cord from accidently removing from the AC IN of the projector, attach the power cord stopper 
to clamp the power cord.

NOTE:
•	 Do not clamp the power cord with other cables. Doing so can generate noise, which can affect adversely the signal cable.

 CAUTION
•	 Do not bundle the power cord. Doing this could cause heat or a fire.

•	 Do not clamp two power cords that would be used when stacking two projectors. Doing this could cause a 
fire.

NOTE: Be careful not to insert the band inversely. Once the band is attached, it cannot be removed from the slot.

Attaching the power cord stopper
1.	 Insert the end of band of the power cord stopper into the slot next to the AC IN on the terminal panel.

2.	 Use the power cord stopper to clamp the power cord.

	 Push the clamper to lock it.

Clamper

3.	 Slide the clamper to the hilt of the power cord.
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Removing the power cord from the power cord stopper

1.	 Push the clamper of the power cord stopper to unclasp it.

2.	 Push the power cord clamper to open it wide enough to pull out the power cord.

Clamper



16

2. Projecting an Image (Basic Operation)

 Turning on the Projector
NOTE:
•	 The projector has two power switches: A main power switch and a POWER button (POWER ON and OFF on the remote control)
• Turning on the projector:
1.	 Press the main power switch to the ON position (I).

	 The projector will go into standby mode.

2.	 Press the POWER button .

	 The projector will become ready to use.

• Turning off the projector:
1.	 Press the POWER button.

	 The confirmation message will be displayed.

2.	 Press the POWER button again.

	 The projector will go into standby mode.

3.	 Press the main power switch to the OFF position (O).

	 The projector will be turned off.

 

Remove the lens cap.

1.	 Press the main power switch to the ON position ( I ). 

	 The projector will go into standby mode. When in standby 
mode, the POWER indicator will light orange and the STA-
TUS indicator will light green when [NORMAL] is selected 
for [STANDBY MODE]. See the Power Indicator section.
(→ page 228) 

	 When you are working in a dark room, it is convenient to 
use the LED lights on the projector.

	 Press the LIGHT button to turn on the LED lights to illu-
minate the control panel and the terminal panel; press it 
again to turn off the LED light.



17

2. Projecting an Image (Basic Operation)

2.	 Press the  (POWER) button on the projector cabinet 
or the POWER ON button on the remote control. 

	 The POWER indicator will turn to blue and the projector 
will become ready to use.

TIP: 
•	 When the message “PROJECTOR IS LOCKED! ENTER YOUR 

PASSWORD.” is displayed, it means that the [SECURITY] 
feature is turned on. (→ page 45)

•	 When the ECO message is displayed, it means that [ON] is 
selected for [ECO MESSAGE]. (→ page 122)

	 After you turn on your projector, ensure that the computer 
or video source is turned on.

NOTE: When no signal is available, the NEC logo (default), blue, or 
black screen will be displayed.
 

Performing Lens Calibration 
After installation or replacement of the lens, be sure to perform 
[CALIBRATION] by pressing and holding the ORIENTATION 
button for at least two seconds. Calibration corrects the ad-
justable zoom and focus range. If calibration is not performed, 
you may not be able to get the best focus and zoom even if 
you adjust the focus and zoom for the lens. 
•	 The following lenses need calibration:
	 NP26ZL, NP27ZL, NP28ZL, NP29ZL

Standby Blinking Power On

Steady orange 
light

Blinking blue 
light

Steady blue 
light

(→ page 228)
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Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one 
of the 27 menu languages.

To select a menu language, follow these steps:

1.	 Use the , H, F or E button to select one of the 27 lan-
guages from the menu.

2.	 Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu opera-
tion.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 103 and 121)

NOTE: 
•	 Turning the power back on directly after it is turned off (by direct power off) while an image is being projected can result in 

malfunction. Be sure to wait at least 1 second before turning the power back on.
•	 Keep the lens cap off the lens while the projector’s power is on.
	 If the lens cap is on, it could be warped due to high temperature.
•	 If one of the following things happens, the projector will not turn on.

-	 If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the 
projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool 
down.

-	 Starting under low temperature conditions
	 If the usage environment temperature is lower than the projector’s operating temperature, the TEMP. indicator will flash. Increase 

the usage environment temperature to 0°C or higher and turn on the projector again.
	 If you turn on the projector at around 0°C, it may take 5 minutes to warm up the projector.
	 During warm-up, the TEMP. indicator will flash. When the warm-up is completed, the TEMP. indicator will light out.
-	 When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
-	 If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. 

Cancel the lock by turning it off. (→ page 127)
-	 If the lamp fails to light, and if the LAMP 1 or LAMP 2 indicator flashes on and off in a cycle of six times, wait a full minute and 

then turn on the power.
•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
•	 Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is 

stabilized.
•	 When the projector is turned on, it may take some time before the lamp light becomes bright.
•	 If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without display-

ing an image for some time and then the projector will display the image.
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If the projected image is inverted or upside down
1	 Press the ORIENTATION button. 

	 The [ORIENTATION] screen will be displayed.

2	 Press again to select a correct orientation.

	 Each time the ORIENTATION button is pressed, the choice you highlight 
will be changed.

DESKTOP FRONT DESKTOP REAR

CEILING FRONT CEILING REAR

3	 Stop pressing the ORIENTATION button.

	 The menu will be closed in about two seconds and the projected image 
will be displayed in the orientation you select.

	 A confirmation message will be also displayed.

4	 Press the ENTER button. 

	 The confirmation message will be closed.
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 Selecting a Source
Selecting the computer or video source
NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button once. The projector will search for the available 
input source and display it. The input source will change as follows: 

COMPUTER1 → COMPUTER2 → COMPUTER3 → HDMI → DisplayPort 
→ VIDEO → S-VIDEO → VIEWER → SLOT → COMPUTER1 → ...

•	 With the SOURCE screen displayed, you can press the SOURCE 
button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMPUTER1, COMPUTER2, COMPUTER3, HDMI, 
DisplayPort, VIDEO, S-VIDEO, VIEWER, or NETWORK buttons.

Selecting Default Source 
You can set a source as the default source so that it will be displayed 
each time the projector is turned on.

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the  button twice to select [SETUP] and press the H but-
ton or the ENTER button to select [BASIC].

3.	 Press the  button five times to select [OPTIONS(2)].

4.	 Press the H button five times to select [DEFAULT SOURCE 
SELECT] and press the ENTER button.

	 The [DEFAULT SOURCE SELECT] screen will be displayed.

	 (→ page 132)

5.	 Select a source as the default source, and press the ENTER but-
ton.

6.	 Press the EXIT button a few times to close the menu.

7.	 Restart the projector.

	 The source you selected in step 5 will be projected.

NOTE: Even when [AUTO] is turned on, the [NETWORK] will not be automatically 
selected. To set your network as the default source, select [NETWORK].

TIP: 
•	 When the projector is in Standby mode, applying a computer signal from a 

computer connected to the COMPUTER 1/3 IN input will power on the projector 
and simultaneously project the computer’s image.

	 ([AUTO POWER ON(COMP1/3)] → page 132)
•	 On the Windows 7 keyboard, a combination of the Windows and P keys allows 

you to set up external display easily and quickly.
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 Adjusting the Picture Size and Position
Use the horizontal adjustment knob and adjustable tilt feet to finely tilt the projector; use the LENS SHIFT, ZOOM, 
and FOCUS buttons to adjust the picture size and position.
In this chapter drawings and cables are omitted for clarity.

Tilting the projector
[Horizontal adjustment knob/Tilt feet]

Adjusting the projected image’s vertical and horizontal 
position
[Lens shift]

(→ page 22) (→ page 24)

Adjusting the focus
[Focus]

Finely adjusting the size of an image
[Zoom]

(→ page 26) (→ page 27)

Adjusting the keystone correction
[Keystone]

(→ page 28)

TIP:
•	 Built-in test patterns can be conveniently used for adjusting the picture size and position. (→ page 105)
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CAUTION •	 Perform the adjustment from behind or from the side of the projector. Adjusting from 
the front could expose your eyes to strong light which could injure them. The rear 
vents of the projector may become heated during normal projector operation. Use 
caution when adjusting the tilt foot on the rear side. 

•	 Keep hands away from the lens mounting portion while the lens shift is in operation. 
Failure to do so could result in hands being pinched by the moving lens.

Tilting the projector
The projector must be placed square to the screen otherwise keystone distortion may appear on the screen. This sec-
tion provides explanation on how to place the projector perpendicular to the screen when viewed from the side.

1.	 Lower the front and back tilt feet.

2.	 Use the horizontal adjustment knob to finely tilt the projector so that the projector is set to be parallel with 
the screen.

	 Make sure that the top edge of the image is parallel with the bottom edge of the image.

	 Adjustable range: 4°

Screen

Parallel

Clockwise

Counter-
clockwise

Horizontal adjustment knob

3.	 Rotate the two front tilt feet to adjust the height to keep the projector level so that the top edge of the screen 
is parallel with the top edge of the projected image.

	 Adjustable range: 1.8°

Screen
Parallel

Lower

Raise

Front tilt foot
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4.	 Rotate each of the tilt feet to adjust the height while keeping the projector level with the floor/ceiling and 
perpendicular to the screen when viewed from the side.

	 To raise the front side of the projector, extend the left and right tilt feet.

	 To lower the front side of the projector, extend the rear foot.

	 Adjustable range: 2°

Screen

90°

Lower

Raise

Front tilt foot

 
NOTE:
•	 Do not lengthen each of the tilt feet any more than 13 mm/0.51". The force of doing so may cause the tilt foot to come off, result-

ing in damage to the projector.
•	 Do not use the tilt feet for any purpose other than adjusting the projector’s projection angle.
	 Do not attempt to carry or mount the projector using the tilt feet. Doing so may result in damage to the projector or personal 

injury.
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Adjusting the vertical position of a projected image (Lens shift)

NOTE:
•	 The lens shift function is not available on the projector with NP25FL (fixed focus) lens installed. 
	 Return the lens shift position to the home position before installing the lens to the projector.
•	 Shifting the lens to the maximum in two directions combined will cause the edges of the image to become dark or will cause 

some shadows.

Adjusting with buttons on the cabinet
1.	 Press one of the LENS SHIFT ▼▲◀▶ buttons.

2.	 Use the LENS SHIFT ▼▲◀▶ buttons to move the projected image.

Returning the lens shift position to the home position
Press and hold the SHUTTER/HOME POSITION button for 2 seconds to return the lens shift position to the home 
position (nearly center position)
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Adjusting with the remote control
1.	 Press the LENS SHIFT button.

	 The Lens Shift screen will be displayed. 

2.	 Press the ▼▲◀ or ▶ button.

	 Use the ▼▲◀▶ buttons to move the projected image.

TIP: 
•	 The diagram below shows the lens shift adjustment range for the desktop front. To raise the projection position higher than this, 

use the tilt feet. (→ page 22)

1V

1H0.2H 0.2H

0.55V

0.4V

Height of projected image

Width of projected image
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Focus
Applicable lens: NP26ZL/NP27ZL/NP28ZL/NP29ZL
Use the FOCUS (+) or (−) button on the projector cabinet to obtain the best focus.

TIP: To obtain the best focus, perform the following (for fixed installation)
Preparation: Warm up the projector for one hour.
1.	Use the FOCUS +/− buttons to make sure you obtain the best focus. If you do not, move the projector back and forth.
2.	Select the [TEST PATTERN] from the menu and display the test pattern. (→ page 105)
3.	Keep pressing the FOCUS − button until the grid of the text pattern is made invisible.
4.	Keep pressing the FOCUS + button until you obtain the best focus.
	 If you adjust beyond the best focal point, go back to step 3 and repeat the procedures.

NOTE:
•	 Use the focus ring to obtain the best focus on the NP25FL lens.
 

Adjusting with buttons on the remote control
1.	 Press the FOCUS/ZOOM button to display the adjustment win-

dow.

2.	 Use the ◀ or ▶ button to adjust the focus.

3.	 Press the FOCUS/ZOOM button again to close the adjustment 
window.
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Zoom
Use the ZOOM (+) or (−) button on the projector cabinet to zoom in or out.

Adjusting with buttons on the remote control
1.	 Press the FOCUS/ZOOM button to display the adjustment win-

dow.

2.	 Press the ▼ button to select [ZOOM].

3.	 Use the ◀ or ▶ button to zoom in or out.

4.	 Press the FOCUS/ZOOM button again to close the adjustment 
window.
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 Correcting Keystone Distortion
When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use 
the “Keystone” function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square 
image.
The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distor-
tions.
When the projector is placed diagonally to the screen, 
When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu 
so that the top and bottom of sides of the projected image are parallel.

1.	 Press the 3D REFORM button on the remote control or the projec-
tor cabinet.

	 The Keystone screen will be displayed on the screen.

2.	 Press the  button to select [VERTICAL] and then use the  or  
so that the left and right sides of the projected image are parallel.

* Adjust the vertical keystone distortion.

3.	 Align the left (or right) side of the screen with the left (or right) side 
of the projected image.

•	 Use the shorter side of the projected image as the base.

•	 In the right example, use the left side as the base.

4.	 Press the  button to select [HORIZONTAL] and then use the  or 
 so that the top and bottom sides of the projected image are par-
allel.

•	 Adjust the horizontal keystone distortion.

Screen frame
Projected area

Align left side
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NOTE:
•	 If the projection angle is the same as in the last use, the previous correction setting values are retained in the memory.
•	 When doing Step 2, adjust the position of image so that the screen is smaller than the area of the projected area.
•	 To reset the 3D Reform correction setting values, press and hold the 3D REFORM button for a minimum of 2 seconds.
•	 Each time the 3D REFORM button is pressed, the item will change as follows: KEYSTONE → CORNERSTONE → None → KEY-

STONE → ...
For information on [CORNERSTONE], see “Correcting Horizontal and Vertical Keystone Distortion (Cornerstone)” on page 40.
•	 The Cornerstone adjustment will not be available during the Keystone adjustment. To perform the Cornerstone adjustment, press 

and hold the 3D REFORM button for a minimum of 2 seconds to reset the Keystone correction setting values. The Keystone 
adjustment will not be available during the Cornerstone adjustment. To perform the Keystone adjustment, press and hold the 3D 
REFORM button for a minimum of 2 seconds to reset the Cornerstone correction setting values.

•	 The 3D Reform feature can cause an image to be slightly blurred because the correction is made electronically.

5.	 Repeat steps 2 and 4 to correct keystone distortion.

6.	 After completing Keystone correction, press the EXIT button.

	 The Keystone screen will disappear.

•	 To perform Keystone correction again, press the 3D REFORM button 
to display the Keystone screen and repeat above steps 1 to 6.
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 Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust
Optimizing a computer image automatically. (COMPUTER1/COMPUTER2/COMPUTER3)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
•	 If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] 

manually. (→ page 112, 113)
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 Turning off the Projector
To turn off the projector:

1.	 First, press the  (POWER) button on the projector 
cabinet or the POWER OFF button on the remote con-
trol. 

	 The [POWER OFF / ARE YOU SURE ? / CARBON SAV-
INGS- SESSION 0.000[g-CO2]] message will appear.

2.	 Secondly, press the ENTER button or press the  
(POWER) or the POWER OFF button again.

	 The lamp will turn off and the projector will go into standby 
mode. When in standby mode, the POWER indicator will 
light orange and the STATUS indicator will light green when 
[NORMAL] is selected for [STANDBY MODE]. 

3.	 Press the main power switch to the OFF position (O). 

	 The POWER indicator will go off and the main power will 
turn off.

Power On

Steady blue light

Standby

Steady orange lightPress twice
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 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.

NOTE:
•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off.
•	 You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
•	 Wait at least 20 minutes after the power is turned on (after starting to project) before turning the AC power off while an image is 

being projected or while the cooling fan is running.
•	 Do not unplug the power cord from the projector or from the power outlet while an image is being projected. Doing so could 

deteriorate the projector’s AC input connector or the power plug’s contact. To turn off the AC power while an image is being 
projected, use the projector's main power switch, the power strip’s switch, the breaker, etc.

•	 Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing 
the menu. Doing so can cause loss of adjustments and settings.

•	 Do not turn off the main power using the Main Power Switch or by disconnecting the power to the projector while lens adjust-
ments are being performed. If power is removed while the lens is moving, you may not be able to achieve the best possible lens 
adjustments after restarting the projector.
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 Carrying the Projector
Preparation: Make sure that the projector is turned off.

1.	 Unplug the power cord.

2.	 Disconnect any other cables.
•	 Remove the USB memory if it is inserted into the projector.

•	 Remove the lens before shipping the projector.

3.	 Mount the lens cap on the lens.

4.	 Before moving the projector, screw in the tilt feet if they have been lengthened.

NOTE:
•	 Do not apply strong shock or force to the projector while carrying the projector.
•	 Remove the lens before moving the projector. Attach the lens cap to the lens and the dust cap to the lens hood of the projector.
•	 Use the original carton when shipping the projector without the lens. Improper packaging may cause damage to the projector 

during shipping.
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1 Blocking the lamp light (LENS 
SHUTTER)
Press the SHUTTER/HOME POSITION button to block the lamps light 
from hitting the screen. Press again to allow the screen to become il-
luminated again.
•	 Another way to shut the lamp light off is to press the SHUTTER button 

on the remote control.

NOTE: 
•	 Do not press and hold the SHUTTER/HOME POSITION button for 2 seconds or 

longer.
	 Doing so will cause the lens shift position to return to the home position.
 

 Turning off the Image
Press the AV-MUTE button to turn off the image for a short period of time. 
Press again to restore the image.

The projector’s power-saving function will work in some seconds after the 
image is turned off. As a result, the lamp power will be reduced.

NOTE:
•	 To restore the image, even if you press the AV-MUTE button immediately after 

the start of the power-saving function, the lamp brightness may not be restored 
to its original level.

 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume 
motion.

NOTE: The image is frozen but the original video is still playing back.
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 Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on 
the signal.

To do so:

1.	 Press the D-ZOOM (+) button to magnify the picture.

2.	 Press the  button.
	 The area of the magnified image will be moved

3.	 Press the D-ZOOM (−) button.

	 Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE: 
•	 The image will be enlarged or reduced at the center of the screen.
•	 Displaying the menu will cancel the current magnification.
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 Changing Eco Mode/Checking Energy-Saving Effect Using 
Eco Mode [ECO MODE]
This feature enables you to select two brightness modes of the lamp:
OFF and ON modes. The lamp life can be extended by turning on the [ECO MODE].

[ECO MODE] Description

[OFF] This is the default setting (100% Brightness).

[ON] Low lamp power consumption (approx. 75% Brightness).

To turn on the [ECO MODE], do the following: 
1.	 Press the ECO button on the remote control to display [ECO MODE] screen.

2.	 Use the  or  button to select [ON].

3.	 Press the ENTER button. 

	 To change from [ON] to [OFF], Go back to Step 2 and select [OFF]. Repeat Step 3.

NOTE: 
•	 The [ECO MODE] can be changed by using the menu.
	 Select [SETUP] → [BASIC] → [LAMP MODE] → [ECO MODE].
•	 The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] →[USAGE TIME].
•	 [ECO MODE] is always set to [OFF] immediately after the lamp is turned on. The lamp condition will not be affected even when 

[ECO MODE] is changed.
•	 After a lapse of 1 minute from when the projector displays a blue, black or logo screen, [ECO MODE] will automatically switch to 

[ON]. 
•	 If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [ON] mode 

to protect the projector. This is called “Forced ECO Mode”. When the projector is in the Forced Eco Mode, the picture brightness 
decreases slightly and the TEMP. indicator lights orange. At the same time the Thermometer symbol [  ] is displayed at the bot-
tom right of the screen.

	 When the projector comes back to normal temperature, the Forced Eco Mode is cancelled and the [ECO MODE] returns to [OFF] 
mode.
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Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO MODE] 
is set to [ON]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON 
SAVINGS] message shows the total amount of CO2 emission reduction from the time of shipment up to now. You can 
check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 134)

The [CARBON SAVINGS-SESSION] message shows the amount of CO2 emission reduction between the time of 
changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-
SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE ?] message at the time of power-off.

TIP:
•	 The formula as shown below is used to calculate the amount of CO2 emission reduction.
	 Amount of CO2 emission reduction = (Power consumption in [OFF] for ECO MODE − Power consumption in [ON] for ECO MODE) 

× CO2 conversion factor.* When the image is turned off, the amount of CO2 emission reduction will also increase.
	 * �Calculation for amount of CO2 emission reduction is based on an OECD publication “CO2 Emissions from Fuel Combustion, 2008 

Edition”.
•	 The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
•	 This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
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 Using the Optional Remote Mouse Receiver (NP01MR)
The optional remote mouse receiver enables you to operate your computer’s mouse functions from the remote control. 
It is a great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer
If you wish to use the remote mouse function, connect the mouse receiver and computer.
The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change 
your computer settings.

Remote mouse receiver

Computer

To USB port of PC or Macintosh

When operating a computer via the remote mouse receiver

Remote sensor on the remote mouse receiver

7 m/22 feet

When connecting using the USB terminal
For PC, the mouse receiver can only be used with a Windows XP*, Windows Vista, Windows 7, or Mac OS X 10.0.0 
or later operating system.

* NOTE: In SP1 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer 
Options tab].

NOTE: The PAGE  and  buttons do not work with PowerPoint for Macintosh.

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may not 
identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.
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Operating your computer’s mouse from the remote control
You can operate your computer’s mouse from the remote control.

PAGE / Button	� scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint on your 
computer.

 Buttons	���� moves the mouse cursor on your computer.
L-CLICK Button	������ works as the mouse left button.
R-CLICK Button	����� works as the mouse right button.

NOTE:
•	 When you operate the computer using the  or  button with the menu displayed, both the menu and the mouse pointer 

will be affected. Close the menu and perform the mouse operation.
•	 The PAGE  and  buttons do not work with PowerPoint for Macintosh.

About Drag Mode:
By pressing the L-CLICK or R-CLICK button for 2 or 3 seconds then releasing, the drag mode is set and the drag 
operation can be performed simply by pressing the  button. To drop the item, press the L-CLICK (or R-CLICK) 
button. To cancel it, press the R-CLICK (or L-CLICK) button.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user 
documentation or online help supplied with your computer.
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 Correcting Horizontal and Vertical Keystone Distortion 
[CORNERSTONE]

Use the 3D Reform feature to correct keystone (trapezoidal) distortion to make the top or bottom and the left or right 
side of the screen longer or shorter so that the projected image is rectangular.

Cornerstone
1.	 Press and hold the 3D REFORM button for a minimum of 2 seconds to reset current adjustments.

	 Current adjustments for [KEYSTONE] or [CORNERSTONE] will be cleared.

2.	 Project an image so that the screen is smaller than the area of the raster.

3.	 Pick up any one of the corners and align the corner of the image with a corner of the screen.

Projected image

The drawing shows the up-
per right corner.

4.	 Press the 3D REFORM button twice.

	 The Cornerstone adjustment screen is displayed.

5.	 Use the  button to select one icon () which points in the direction you wish to move the projected 
image frame.

6.	 Press the ENTER button.

TIP: If you are adjusting [KEYSTONE], [CORNERSTONE] will not be 
available. If this happens, press and hold the 3D REFORM button for a 
minimum of 2 seconds to reset the [KEYSTONE] adjustments.

The drawing shows the upper left 
icon ( ) is selected.
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7.	 Use the  button to move the projected image frame as shown on the example.

8.	 Press the ENTER button.

9.	 Use the  button to select another icon which points in the direction.

	 On the Cornerstone adjustment screen, select [EXIT] or press the EXIT button on the remote control.

	 The confirmation screen is displayed.

10.	Press the  or  button to highlight the [OK] and press the ENTER button.

This completes the Cornerstone correction.
Selecting [CANCEL] will return to the adjustment screen without saving changes (Step 3).
Selecting [RESET] will return to the factory default.
Selecting [UNDO] will exit without saving changes.

NOTE: To reset the 3D Reform correction setting values, press and hold the 3D REFORM button for a minimum of 2 seconds.
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The adjustable ranges for 3D Reform are as follows:

HORIZONTAL VERTICAL
CORNERSTONE Max. +/− 35° approx. Max. +/− 30° approx.KEYSTONE

*	 The following are conditions under which the maximum angle is achieved:

•	 When the NP27ZL lens is used

•	 When the lens shift is set to the center

	 When the lens shift is used and yet the image is not displayed in the center of the screen, the adjustable range 
will be increased or decreased.

•	 Image is projected in maximum wide with the zoom

NOTE: 
•	 Even when the projector is turned on, the last used correction values are applied.
•	 If the Cornerstone screen is unavailable (grayed), press and hold the 3D REFORM button for a minimum of 2 seconds to reset 

the current correction data. The Cornerstone function becomes available.
•	 The range of keystone correction is not the maximum tilt angle of projector.

NOTE: Using 3D Reform correction can cause the image to be slightly blurred because the correction is made electronically.



43

3. Convenient Features

 Displaying Two Pictures at the Same Time
The projector has a feature that allows you to view two different signals simultaneously. You have two modes: PIP 
mode and PICTURE BY PICTURE mode.

From the menu you can select [SETUP] → [BASIC] → [PIP/PICTURE BY PICTURE]. 

The [PIP/PICTURE BY PICTURE] menu item has the following three options: MODE, POSITION, and SOURCE.
Use the  or  button to select [MODE], [POSITION] or [SOURCE] and press the ENTER button.

Selecting the PIP or PICTURE BY PICTURE Mode [MODE]
This option allows you to select two modes: PIP and SIDE BY SIDE.

Use the  or  button to select [PIP] or [PICTURE BY PICTURE] and press the ENTER button.

PIP: This option allows you to view a sub picture in the main picture.

	 Main picture

Sub picture

PICTURE BY PICTURE: This allows you to view two pictures side by side.

	 Main picture Sub picture

NOTE: 
•	 The main picture will be displayed on the left side and the sub picture on the right side.
•	 The main picture signal supports the COMPUTER 1, COMPUTER 2, and COMPUTER 3 connectors.
	 The sub picture signal supports the VIDEO IN and S-VIDEO IN connectors.
•	 The main picture supports an RGB signal with a resolution of 1280 × 1024 pixels or less.
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Viewing Two Pictures

1.	 Press the PIP button on the remote control.

	 The PIP/PICTURE BY PICTURE SOURCE screen will be displayed.

	

2.	 Use the G or  button to select the source and press the ENTER button.

	 The PIP screen or PICTURE BY PICTURE screen will be displayed, depending on which was selected in the 
[MODE] setting screen.

	

3.	 Press the PIP button again to return to the normal screen (single picture).

TIP:
•	 Selecting another source will return to the normal screen.
•	 Selecting a source not supported for the main picture or the sub picture will return to the normal screen.

[POSITION]
This option allows you to select the position of a sub picture in the main picture.

NOTE: 
•	 The default setting is [BOTTOM-RIGHT].

Use the  or  button to select the sub picture’s position and press the ENTER button.
The options are: TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, and BOTTOM-RIGHT.

The following adjustments and settings are available for the main picture only.
- Adjusting picture

- Magnifying a picture

The following operations are available for both the main and sub pictures.
- Picture mute

- Freezing a moving picture
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 Preventing the Unauthorized Use of the Projector [SECURITY]
A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword 
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the pro-
jector cannot project an image. 
• The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the  button twice to select [SETUP] and press the  button or the ENTER button to select [BA-
SIC].

3.	 Press the  button to select [INSTALLATION(2)].

4.	 Press the  button three times to select [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

5. 	Press the  button to select [ON] and press the ENTER button.

	 The [SECURITY KEYWORD] screen will be displayed.

6.	 Type in a combination of the four  buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

	 The [CONFIRM KEYWORD] screen will be displayed.

NOTE: Make a note of your password and store it in a safe place.
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7.	 Type in the same combination of  buttons and press the ENTER button.

	 The confirmation screen will be displayed.

8.	 Select [YES] and press the ENTER button.

	 The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1.	 Press the POWER button.

	 The projector will be turned on and display a message to the effect that the projector is locked.

2.	 Press the MENU button.

3.	 Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
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To disable the SECURITY function:

1.	 Press the MENU button.

	 The menu will be displayed.

2. 	Select [SETUP] → [INSTALLATION(2)] → [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

3.	 Select [OFF] and press the ENTER button.

	 The SECURITY KEYWORD screen will be displayed.

4.	 Type in your keyword and press the ENTER button.

	 When the correct keyword is entered, the SECURITY function will be disabled.

NOTE: If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request 
code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] 
is a request code.
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 Storing Changes for Lens Shift, Zoom, and Focus [LENS 
MEMORY]
The adjusted values can be stored in projector memory when using the LENS SHIFT, ZOOM and FOCUS buttons of 
the projector or the remote control. Adjusted values can be applied to the signal you selected. This will eliminate the 
need to adjust lens shift, focus, and zoom at the time of source selection. There are two ways to save adjusted values 
for lens shift, zoom, and focus.

Function name Description page

REF. LENS MEMORY Adjusted values common to all the input signals.
If no adjusted values are stored in [LENS MEMORY], the values stored 
in [REF. LENS MEMORY] will be applied for lens adjustment.

→ page 126

LENS MEMORY Adjusted values for each input signal.
Use the adjusted values for the signal with a different aspect ratio or 
resolution. The adjusted values can be applied at the time of source 
selection.

→ page 117

NOTE:
•	 The NP25FL lens does not support the Lens Memory function.
•	 Be sure to perform [CALIBRATION] after replacement of the lens.

Usage Example
When you wish to display on a screen having a 4:3 aspect ratio an NTSC or other 4:3 aspect ratio signal and an 
SXGA or other 5:4 aspect ratio signal:

Perform shift, focus, and zoom adjustments to set the vertical screen size of the vertically tall 5:4 aspect ratio signal 
to standard.
Both 4:3 aspect ratio signals and 5:4 aspect ratio signals can now be displayed.
Note that with these shift, focus, and zoom adjustments, the 4:3 aspect ratio signal will become smaller on the 
screen.
To eliminate this size reduction, adjust the shift, focus and zoom to the optimum condition for each of the 4:3 aspect 
ratio signal and the 5:4 aspect ratio signal.
Memory (storage) of each of these values will permit projection at an optimum condition upon signal switching.

To store your adjusted values in [REF. LENS MEMORY]:
1.	 Press the MENU button.

	 The menu will be displayed. 

2.	 Press the ▶ button to select [SETUP] and press the ENTER button.

3.	 Press the ▶ button to select [INSTALLATION (1)].
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4.	 Press the ▼ button to select [REF. LENS MEMORY] and press the ENTER button.

	 The [REF. LENS MEMORY] screen will be displayed.

5.	 Select [STORE] and press the ENTER button.

	 The confirmation screen will be displayed.

6.	 Press the ◀ button to select and [YES] and press the ENTER button.

	 The adjusted values for lens shift, zoom, and focus have been stored in [REF. LENS MEMORY].

7.	 Press the MENU button.

	 The menu will be closed.

TIP:
•	 To store adjusted values for each input source, use the Lens Memory function.

To call up your adjusted values from [REF. LENS MEMORY]:
1.	 Press the MENU button.
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	 The menu will be displayed. 

2.	 Press the ▶ button to select [SETUP] and press the ENTER button.

3.	 Press the ▶ button to select [INSTALLATION (1)].

4.	 Press the ▼ button to select [REF. LENS MEMORY] and press the ENTER button.

	 The [REF. LENS MEMORY] screen will be displayed.

5.	 Select [MOVE] and press the ENTER button.

	 The confirmation screen will be displayed.

6.	 Press the ◀ button to select and [YES] and press the ENTER button.

	 The adjusted values will be applied to the current signal. .

7.	 Press the MENU button.

	 The menu will be closed.
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TIP:
To call up the adjusted values from [LENS MEMORY]:
1.	 From the menu, select [ADJUST] → [LENS MEMORY] → [MOVE] and press the ENTER button.

	 The confirmation screen will be displayed.

2.	 Press the ◀ button to select and [YES] and press the ENTER button.

	 The adjusted values stored in [LENS MEMORY] will be applied to the current signal. 

To automatically apply the adjusted values at the time of source selection:
1.	 From the menu, select [SETUP] → [REF. LENS MEMORY] → [LOAD BY SIGNAL] and press the ENTER but-

ton.

2.	 Press the v button to select and [ON] and press the ENTER button.

	 This will move the lens automatically to the position at the time of source selection according to the adjusted val-
ues. 

NOTE: The Lens Memory function may not produce a completely aligned image (due to tolerances in the lenses) using the adjusted 
values stored in the projector. After calling up and applying the adjusted values from the Lens Memory function, finely adjust the 
lens shift, zoom and focus to produce the best possible image.
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 Displaying a Picture Using [EDGE BLENDING]
The EDGE BLENDING function allows a multi-screen image with high resolution to be displayed on a large screen.
This function adjusts overlapping edges of images projected from each projector to uniform multi-screen images.

NOTE:
•	 For projector throw distances, refer to “Throw distance and screen size” on page 215, 216, 217.
•	 Before performing the Edge Blending function, place the projector in the correct position so that the image becomes square in 

the appropriate size, and then make optical adjustments (lens shift, focus, and zoom).

Before explaining use of the Edge Blending function
This section explains the case for “Example: Placing two projectors side by side”. As shown, the projected image on 
the left is referred to as “Projector A” and the projected image on the right is referred to “Projector B”. Unless otherwise 
specified hereinafter, the “projector” is used to mean both A and B.

Example: Placing two projectors side by side

Edge Blending area

Projected area Projected area

Projector A Projector B

Preparation:
•	 Turn on the projector and display a signal.
•	 To use two or more projectors, you have to turn on [CONTROL ID] from the menu. For more information, refer to 

“Setting ID to the Projector [CONTROL ID]” on page 127.

① Enable [EDGE BLENDING].
1	 Select [SETUP] → [EDGE BLENDING] and press the ENTER button.



53

3. Convenient Features

2	 Select [MODE] → [ON] and press the ENTER button.

	 This enables the Edge Blending function. The following menu items are available:

	 [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL]

3	 Select [RIGHT] for Projector A and [LEFT] for Projector B.

	 Press the ENTER button.

	 The following items are available:

	 [CONTROL], [MARKER], [RANGE], and [POSITION]

4	 Select [CONTROL] → [ON] and press the ENTER button.

	 Each [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL] has its own [CONTROL], [MARKER], [RANGE], 
and [POSITION]. Turning on [CONTROL] will make [MARKER], [RANGE], and [POSITION] available.
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② Adjust [RANGE] and [POSITION] to determine an area of overlapped edges of images 
projected from each projector.

[RANGE]
(Determine an area of overlapped edges of 
images.)

[POSITION]
(Determine the position of overlapped edges of images.)
Green marker

Turn on [RIGHT]

Magenta marker

Turn on [LEFT]

Magenta marker

Turning on [MARKER] will display markers in magenta and green.
The magenta marker is used for [RANGE] and green one for [POSITION].

1	 Adjust [RANGE].

	 Use the  or  button to adjust the overlapped area.

TIP:
•	 Adjust to overlap one projector’ marker with the other projector’s marker.

2	 Adjust [POSITION].

	 Use the  or  button to align one edge with the other edge of overlapped images.
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TIP:
•	 When displaying a signal with a different resolution, perform the Edge Blending function from the start. 
•	 Setting of [MARKER] will not be saved and return to [OFF] when the projector is turned off. 
•	 To display or hide the marker while the projector is running, turn on or off [MARKER] from the menu.
•	 If you want to make differences in white balance and brightness between projectors less visible, adjust [REF. WHITE BALANCE] 

and [MULTI-SCREEN COMP.] to obtain the possible best results. (→ page 125)

Black Level Adjustment
If you notice any differences in the brightness of an image, use [BLACK LEVEL] to adjust the darkest part or the level 
of brightness.

NOTE: 
This function is enabled only when [MODE] is turned on.
Adjustable area varies depending on what combination of [TOP], [BOTTOM], [LEFT] and [RIGHT] are turned on.

Example: Adjusting the Black Level when placing two projectors side by side

Width of overlap

Adjust [CENTER] Adjust [CENTER]

Projector A’s 
image

Projector B’s 
image

Adjust [CENTER-RIGHT] Adjust [CENTER-LEFT]

1.	 Turn on [MODE]

2.	 Select [BLACK LEVEL] and press the ENTER button.

3.	 Use the  or  button to select an item and use the  or  to adjust the black level.

	 Do this for the other projector if necessary.
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9-segmented portions for Black Level adjustment
The center projector

This function adjusts the brightness level of 9-segmented portions for the center projector and 4-segmented portions 
for the left bottom projector as shown below.

TOP-LEFT

BOTTOM-LEFT

CENTER-
LEFT

TOP-RIGHT

CENTER-RIGHT

BOTTOM-RIGHT

TOP-CENTER

CENTER

CENTER

BOTTOM-CENTER

TOP-RIGHT

CENTER-RIGHT

TOP-CENTER
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 Controlling the Projector by Using an HTTP Browser
Overview
The HTTP Server function provides settings and operations for:
1.	 Setting for wired/wireless network (NETWORK SETTINGS)

	 To use wireless LAN connection, the optional USB Wireless LAN Unit is required. (→ page 174)

	 To use wired/wireless LAN connection, connect the projector to the computer with a commercially available LAN 
cable. (→ page 173)

2.	 Setting Alert Mail (ALERT MAIL)

	 When the projector is connected to a wired/wireless network, lamp replace time or error messages will be sent via 
e-mail.

3.	 Operating the projector

	 Power on/off, selecting input, and picture adjustments are possible.

4.	 Setting PJLink PASSWORD and AMX BEACON

Access to the HTTP server function:
•	 Start the Web browser on the computer via the network connected to the projector and enter the following 

URL :

	 http://<the projector’s IP address> /index.html

TIP: The factory setting IP address is [DHCP ON].

NOTE: 
•	 To use the projector in a network, consult with your network administrator about network settings.
•	 The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your net-

work.
	 Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in 

rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projec-
tor.

•	 If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web 
browser (or clear the cache).

•	 This device uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will 
vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 173)
Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the 
setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set 
will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be 
reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
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Handling of the Address for Operation via a Browser
Regarding the actual address that is entered for the address or entered to the URL column when operation of the pro-
jector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the 
projector has been registered to the domain name server by a network administrator, or the host name corresponding 
to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: �When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network 
setting by specifying 
  http://pj.nec.co.jp/index.html 
for the address or the entry column of the URL.

Example 2: �When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by 
specifying 
  http://192.168.73.1/index.html 
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
ON	������������������������� Power is switched on.
OFF	������������������������ Power is switched off.

VOLUME: This control is not available on this model.

AV-MUTE: This controls the mute function of the projector.
PICTURE	���������������� Mutes the video.
PICTURE 	����������� Cancels the video muting.
SOUND*	���������������� Mutes the audio.
SOUND* 	������������ Cancels the audio muting.
ALL ON	������������������ Mutes each of the video, and audio* functions.
ALL OFF	����������������� Cancels the muting of each of the video, and audio* functions.

NOTE:
*	 The sound mute function is not available because the projector does not have an audio function.
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PICTURE: Controls the video adjustment of the projector.
BRIGHTNESS 	���� Increases the brightness adjustment value.
BRIGHTNESS 	���� Decreases the brightness adjustment value.
CONTRAST 	�������� Increases the contrast adjustment value.
CONTRAST 	�������� Decreases the contrast adjustment value.
COLOR 	�������������� Increases the color adjustment value.
COLOR 	�������������� Decreases the color adjustment value.
HUE 	������������������� Increases the hue adjustment value.
HUE 	������������������� Decreases the hue adjustment value.
SHARPNESS 	����� Increases the sharpness adjustment value.
SHARPNESS 	����� Decreases the sharpness adjustment value.

•	 The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 
111)

SOURCE SELECT: This switches the input connector of the projector.
COMPUTER 1	�������� Switches to the COMPUTER 1 IN connector.
COMPUTER 2	�������� Switches to the COMPUTER 2 IN connector.
COMPUTER 3	�������� Switches to the COMPUTER 3 IN connector.
HDMI	��������������������� Switches to the HDMI IN connector.
DisplayPort	������������ Switches to the DisplayPort.
VIDEO	�������������������� Switches to the VIDEO IN connector.
S-VIDEO	���������������� Switches to the S-VIDEO IN connector.
VIEWER	����������������� Switches to the data on the USB memory device.
NETWORK	������������� Switches to a LAN signal.
SLOT	���������������������� Switches to the optional board.

PROJECTOR STATUS: This displays the condition of the projector.
LAMP 1 LIFE REMAINING	��Displays the remaining life of the lamp 1 as a percentage.
LAMP 2 LIFE REMAINING	��Displays the remaining life of the lamp 2 as a percentage.
LAMP 1 HOURS USED	��������Displays how many hours the lamp 1 has been used.
LAMP 2 HOURS USED	��������Displays how many hours the lamp 2 has been used.
FILTER HOURS USED	���������Displays how many hours the filter has been used.
ERROR STATUS	������������������Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
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NETWORK SETTINGS

• SETTINGS

WIRED or WIRELESS

SETTING Set for wired LAN or for wireless LAN.

APPLY Apply your settings to wired LAN or wireless LAN.

DHCP ON Automatically assign IP address, subnet mask, and gateway to the projector from your 
DHCP server.

DHCP OFF Set IP address, subnet mask, and gateway to the projector assigned by your network 
administrator.

IP ADDRESS Set your IP address of the network connected to the projector.

SUBNET MASK Set your subnet mask number of the network connected to the projector.

GATEWAY Set the default gateway of the network connected to the projector.

WINS Set the IP address of your WINS server of the network connected to the projector when 
[DHCP] is turned on, this option is not available.

AUTO DNS ON DHCP server will automatically assign IP address of DNS server connected to the 
projector.

AUTO DNS OFF Set your IP address of DNS server connected to the projector.

Setting for WIRED LAN

PROFILE 1/PROFILE 2 Two settings can be set for wired LAN connection. Select PROFILE 1 or PROFILE 2. 

DISABLE Turn off wired LAN connection

Setting for WIRELESS LAN (the optional Wireless LAN Unit required for Europe, Australia, and Asian coun-
tries) 

EASY CONNECTION Execute a wireless LAN using EASY CONNECTION.

SIMPLE ACCES POINT Set the projector for simple access point.

WPS Use WPS (Wi-Fi Protected Setup™) to set up the wireless LAN for the projector.
NOTE: Use the projector’s menus to make WPS connections and change the WPS 
profile settings.

CHANNEL Select a channel. Available channels vary depending on the country and region. When 
you select [INFRASTRUCTURE], make sure that the projector and your access point 
are on the same channel; when you select [AD HOC], make sure that the projector and 
your computer are on the same channel.

PROFILE 1/PROFILE 2 Two settings can be set for wireless LAN connection. Select PROFILE 1 or PROFILE 
2.
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SSID Enter an identifier (SSID) for wireless LAN. Communication can be done only with 
equipment whose SSID matches SSID for your wireless LAN.

SITE SURVEY Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you 
can access.

NETWORK TYPE Select communication method when using wireless LAN.
INFRASTRUCTURE: Select this option when communicating with one or more equip-
ment connected to the wireless LAN network via a wireless access point.
AD HOC: Select this option when using the wireless LAN to directly communicate with 
a computer in peer-to-peer mode. 

SECURITY TYPE Turn on or off the encryption mode for secure transmission. When turn on the encryp-
tion mode, set WEP key or encrypted key.

DISABLE Will not turn on the encryption feature. Your communications may 
be monitored by someone.

WEP 64 bit Uses 64-bit datalength for secure transmission.

WEP 128 bit Uses 128-bit datalength for secure transmission. This option will 
increase privacy and security when compared to use of 64-bit 
datalength encryption.

WPA-PSK TKIP / WPA-PSK AES/
WPA2-PSK TKIP / WPA2-PSK AES/
WPA-EAP TKIP EAP-TLS/
WPA-EAP AES EAP-TLS/
WPA-EAP TKIP PEAP-MSCHAP v2/
WPA-EAP AES PEAP-MSCHAP v2/
WPA2-EAP TKIP EAP-TLS/
WPA2-EAP AES EAP-TLS/
WPA2-EAP TKIP PEAP-MSCHAP v2/
WPA2-EAP AES PEAP-MSCHAP v2

These options parovide stronger security 
than WEP.

NOTE:
•	 The WEP settings must be the same as communication devices such as PC or access point in 

your wireless network.
•	 When you use WEP, your image transmission speed will slow down.
•	 Other encryption keys than WEP 64bit and WEP 128bit are not available when [AD HOC] is 

selected from [NETWORK TYPE].
•	 To install a digital certificate, use the projector’s menu. (→ page 147)

INDEX Select encryption key when selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY 
TYPE].

KEY When selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE]:
Enter WEP key.

Select Characters (ASCII) Hexadecimal digit (HEX)

WEP 64 bit Up to 5 characters Up to 10 characters

WEP 128 bit Up to 13 characters Up to 26 characters

When selecting [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] or [WPA2 
PSK-AES]:
Enter encryption key. Key length must be 8 or greater and 63 or less.

USERNAME Set a user name for WPA-EAP/WPA2-EAP.

PASSWORD Set a password for WPA-EAP TKIP PEAP-MSCHAP v2/WPA-EAP AES PEAP-MSCHAP 
v2/WPA2-EAP TKIP PEAP-MSCHAP v2/WPA2-EAP AES PEAP-MSCHAP v2.

USE DIGITAL CERTIFI-
CATE

Select this if you use a digital certificate for WPA-EAP TKIP PEAP-MSCHAP v2/WPA-
EAP AES PEAP-MSCHAP v2/WPA2-EAP TKIP PEAP-MSCHAP v2/WPA2-EAP AES 
PEAP-MSCHAP v2.
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• NAME

PROJECTOR NAME Enter a name for your projector so that your computer can identify the projector. A 
projector name must be 16 characters or less. 
TIP: Projector name will not be affected even when [RESET] is done from the menu.

HOST NAME Enter the hostname of the network connected to the projector. A host name must be 
15 or less.

DOMAIN NAME Enter the domain name of the network connected to the projector. A domain name 
must be 60 characters or less.

• ALERT MAIL

ALERT MAIL This option will notify your computer of lamp replace time or error messages via e-mail 
when using wireless or wired LAN. 
Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.
Sample of a message to be sent from the projector:

The lamp and filters are at the end of its usable life. Please replace the lamp.
Projector Name: XXXXX
Lamp 1 Hours Used: XXX [H]
Lamp 2 Hours Used: XXX [H]

SENDER’S ADDRESS Enter sender’s address. 

SMTP SERVER NAME Enter the SMTP server name to be connected to the projector.

RECIPIENT’S ADDRESS 
1, 2, 3

Enter your recipient’s address. Up to three addresses can be entered.

TEST MAIL Send a test mail to check whether your settings are correct or not
NOTE:
•	 If you execute a test, you may not receive an Alert mail. Should this happen, check if network 

settings are correct.
•	 If you entered an incorrect address in a test, you may not receive an Alert mail. Should this 

happen, check if the Recipient’s Address is correct.

SAVE Click this button to save your settings to the projector’s memory.
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• NETWORK SERVICE

PJLink PASSWORD Set a password for PJLink*. A password must be 32 characters or less. Do not forget 
your password. However, if you forget your password, consult with your dealer.

HTTP PASSWORD Set a password for HTTP server. A password must be 10 characters or less.

AMX BEACON Turn on or off for detection from AMX Device Discovery when connecting to the network 
supported by AMX’s NetLinx control system.
TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx control system will rec-
ognize the device and download the appropriate Device Discovery Module from an AMX server.
Placing a checkmark will enable detecting the projector from AMX Device Discovery.
Clearing a checkmark will disable detecting the projector from AMX Device Discovery.

NOTE: If you forget your password, contact your dealer. 

*What is PJLink?
PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard proto-
col is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005.
The projector supports all the commands of PJLink Class 1.
Setting of PJLink will not be affected even when [RESET] is done from the menu.

CRESTRON ROOMVIEW compatibility
The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed 
and controlled from a computer or a controller.
For more information, visit http://www.crestron.com

<Setting Procedure>
Access to the HTTP server function, and make necessary settings for [CRESTRON] in [NETWORK SETTINGS].

• ROOMVIEW for managing from the computer.

DISABLE Disables ROOMVIEW.

ENABLE Enables ROOMVIEW.

• CRESTRON CONTROL for managing from the controller.

DISABLE Disables CRESTRON CONTROL.

ENABLE Enables CRESTRON CONTROL. 

IP ADDRESS Set your IP address of CRESTRON SERVER.

IP ID Set your IP ID of CRESTRON SERVER.

TIP: The CRESTRON settings are required only for use with CRESTRON ROOMVIEW.
For more information, visit http://www.crestron.com

• INFORMATION

WIRED LAN Display a list of settings of wired LAN connection.

WIRELESS LAN Display a list of settings of wireless LAN connection.

UPDATE Reflect settings when they are changed.

http://www.crestron.com
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 Projecting Your Computer’s Screen Image from the 
Projector via a Network [NETWORK PROJECTOR]
By selecting the projector connected to the same network as that of your PC, the PC screen image can be projected 
to the screen via network. There is no need of connection using the computer cable (VGA).

Operation Environment

Applicable OS Windows 7 Professional
Windows 7 Ultimate
Windows 7 Enterprise 
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise

Hardware specifications The specifications recommended by Microsoft as the operation environment for 
Windows 7/Windows Vista should be satisfied.

Network Environment Wired LAN or wireless LAN environment that supports TCP/IP is required.

Screen color High Color (16 bits)
True Color (24 bits and 32 bits)
* Setting with 256 colors or less is not available.

Setting the Projector to Network Projector Input Mode
1.	 With the projector turned on, press the SOURCE button.

	 The input selection window appears.

	 Another way to display the input selection window is to press the NETWORK button on the remote control. The 
APPLICATION MENU screen will be displayed. Go to step 3.
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2.	 Press the  or  button to select [NETWORK] and press the ENTER button.

	 In the screen, the [APPLICATION MENU] menu is displayed.

3.	 From the [APPLICATION MENU] menu, select [NETWORK PROJECTOR].

	 The [PROJECTOR NAME/DISPLAY RESOLUTION/PASSWORD/URL] will be displayed.
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Projecting the Image with Network Projector
1.	 Click [Start] from the desktop of Windows 7.

2.	 Click [All Programs].

3.	 Click [Accessories].

4.	 Click [Connect to a Network Projector].

	 When the [Permission Connect to a Network Projector] window appears, click [Yes.].

	 The “Connect to a Network Projector” window appears.

5.	 Click [→ Search for a projector (recommended)].

	 In the “Available projectors” box, “PH1000 Series” is displayed.

6.	 Click [PH1000 Series].

	 The message “Enter the password for the projector that you selected.” is displayed at the bottom of the window.
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7.	 Input the password to the password input box displayed by the operation at step 3 on page 65.

8.	 Click [Connect].

	 The network projector function works and the screen of Windows 7 is projected from the projector.

•	 If the resolution of your computer’s screen is different from the projector’s screen resolution, the NETWORK 
PROJECTOR function may not work. If this happens, change the resolution of the computer’s screen to lower 
resolution than the one displayed at Step 3 on page 65.

NOTE: When the network projector function works, the background color of the desktop changes to black. When the network 
projector function is stopped, the original background color is restored.

Reference: If the projector cannot be found at Step 5, click [ → Enter the projector address]. Then, input the “Network address” 
(Input example: http://10.32.97.61/lan) and “Projectorpassword” (Input example: 82291627) displayed in the screen projected 
from the projector.

Exiting the Network Projector Operation

1.	 Click [Projecting: PH1000 Series] in the Windows Vista task bar.

2.	 Click [Disconnect].

	 The Network Projector function is stopped.

3.	 Press the SOURCE button of the projector to select an input terminal other than [NETWORK].

	 When using the remote control, press a button other than the NETWORK button.
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 Using the Projector to Operate Your Computer via a Network 
[REMOTE DESKTOP]
•	 By selecting the PC connected to the same network as that of the projector, the PC screen image can be projected 

to the screen via network.

	 Then, by operating the keyboard, you can operate Windows 7, Windows Vista or Windows XP on the PC connected 
with the network.

•	 With the Remote Desktop function, you can remotely operate the PC placed at a distance from the projector.

Meeting room

Office

NOTE:
•	 The [REMOTE DESKTOP] function will work on the following Windows editions.
	 Windows 7 Professional
	 Windows 7 Ultimate
	 Windows 7 Enterprise 
	 Windows Vista Business
	 Windows Vista Ultimate
	 Windows Vista Enterprise
	 Windows XP Professional with Service Pack 3
	 (Note)
•	 In this user’s manual this feature is described using Windows 7 as an example, but Windows Vista and Windows XP Professional 

Service Pack 2 or later will also work with this feature.
•	 A keyboard is required to use the Remote Desktop function.
•	 The Remote Desktop function can be operated with a keyboard. Using a wireless mouse with a wireless keyboard is more useful 

for operating.
Use a commercially available wireless keyboard, a wireless mouse, and a USB wireless receiver.
Use a commercially available USB keyboard and USB mouse.

•	 A USB keyboard with a built-in USB hub cannot be used with the projector.
•	 A wireless keyboard or mouse that supports Bluetooth cannot be used with the projector.
•	 We do not warrant that the USB port of the projector will support all USB devices in the market.
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Prepare a commercially available wireless keyboard (US layout version).
Connect the USB wireless receiver to the USB port (Type A) of the projector. Make all necessary settings for your 
wireless keyboard and mouse.
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Setting the password to the user account of Windows 7
TIP: If a password has been set for an account, the steps 1 to 9 can be skipped.
1.	 Click [Start] from the desktop of Windows 7.

2.	 Click [Control Panel].

3.	 Click [Add or remove user accounts] displayed under [User Accounts].

4.	 When the [User Account Control] confirmation window appears, click [Continue].

5.	 Click [Administrator].

6.	 Click [Create a password].

7.	 Input the password to the [New password] box.

8.	 Input the same password as that at Step 7 to the [Confirm new password] box.

9.	 Click [Create a password].

	 The Administrator is changed to [Password Protection].

Setting the Remote Access
1.	 Click [Start] from the desktop of Windows 7.

2.	 Click [Control Panel].

3.	 Click [System and Security].

4.	 Click [Allow remote access] displayed under [System].

5.	 When the [User Account Control] confirmation window appears, click [Continue].

	 The [System Properties] window appears.

6.	 Click [Allow connections from computers running any version of Remote Desktop (less secure)] in the 
Remote Desktop box and click [OK].

Checking the IP address on Windows 7
1.	 Click [Start] from the desktop of Windows 7.

2.	 Click [Control Panel].

3.	 Click [View network status and tasks] displayed under [Network and Internet].
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4.	 Click [View status] displayed in blue on the right of [Local Area Connection] in the window.

	 The [Local Area Connection Status] window appears.

5.	 Click [Details...].

	 Write down the value for “IPv4 IP Address” (xxx.xxx.xxx.xxx) displayed.

6.	 Click [Close].

7.	 Click [X] at the upper right of the window.

	 The system goes back to the desktop.

Starting the Remote Desktop
1.	 With the projector turned on, press the SOURCE button.

	 The input selection window appears.

	 Another way to display the input selection window is to press the NETWORK button on the remote control. The 
APPLICATION MENU screen will be displayed. Go to step 3.
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2.	 Press the  or  button to select [NETWORK] and press the ENTER button.

	 The [APPLICATION MENU] menu will be displayed.

3.	 From the [APPLICATION MENU] menu, use the wireless keyboard to select [REMOTE DESKTOP CONNEC-
TION].

	 The [REMOTE DESKTOP CONNECTION] window appears.

4.	 Operate the wireless keyboard to input the IP address of Windows 7 and click “Connect”.

	 The log-on screen of Windows 7 is displayed in the screen projected by the projector.

5.	 Operate the wireless keyboard to input the user’s password and press “Enter”.

	 The remote desktop function is started.

	 Windows 7 desktop is displayed in the screen projected by the projector.

	 Log out the computer.

	 Use the wireless keyboard connected to the projector to operate Windows 7.

NOTE: When the projection is made with the remote desktop function, the background color of the desktop is changed to 
black.
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Exiting the Remote Desktop
1.	 Operate the wireless keyboard to click [Start] from the desktop screen projected by the projector.

2.	 Click [X] on the right of the start menu.

	 The remote desktop function is stopped.

3.	 Press the SOURCE button of the projector to select an input terminal other than [NETWORK].

	 When using the remote control, press a button other than the NETWORK button.

TIP:
Setting [OPTIONS] in REMOTE DESKTOP
Clicking [OPTIONS] displays the [PERFORMANCE] screen.
Making settings to [OPTIONS] will allow you to display the desktop background, or to enable the window animation function during 
the Remote Desktop operation. However, doing this will cause the display’s or mouse’s response to slow down. 
If the display’s or mouse’s response is slowed down, try one or more of the following:

DESKTOP BACKGROUND: Clear the check mark to display the desktop background in monochrome.
MENU AND WINDOW ANIMATION: Clear the check mark to disable menu and window animation.
THEMES: Clear the check mark not to use Themes.
SHOW CONTENTS OF WINDOW WHILE DRAGGING: Clear the check mark to show only the window pane while 
dragging.
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❶ What you can do with the Viewer
The Viewer feature allows you to view slides or movie files stored on a USB memory on the projector, or a shared 
folder in a computer connected to the network.
The Viewer has the following features.

•	 When a commercially available USB memory that stores image files is inserted into the USB port (Type A) of the 
projector, the Viewer allows you to view the image files on the USB memory.

	 Even if no computer is available, presentations can be conducted simply with the projector. 

•	 Movie file can be played back.

•	 A Microsoft PowerPoint file or Adobe PDF file can be simply projected on the screen without connecting a com-
puter.

•	 Image and movie files stored in a shared folder in a computer connected to a network can be projected.

	 The computer with “Media Sharing” of Windows Media Player 11 turned on can be used as a media server.

Supported graphic formats

Format File name extension

JPEG .jpg, .jpe, .jpeg (CMYK is not supported.)

BMP .bmp (bit field not supported)

PNG .png (Interlaced PNG and α channel PNG are not supported.)

GIF .gif (Interlaced GIF, transparation GIF, and animation GIF are not supported.)

* If an unsupported image is selected, the icon  will be displayed.

NOTE: 
Maximum number of pixels of image which can be displayed are:
•	 Progressive JPEG: 1280 × 1280
•	 GIF: 1280 × 1280
•	 Others: 4000 × 4000
•	 Some files supported by the above requirements may not be displayed.

Supported movie files

File name extension Video compression/expansion method Audio compression/expansion method

.mpg, .mpeg MPEG2 MPEG Audio Layer2

MPEG Audio Layer3

.wmv VC-1/WMV9 WMA9 Standard

.mp4 H.264/AVC AAC-LC

Playback requirements:
Resolution: 320 × 240 to 1280 × 720
Video frame rate: up to 30fps
Bitrate: up to 15Mbps
Max. file size: up to 2GB

NOTE:
•	 Some files supported by the above requirements may not be played back.
	 When a supported movie file is played back, its audio will not be output from the projector.
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NOTE:
•	 Movie files converted by using the video/audio format which is not supported by this projector cannot be played back.
	 In this case, there will be no icon to show that playback is not possible.
•	 Files with Digital Rights Management(DRM) protection cannot be played back.
•	 Some of the movie files that meet the above requirements may not be played back.
•	 WMV format video file will be displayed in an aspect ratio of 1 to 1 independently of its original aspect ratio.
•	 Files that can be played back on the media server are graphics and movie files. In Windows Media Player 11 (Windows XP/

Windows Vista) mp4 files cannot be played back.

Supported PDF files

File name extension Supported file format

.pdf Adobe Acrobat PDF

NOTE:
•	 Fonts not embedded in PDF file may not be displayed
•	 Functions added to PDF file after created will not work or display. Functions added are bookmarks, boxes in form tool, and notes 

will not be displayed.
	 Auto flip or Auto transition will not work.
•	 Some PDF files may not be displayed.

Supported PowerPoint files

File name extension Supported file format

.ppt Microsoft PowerPoint 97 – 2003

NOTE:
•	 Playable fonts, colors, font ornament, placement, object insertion or animation are restricted.
•	 Some Microsoft PowerPoint 97 – 2003 files may not be displayed.

Supported USB memory devices
-	 Be sure to use a USB memory device formatted with the FAT, exFAT, FAT32 or FAT16 file system.

	 The projector does not support NTFS formatted USB memory.

	 If the projector does not recognize your USB memory, check if the format is supported.

	 To format your USB memory in your computer, refer to the document or help file that comes with your Win-
dows.

-	 We do not warrant that the USB port of the projector will support all USB memories in the market.

-	 Wait at least 5 seconds after disconnecting a USB memory device before reconnecting it and vice versa. 

	 The projector may not identify the USB memory device if it is repeatedly connected and disconnected in rapid 
intervals.
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Notices on shared folder and media server
•	 Files from a shared folder or media server may not be projected if security or antivirus software is installed on your 

computer.

•	 Open the following firewall ports:

-	 Media server 

Port number Protocol
1900 UDP
2869 TCP
10243 TCP
10280-10284 UDP

-	 Shared folder

Port number Protocol
137 UDP/TCP
138 UDP/TCP
139 UDP/TCP
445 UDP/TCP

•	 Set your computer for sharing and security to grant access to files in the shared folder and set your security or 
antivirus software to grant access to files in the shared folder. Consult your network administrator for more informa-
tion.

•	 Movie files in the shared folder or the media server may not be played back correctly depending on your network 
environment or the bit rate of your file.

NOTE:
Do not disconnect between the projector and your computer by removing the LAN cable or turning off the projector when a Pow-
erPoint file or PDF file is displayed from a shared folder.
Doing so will make Viewer inoperable.

NOTE:
•	 The following operations by using the buttons on the projector are not possible when the VIEWER screen such as the slide screen 

and the thumbnail screen is displayed.
-	 Auto Adjustment by using the AUTO ADJ. button

•	 Freezing picture by using the FREEZE, ASPECT, or AUTO ADJ. button on the remote control is not possible when the VIEWER 
screen such as the slide screen and the thumbnail screen is displayed.

•	 Executing [RESET] → [ALL DATA] from the menu will return the settings for the Viewer toolbar to the factory default.
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❷ Preparing presentation materials

1.	 Create your presentation materials and save them in a supported file format to your computer.

•	 See page 99 for supported file formats.

•	 Make sure that PowerPoint file is displayed on the Viewer before giving your real presentation.

	 With Viewer PPT Converter 3.0, you can convert your PowerPoint files to index files that can be displayed on 
the Viewer. Viewer PPT Converter 3.0 can be downloaded from our website.

•	 When creating a PDF file, embed your fonts in your PDF file. Embedding fonts requires Adobe Acrobat. This 
cannot be done in Adobe Reader.

TIP:
• Using Print Command
Example for font embedding using Print Command. See the help of Adobe Acrobat for more information.
1.	 Select “Print” from the “File” menu.

2.	 Select “Adobe PDF” from “Printer name” and click the “Properties” but-
ton.

3.	 Click the “Edit” button in the “Adobe PDF Settings” tab.

4.	 Click the font tab in the Edit window to select the font embed window.

5.	 Place a check mark for “Embed all fonts”.

	 Click “OK” to return to the Print window, and click “OK” to start creating a 
PDF file.

2.	 Save a file to your drive.

	 To save a file to your USB memory:

	 Use the Windows Explore to copy the file to your USB memory.

	 To place a file in a shared folder you create in your computer, see page 90.

	 To use “Media Sharing” in Windows Media Player 11, see page 94.
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❸ Projecting images stored in a USB memory device

This section explains the basic operation of the Viewer.
The explanation provides the operational procedure when the Viewer toolbar is set to the factory default.

Preparation: Before starting the Viewer, store images to the USB memory using your computer.

Starting the Viewer

1.	 Turn on the projector. (→ page 16)

2.	 Insert the USB memory into the USB port of the projec-
tor.

NOTE:
•	 Do not remove the USB memory from the projector while it’s LED 

flashes. Doing so may corrupt the data.

TIP:
You can a USB memory insert the projector when the drive list screen 
is displayed.

3.	 Press the SOURCE button to select [VIEWER].

	 A press of the SOURCE button will display the source select 
screen.

	 A few more presses of the SOURCE button will display the 
drive list screen.

	 Another way to select [VIEWER] is to press the VIEWER 
button on the remote control.

TIP:
•	 For more information about the drive list screen, see page 82.
•	 To display graphics in a shared folder, see page 90; to display still 

images or movie files in a media server, see page 94.
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4.	 Press the ▶ button to select “USB1” and press the 
ENTER button.

	 The “USB1” thumbnail screen will be displayed.

TIP:
•	 For more information about thumbnail screen, see page 84.

5.	 Use the ▲▼◀ or ▶ button to select an icon.

•	 The → (arrow) symbol on the right indicates there are 
more pages. pressing the PAGE ▽ (page down) button 
will show the next page: pressing the PAGE △ (page up) 
will show the previous page.

6.	 Press the ENTER button.

	 Operation varies depending on the selected file.

	 • Still image

	 The selected slide will be displayed.

	 The ◀ or ▶ button can be used to select the next (right) 
slide or the previous (left) slide in the thumbnail screen.

•	 Pressing the ENTER button will display the control bar 
with which is used to select or rotate an slide.(→ page 
85)
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	 • Movie file

	 The movie file will start playing.

	 After finishing the playback, the screen will turn to black. 
Press the EXIT button to return to the thumbnail screen.

•	 Pressing the ENTER button will display the movie’s 
control bar with which you can pause or fastforward and 
some other operations.

	 • Microsoft PowerPoint file

	 The slide on the first page will be displayed.

	 Press ▶ to select the next slide; press ◀ to select the previ-
ous slide.

•	 You can also use the ▼ or ▲ button to select a page. To 
return to the thumbnail screen, press the EXIT button.

NOTE:
•	 Files with slideshow or animation effects may not be correctly 

displayed on the Viewer.
	 See “Supported PowerPoint files” on page 75, 99.

	 • Adobe PDF file

	 The first page will be displayed.

•	 The PDF file will fill the width of the screen.

	 Pressing the ▼ or ▲ button will scroll the screen down or 
up.

	 The PAGE ▽ or PAGE △ button will move the screen one 
page down or up.

	 To return to the thumbnail screen, press the EXIT button.

•	 When a passoword input window is displayed, it means 
that the PDF file is password-protected.

	 Pressing the ENTER button will show the software 
keyboard. Use the software keyboard to enter your 
password.

	 Select [OK] and press the ENTER button. The PDF file 
will be displayed.

•	 For more information on the software keyboard, see page 
153.

NOTE:
Bookmarks and notes that were added after PDF conversion will not 
be displayed.
If fonts were not embedded at the time of PDF conversion, those fonts 
will not be displayed.
 

 
TIP:
It takes some time (about 30 seconds to two minutes) to display a 
large size file or to turn pages of a PDF file that has many pages.
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	 • Index file (extension:.idx)

•	 Index files, which is converted by using Viewer PPT 
Converter 3.0, will appear in the Thumbnail screen. 

	 Only folders and JPEG files converted by using 
Viewer PPT Converter 3.0 will appear in the Thumbnail 
screen.

•	 To select slideshow of index files, open the [PRESENTA-
TION] folder in the DRIVE LIST screen.

	 However, index files will not appear. Only folders and 
JPEG files will appear.

•	 Up to four index folders in your USB and shared folder 
are displayed. The four folders will be displayed in reverse 
chronological order

•	 When you insert the USB memory device storing index 
with the Viewer in operation, the content of the index files 
will be displayed.

NOTE:
•	 The play mode (MANUAL/AUTO) for slides of index file works in 

the following way:
	 In case of [MANUAL] for [PLAY MODE]
	 When you select [OPTIONS] → [SLIDE SETTING] → [PLAY MODE] 

→ [MANUAL], index files will be set for manual playback in regard-
less of whether [INTERVAL] is set.

	 In case of [AUTO] selected for [PLAY MODE]
	 When you select [OPTIONS] → [SLIDE SETTING] → [PLAY MODE] 

→ [AUTO], index files will be set for auto playback at intervals 
specified by using [INTERVAL].

	 When, however, [-1] is selected for [INTERVAL], the play mode will 
be set for auto playback according to the setting for [OPTIONS] → 
[SLIDE SETTING] → [INTERVAL].

7.	 Remove the USB memory from the projector.

	 Return to the drive list screen. Make sure that the LED on 
the USB memory is not flashing before removing the USB 
memory.

NOTE: If you remove the USB memory from the projector with a slide 
displayed, the projector may not operate correctly. If this happens, 
turn off the projector, turn off the main power switch, and unplug the 
power cord. Wait 3 minutes, then connect the power cord, turn on 
the main power switch, and turn on the projector.

Exiting the Viewer
1.	 Press the SOURCE button to select a source other than 

[VIEWER].

	 A press of the SOURCE button will display the source select 
screen.

	 A few more presses of the SOURCE button will display 
another source.

•	 To exit the Viewer using the remote control, select a 
source other than [VIEWER].

XXXX Motors
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Names and functions of Viewer screen

The Viewer has three screens: Drive list screen, Thumbnail screen, and Slide screen.

• Drive list screen
Displays a list of drives connected to the projector.

Menu operation
•	 Use the ▼ or ▲ button to move the cursor up or down. Select the menu item and press the ENTER button 

to display the submenu.

Operation for Drive list screen
1.	 Press the ▶ button to move the cursor to the drive list. 

	 (Use the ◀ or ▶ button to switch between the menu and the drive list.)

	 Press the ▼ or ▲ button to select a type of drive; press the ◀ or ▶ button to select the drive connected to the 
projector.

2.	 Select the drive and press the ENTER button to switch to the thumbnail screen of the selected drive.

Cursor (yellow)

Cursor (yellow)

Menu Menu Scroll bar

[Drive list screen] [Thumbnail screen]

Folder icon

Path information

Drive information/File information

Menu guide Operation button guide

Control bar
* The operation for still image differs from that for movie.

[Slide screen]
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Functions

Name Description

REFRESH Displays additional media servers in the drive list screen.

OPTIONS Opens the OPTIONS menu.

SLIDE SETTING Sets up slides. (→ page 87)

MOVIE SETTING Sets up movie files. (→ page 88)

AUTO PLAY SETTING Sets up auto play. (→ page 88)

SHARED FOLDER Sets up a shared folder. (→ page 90)

MEDIA SERVER Sets up a media server. (→ page 94)

RETURN Closes the OPTIONS menu. 

SYSTEM SETTING Switches to the system setting menu. See wired LAN, wireless LAN, WPS, 
network information, mouse, and keyboard in “9. Application Menu”. (→ 
page 140)

USB Displays the icon for a USB memory inserted into the USB port of the 
projector.

SHARED FOLDER Displays up to four drives of a computer connected to a LAN (set for con-
necting a shared folder).
* See page 90 for setting up for connecting a shared foler of the projector.

MEDIA SERVER Displays up to four drives of a computer connected to a LAN (set for con-
necting a media server).
* See page 94 for setting up for connecting a media server of the projector

PRESENTATION Displays the icon when a USB memory or shared foler stores index files.

Path information Displays the location of a folder or file.

Drive information [Example]

USB1 314MB FREE/492MB

Displays the drive. Displays free space and capcity of 
a drive. (USB only)

Menu guide Displays the description of a selected menu.

Operation button guide Displays information about operation buttons.

* It is displayed in three-digit number (rounding up)

NOTE:
When the OPTIONS menu is displayed, the drive list screen or thumbnail screen is not displayed. To display it, select the [RETURN] 
icon and press the ENTER button.
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• Thumbnail screen
Displays a list of folders, thumbnails, and icons in the drive selected on the drive list screen.

Menu operation
•	 Use the ▼ or ▲ button to move the cursor up or down. Select the menu item and press the ENTER button 

to display the menu or setting screen.

Operation for Thumbnail screen
1.	 Press the ▶ button to move the cursor to the thumbnail screen when the OPTIONS menu is not dis-

played.

2.	 Press the ▼, ▲, ◀, or ▶ button to select a file or folder.

3.	 Press the ENTER button to start slideshow or playback of the selected file. Selecting a folder will display 
its thumbnail screen.

Functions

Name Description

UP Goes to one upper level menu.

THUMBNAIL Switches two displays between thumbnail and icon.

SORT SETTING Rearranges folders or files.

DRIVE LIST Returns to the drive list screen.

OPTIONS Changes to the OPTIONS menu.

SYSTEM SET-
TING

Opens the system setting menu.

Scroll bar Thumbnail screen will display 12 files with 4 by 3. If the thumbnail screen has twelve or 
more files or folders, the scroll bar will be displayed at the right side. Using the PAGE 
▽ or PAGE △ button will scroll the whole screen down or up.

Path information Displays the location of a folder or file.

Thumbnail information [Example]

005.jpg 5/200 11/03/2010 13:25:12 502KB

Selected folder 
name or file 
name

Numbers and order of 
files in a folder (only 
when folder selected)

Create/Change date: 
M/D/Y/H/M/B

Displays file 
capacity

Menu guide Displays the description of a selected menu.

Operation button guide Displays information about operation buttons.

TIP:
•	 If an unsupported image is selected, the icon [?] will be displayed,
•	 The maximum displayable number of images is 300 in the thumbnail screen including the number of folders.
•	 If a file name or path of a folder is longer than specified, it will be displayed with center characters or path skipped.
	 Example: “123456789.jpg” will be displayed in “123..789.jpg”.
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• Slide screen (still image/movie)
Plays a file selected from a list of thumbnails or icons.
•	 For operating a Microsoft PowerPoint file and Adobe PDF file, see page 80.

Control bar operation
•	 The control bar will be displayed only when a still image (or index file) and a movie file is selected.

•	 The control bar for still images differs from that for movie files.

1.	 Pressing the ENTER button in Slide screen will display the control bar at the bottom of the screen.

2.	 Use the ◀ or ▶ button to select a file and press the ENTER button.

•	 The selected function will be executed.

Functions of still image control bar

Name Description

PREV Goes back to the previous image

PLAY Plays the image. This button also is used to stop or start playing an image.

NEXT Goes to the next image.

RIGHT Rotates the image 90° clockwise.
•	 To cancel, select another folder.

LEFT Rotates the image 90° counter clockwise.
•	 To cancel, select another folder.

SIZE BEST FIT Displays the image with its aspect ratio in the projector’s displayable 
maximum resolution.

ACTUAL 
SIZE

Displays the image in its actual size.

CLOSE Closes the control bar.
•	 You can also press the EXIT button to close the control bar.

END Stops playing slides or slideshow, and closes the control bar to return to the thumbnail 
screen.
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Functions of movie control bar

Name Description

PREV Goes back to the beginning of a movie file.
•	 Goes back to the beginning of the previous movie file if executed immediately after being 

started playing.

FR Fast-rewinds a movie file for about 7 seconds.

PLAY/PAUSE PLAY Plays a movie file.

PAUSE Stops playing a movie file.

FF Fast-forwards a movie file for about 7 seconds.

NEXT Goes to the beginning of a next movie file.

TIME Displays an elapsed time for playback or pause.

SIZE BEST FIT Displays the image with its aspect ratio in the projector’s displayable 
maximum resolution.

ACTUAL 
SIZE

Displays the image in its actual size.

CLOSE Closes the control bar.
•	 You can also press the EXIT button to close the control bar.

END Stops playing a movie, and closes the control bar to return to the thumbnail screen.
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Viewer option settings

• SLIDE SETTING
Sets still images or slides.

Name Options Description

SCREEN SIZE BEST FIT Displays the image with its aspect ratio in the projector’s display-
able maximum resolution.

ACTUAL SIZE Displays the image in its actual size.

PLAY MODE MANUAL Selects manual play.

AUTO Selects auto play.

INTERVAL 5 - 300 seconds Specifies interval time when [AUTO] is selected for PLAY 
MODE.

REPEAT Check mark Turns on or off the repeat function.

TIP
•	 To play one or more slides, place those files into a folder.
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• MOVIE SETTING
Sets the functions for a movie file.

Name Options Description

SCREEN SIZE BEST FIT Displays the image with its aspect ratio in the projector’s display-
able maximum resolution.

ACTUAL SIZE Displays the image in its actual size.

REPEAT OFF Turns on or off the repeat function.

ONE REPEAT Repeats one file only.

ALL REPEAT Repeats all files in the current folder.

TIP
•	 Turning on [REPEAT] will display black screen during intermission between movies.

• AUTO PLAY SETTING
Sets auto play for slideshow when a USB memory device is inserted into the USB port of the projector, or when 
[VIEWER] is selected for [SOURCE].

Name Options Description

AUTO PLAY OFF —

PICTURE Plays the first still image found in a drive.

MOVIE Plays the first movie found in a drive.

PowerPoint Plays the first PowerPoint file found in a drive.

TIP
•	 Auto play behavior is different between when a USB memory device is inserted into the USB port of the projector and when 

[VIEWER] is selected for [SOURCE].
•	 Auto play starts for the first found file supporting the file type set up for Auto Play. The file will be searched in the drive root or 

lower level. 
•	 When [VIEWER] is selected for [SOURCE], the last selected file will be automatically played if it is found, or the last selected folder 

will be searched and the first found file will be automatically played.
	 To automatically play a movie file in a USB memory, store one movie file or change its file name so that it can be searched first.
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• SORT SETTING
Sets the order of displaying thumbnails or slides.

Name Options Description

SORT NAME (ABC..) Displays the files alphabetically by name in ascending order.

NAME (ZYX..) Displays the files alphabetically by name in descending order.

EXT. (ABC..) Displays the files alphabetically by extension in ascending or-
der.

EXT. (ZYX..) Displays the files alphabetically by extension in descending 
order.

DATE (NEW) Displays the files in reverse chronological order.

DATE (OLD) Displays the files in chronological order.

SIZE (BIG) Displays the files in descending order of its file size.

SIZE (SMALL) Displays the files in ascending order of its file size.
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❹ Projecting data from shared folder

LAN

Shared folder

Wireless LAN

Projector

Shared folder

Preparation
For projector: Connect the projector to the network.
For computer: Place files to be projected in a shared folder and note the folder’s path. Memorize or write down the 
path for later use.

•	 For sharing a folder, refer to your user guide or help file accompanied with your Windows computer.

•	 Use a keyboard to give a name to the shared folder in alphanumeric characters.

•	 To connect the shared folder beyond the subnet, set [WINS CONFIGURATION] in [NETWORK SETTINGS] from 
the menu.

•	 Digital signature (SMB signature) is not supported.

Connecting the projector to the shared folder 
1.	 Press the VIEWER button on the remote control.

	 The drive list window will be displayed.

•	 Another way to start the VIEWER is to press the SOURCE button a few times on the projector cabinet. (→ page 
20)
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2.	 Displays the [OPTIONS] menu.

	 Press the ▼ button to select the  (OPTIONS) icon and press the ENTER button.

•	 When the OPTIONS menu is displayed, the drive list will not be displayed.

3.	 Display the [SHARED FOLDER SETTING] screen.

	 Press the ▼ button to select the  (SHARED FOLDER SETTING) icon and press the ENTER button.

4.	 Select a folder number and place to enable it.

	 Press the ◀ or ▶ button to a shared folder number and press the ▼ button to select [ENABLE] , and then press 
the ENTER button.

5.	 Enter the path, user name, and password for the shared folder.

	 Press the ▼ button to select the [SHARED FOLDER] field. The software keyboard will be displayed.

	 For using the software keyboard, see page 153.

•	 If your computer is not password protected, entering a password is not required.

•	 Up to four shared folders can be added.

•	 The maximum length of a path of the shared folder must be 15 alphanumeric characters for computer name and 
23 alphanumeric characters for folder name.
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6.	 Exit the setting.

	 Press the ▼ button to select [OK] and press the ENTER button.

	 This will close the [SHARED FOLDER] screen.

•	 If an error message appear, your settings are not correct. Try again.
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Disconnecting the shared folder from the projector

•	 Disable the number of a shared folder you wish to disconnect

	 Press the ▼ button to select [ENABLE] and press the ENTER button to clear it.

NOTE:
•	 When a PowerPoint file or PDF file is displayed, do not disconnect your LAN cable. If doing so, the Viewer will not work.

TIP: 
•	 Connecting settings for Shared folder 
	 Settings of up to four folders can be saved.
	 Restarting the projector will display setting-saved shared folders in grey folder icon on the drive list screen. 
	 Selecting the grey icon folder will skip entry for a folder path.
•	 Failing to connect with a shared folder will display the folder icon with “x” mark. If this happen, check your folder setting.
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❺ Projecting data from media server

LAN

Media server

Media server

Wireless LAN

Media server

Projector

Preparation
For projector: Connect the projector to the network.
For computer: Prepare image files or movie files to be projected, and set up “Media Sharing” in Windows Media Player 
11 or Windows Media Player 12.

NOTE: 
•	 Both the projector and the media server must be on the same subnet. Connecting to the media server beyond the subnet is not 

possible.
•	 Types of images and movies which can be shared may vary depending on Windows version.

Setting up “Media Sharing” in Windows Media Player 11
1.	 Start Windows Media Player 11.

2.	 Select “Media Sharing” from “Library”.

	 The “Media Sharing” dialog box will be displayed.
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3.	 Select “Share my media” check box, and then select OK. 

	 A list of accessible devices will be displayed.

4.	 Select “PH1000 Series” and then “Allow”.

	 A check mark will be added to the “PH1000 Series” icon.

•	 The “PH1000 Series” is a projector name specified in [NETWORK SETTINGS]. 

5.	 Select “OK”.

	 This will make pictures and video in “Library” available from the projector.
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Setting up “Media Sharing” in Windows Media Player 12
1.	 Start Windows Media Player 12.

2.	 Select “Stream”, and then select “Automatically allow devices to play my media”.

	 The “Allow All Media Devices” windows will be displayed.

3.	 Select “Automatically allow all computers and media devices”.

	 Graphics and movie files in “Library” can be used from the projector.
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Connecting the projector to the media server
Press the VIEWER button on the remote control.
The VIEWER will start.

•	 Another way to start the VIEWER is to press the SOURCE button a few times on the projector cabinet. (→ page 
20)

•	 This will start searching for a computer with “media sharing” enabled in the network and add it to the “Media server” 
of the thumbnail screen.

	 Another way to do this is to point the cursor to “Media server” and select [REFRESH] from the thumbnail menu 
and press the ENTER button.

NOTE: 
•	 Up to four accessible media servers can be automatically searched and displayed. The fifth device or later cannot be displayed.

(→ page 78)
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Disconnecting the projector from the media server
1.	 Display the OPTIONS menu.

	 Press the ▼ button to select the [OPTIONS] icon and select the ENTER button.

2.	 Display the MEDIA SERVER setting screen.

	 Press the ▼ button to select the MEDIA SERVER icon and press the ENTER button.

3.	 Disable the connection.

	 Press the ENTER button to clear the checkmark to disable the connection.

	 Press the ▼ button to select [OK] and press the ENTER button to close the MEDIA SERVER setting screen.
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❻ Restrictions on displaying files

The Viewer allows you to give a simplified display of a PowerPoint file or PDF file.
Due to simplified display, however, actual display may be different from the one on your computer application pro-
gram.

Some restrictions on PowerPoint files

•	 Fonts will be automatically converted to the fonts installed in the projector. Fonts can vary in size or width, causing 
layout corruption

	 Some characters or fonts may not be displayed.

•	 Some functions included in font are not supported.

	 Example: There are some restrictions on animation, selection, or hyperlink.

•	 It may take longer time to feed pages compared with a computer

•	 In some cases Microsoft PowerPoint 97-2003 format files may not be displayed.

Some restrictions on PDF files

•	 Fonts not embedded at the time of PDF creation may not be displayed.

•	 Some functions included in font are not supported.

	 Example: There are some restrictions on annotations, selection, form, or color space.

•	 It may take longer time to feed pages compared with a computer

•	 In some cases Adobe Acrobat format files may not be displayed.



100

5. Using On-Screen Menu
 Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1.	 Press the MENU button on the remote control or the projector cabinet to display the menu.

NOTE: The commands such as ENTER, EXIT, ,  in the bottom show available buttons for your operation.

2.	 Press the  buttons on the remote control or the projector cabinet to display the submenu.

3.	 Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first 
tab.

4.	 Use the  buttons on the remote control or the projector cabinet to select the item you want to adjust or 
set.

	 You can use the  buttons on the remote control or the projector cabinet to select the tab you want.

5.	 Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6.	 Adjust the level or turn the selected item on or off by using the  buttons on the remote control or 
the projector cabinet.

Changes are stored until adjusted again.

7.	 Repeat steps 2 -6 to adjust an additional item, or press the EXIT button on the remote control or the projec-
tor cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. 	Press the MENU button to close the menu.

	 To return to the previous menu, press the EXIT button.
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2 Menu Elements
Slide bar

Solid triangle

Menu mode

Tab

Radio button

ECO mode symbol

Wireless symbol

Menu windows or dialog boxes typically have the following elements:

Highlight	����������������������������� Indicates the selected menu or item. 
Solid triangle	���������������������� Indicates further choices are available. A highlighted triangle indicates the item is active. 
Tab	�������������������������������������� Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button	�����������������������Use this round button to select an option in a dialog box.
Source	�������������������������������� Indicates the currently selected source.
Menu mode	������������������������ Indicates the current menu mode: BASIC or ADVANCED.
Off Timer remaining time	���� Indicates the remaining countdown time when the [OFF TIMER] is preset.
Slide bar	����������������������������� Indicates settings or the direction of adjustment.
ECO mode symbol	�������������� Indicates [ECO MODE] is set.
Key Lock symbol	���������������� Indicates the [CONTROL PANEL LOCK] is enabled.
Thermometer symbol	��������� Indicates the [ECO MODE] is forcibly set to [ON] mode because the internal temperature is too 

high.
High Altitude symbol	���������� Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
Wireless symbol	����������������� Indicate the wireless LAN connection is enabled.

Source

Available buttons

High Altitude symbol Off Timer remaining 
time

Highlight

Thermometer symbol

Key Lock symbol



102

5. Using On-Screen Menu

3 List of Menu Items
Some menu items are not available depending on the input source.
Menu Item Default Options

SOURCE

COMPUTER1 *
COMPUTER2 *
COMPUTER3 *
HDMI *
DisplayPort *
VIDEO *
S-VIDEO *
VIEWER *
NETWORK *
SLOT
ENTRY LIST
TEST PATTERN

ADJUST

PICTURE

MODE STANDARD STANDARD, PROFESSIONAL

PRESET * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, 
sRGB, DICOM SIM.

DETAIL SETTINGS

GENERAL

REFERENCE * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, 
sRGB, DICOM SIM.

GAMMA 
CORRECTION DYNAMIC, NATURAL, BLACK DETAIL

SCREEN SIZE*1 * LARGE, MEDIUM, SMALL
COLOR 
TEMPERATURE*2 * 5000, 6500, 7800, 8500, 9300, 10500

DYNAMIC 
CONTRAST * OFF, ON

WHITE BALANCE
CONTRAST R 0
CONTRAST G 0
CONTRAST B 0
BRIGHTNESS R 0
BRIGHTNESS G 0
BRIGHTNESS B 0

SATURATION
RED 0
GREEN 0
BLUE 0
YELLOW 0
MAGENTA 0
CYAN 0

CONTRAST 50
BRIGHTNESS 50
SHARPNESS 10
COLOR 50
HUE 0
RESET

IMAGE OPTIONS

CLOCK *
PHASE *
HORIZONTAL *
VERTICAL *
BLANKING * TOP, BOTTOM, LEFT, RIGHT
OVERSCAN * AUTO, 0[%], 5[%], 10[%]

ASPECT RATIO

* (COMPUTER1/2/3) AUTO, 4:3, 5:4, 16:9, 15:9, 16:10, 
NATIVE

* (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3, LETTERBOX, 
WIDE SCREEN, ZOOM

* (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3 WINDOW, 
LETTERBOX, WIDE SCREEN, 4:3 FILL

RESOLUTION * –

VIDEO

NOISE 
REDUCTION

RANDOM NR * OFF, LOW, MEDIUM, HIGH
MOSQUITO NR OFF OFF, LOW, MEDIUM, HIGH
BLOCK NR OFF OFF, ON

DEINTERLACE AUTO AUTO, VIDEO, FILM
3D Y/C SEPARATION ON OFF, ON
DETAIL ENHANCEMENT *
SIGNAL TYPE RGB RGB, COMPONENT
VIDEO LEVEL AUTO AUTO, NORMAL, ENHANCED

LENS MEMORY
STORE
MOVE
RESET

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
*1	 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
*2	 When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], the [COLOR TEMPERATURE] is not available.

• Basic menu items are indicated by shaded area.
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Menu Item Default Options

SETUP

BASIC

KEYSTONE
HORIZONTAL 0
VERTICAL 0

CORNERSTONE

PIP/PICTURE BY 
PICTURE

PIP/PBP MODE PIP PIP, PICTURE BY PICTURE
PIP POSITION BOTTOM-RIGHT TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, BOTTOM-RIGHT
PIP/PBP SOURCE OFF OFF, VIDEO, S-VIDEO

WALL COLOR OFF OFF, BLACKBOARD, BLACKBOARD (GRAY), LIGHT 
YELLOW, LIGHT BLUE, LIGHT ROSE

LAMP MODE

ECO MODE OFF OFF, ON
LAMP SELECT DUAL DUAL, SINGLE, LAMP1 ONLY, LAMP2 ONLY
LAMP INTERVAL 
MODE OFF OFF, 12 HOURS, 24 HOURS, 1 WEEK

LAMP SWITCHING 
TIME 00:00 00:00 - 24:00

LAMP SWITCHING 
DAY SUN SUN, MON, TUE, WED, THU, FRI, SAT

CLOSED CAPTION OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, 
TEXT1, TEXT2, TEXT3, TEXT4

OFF TIMER OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00

TOOLS ADMINISTRATOR MODE, PROGRAM TIMER, TIME, 
MOUSE

LANGUAGE ENGLISH

ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, 
SVENSKA, 日本語
DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, 
NEDERLANDS, SUOMI
NORSK, TÜRKÇE, РУССКИЙ, , Ελληνικά, 中文, 한국어
ROMÂNĂ, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, 
ไทย

MENU

COLOR SELECT COLOR COLOR, MONOCHROME
SOURCE DISPLAY ON OFF, ON
MESSAGE DISPLAY ON OFF, ON
ID DISPLAY ON OFF, ON
ECO MESSAGE OFF OFF, ON
DISPLAY TIME AUTO 45 SEC MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC
BACKGROUND LOGO BLUE, BLACK, LOGO
FILTER MESSAGE OFF OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H]

INSTALLATION 
(1)

ORIENTATION DESKTOP 
FRONT

DESKTOP FRONT, CEILING REAR, DESKTOP REAR, 
CEILING FRONT

SCREEN SCREEN TYPE 4:3 SCREEN 4:3 SCREEN, 16:9 SCREEN, 16:10 SCREEN
GEOMETRIC CORRECTION OFF OFF, 1, 2, 3

MULTI-SCREEN 
COMP.

MODE OFF OFF, ON
CONTRAST 0
BRIGHTNESS 0

REF. WHITE 
BALANCE

CONTRAST R 0
CONTRAST G 0
CONTRAST B 0
BRIGHTNESS R 0
BRIGHTNESS G 0
BRIGHTNESS B 0
UNIFORMITY R 0
UNIFORMITY B 0

REF. LENS 
MEMORY

STORE
MOVE
RESET
LOAD BY SIGNAL OFF OFF, ON
FORCED MUTE OFF OFF, ON
CALIBRATION

INSTALLATION 
(2)

NETWORK SETTINGS
WIRED LAN, WIRELESS LAN, WPS, NETWORK 
INFORMATION, PROJECTOR NAME, DOMAIN, ALERT 
MAIL, NETWORK SERVICE

CONTROL PANEL LOCK OFF OFF, ON
SECURITY OFF OFF, ON
COMMUNICATION SPEED 38400bps 4800bps, 9600bps, 19200bps, 38400bps, 115200bps
REMOTE SENSOR FRONT/BACK FRONT/BACK, FRONT, BACK

CONTROL ID
CONTROL ID 
NUMBER 1 1–254

CONTROL ID OFF OFF, ON

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
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Menu Item Default Options

SETUP

OPTIONS(1)

AUTO ADJUST NORMAL OFF, NORMAL, FINE

FAN MODE
AUTO MODE: AUTO, HIGH, HIGH ALTITUDE

FLOOR SETTING: FLOOR, CEILING, VERTICAL TILT UP, VERTICAL 
TILT DOWN

SIGNAL SELECT(COMP3) RGB/
COMPONENT RGB/COMPONENT, VIDEO

SEAMLESS SWITCHING OFF OFF, ON

COLOR SYSTEM

VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 
SECAM

S-VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 
SECAM

COMPUTER3 
(VIDEO) AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 

SECAM

SLOT POWER
PROJECTOR ON OFF, ON
PROJECTOR 
STANDBY ENABLE DISABLE, ENABLE

OPTIONS(2)

STANDBY MODE NORMAL NORMAL, POWER-SAVING, NETWORK STANDBY
DIRECT POWER ON OFF OFF, ON
AUTO POWER ON(COMP1/3) OFF OFF, COMPUTER1, COMPUTER3
AUTO POWER OFF OFF OFF, 0:05, 0:10, 0:20, 0:30

DEFAULT SOURCE SELECT LAST LAST, AUTO, COMPUTER1, COMPUTER2, COMPUTER3, 
HDMI, DisplayPort, VIDEO, S-VIDEO, VIEWER, NETWORK

EDGE BLENDING MODE OFF OFF, ON
(ON: TOP, BOTTOM, LEFT, RIGHT, BLACK LVEL)

INFO.

USAGE TIME

LAMP 1 LIFE REMAINING
LAMP 2 LIFE REMAINING
LAMP 1 HOURS USED
LAMP 2 HOURS USED
FILTER HOURS USED
TOTAL CARBON SAVINGS

SOURCE(1)

INPUT TERMINAL
RESOLUTION
HORIZONTAL FREQUENCY
VERTICAL FREQUENCY
SYNC TYPE
SYNC POLARITY
SCAN TYPE
SOURCE NAME
ENTRY NO.

SOURCE(2)

SIGNAL TYPE
VIDEO TYPE
BIT DEPTH
VIDEO LEVEL
LINK RATE
LINK LANE

WIRED LAN

IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS

WIRELESS 
LAN(1)

IP ADDRESS
SUBNET MASK
GATEWAY
MAC ADDRESS

WIRELESS 
LAN(2)

SSID
NETWORK TYPE
WEP/WPA
CHANNEL
SIGNAL LEVEL

VERSION (1)
FIRMWARE
DATA
FIRMWARE2

VERSION (2) FIRMWARE3

OTHERS

PROJECTOR NAME
MODEL NO.
SERIAL NUMBER
LAN UNIT TYPE
CONTROL ID (when [CONTROL ID] 
is set)

RESET

CURRENT SIGNAL
ALL DATA
ALL DATA(INCLUDING ENTRY LIST)
CLEAR LAMP 1 HOURS
CLEAR LAMP 2 HOURS
CLEAR FILTER HOURS

rmcphers
Highlight

rmcphers
Highlight

rmcphers
Highlight

rmcphers
Highlight

rmcphers
Highlight
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4 Menu Descriptions & Functions [SOURCE]

COMPUTER 1, 2, and 3
Selects the computer connected to your COMPUTER 1, 2, or COMPUTER 3 input connector signal.
NOTE: When the component input signal is connected to the COMPUTER 1 IN, COMPUTER 2 IN, or COMPUTER 3 IN connector, select 
[COMPUTER1], [COMPUTER2] or [COMPUTER3] respectively. The projector automatically determines whether the COMPUTER1, 
2, or 3 input signal is an RGB or component signal.

HDMI
Selects the HDMI compatible equipment connected to your HDMI IN connector.

DisplayPort
Projects the image of the device connected to the DisplayPort input connector.

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

S-VIDEO
Selects what is connected to your S-VIDEO input-VCR or DVD player.
NOTE: A frame may freeze for a brief period of time when a video is played back in fast-forward or fast-rewind with a Video or S-
Video source.

VIEWER
This feature enables you to make presentations using a USB memory that contains slides.
(→ page 74 “4. Using the Viewer”)

NETWORK
Selects a signal from the LAN port (RJ-45) or the installed USB wireless LAN unit (optional for models for Europe, 
Australia, Asia and other countries than North America).

SLOT (for optional board)
Selects a signal from the optional board (SB-01HC or other NEC’s interface boards) when it is installed.

ENTRY LIST
Displays a list of signals. See the following pages.

TEST PATTERN
Displays the test pattern. 
NOTE:
•	 The test pattern can be displayed even when the menu is displayed. Unavailable menu items are displayed in grey. 
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Using the Entry List
When any source or lens memory adjustments are made, the adjustments are automatically registered in the Entry 
List. The (adjustment values of) registered signals can be loaded from the Entry List whenever necessary.
However, only up to 100 patterns can be registered in the Entry List. When 100 patterns have been registered in the 
Entry List, an error message is then displayed and no additional patterns can be registered. You should thus delete 
(adjustment values of) signals that are no longer needed.

Displaying the Entry list
1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the  or  button to select [SOURCE].

	 The SOURCE list will be displayed.

	

3.	 Use the , , , or  to select [ENTRY LIST] and press the ENTER button.

	 The ENTRY LIST windows will be displayed.

	 If the ENTRY LIST window is not displayed, switch the menu to [ADVANCED].

	 To switch the menu between [ADVANCED] and [BASIC], select [APPLICATION MENU] → [TOOLS] → 
[ADMINISTRATOR MODE]. (→ page 158)
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Entering the currently projected signal into the Entry List [STORE]

1.	 Press the  or  button to select any number.

2.	 Press the  or  button to select [STORE] and press the ENTER button.

	

Calling up a signal from the Entry List [LOAD]
Press the  or  button to select a signal and press the ENTER button.

Editing a signal from the Entry List [EDIT]

1.	 Press the  or  button to select a signal you wish to edit.

2.	 Press the , , , or  button to select [EDIT] and press the ENTER button.

	 The Edit window will be displayed.

	

SOURCE NAME Enter a signal name. Up to 18 alphanumeric characters can be used.
INPUT TERMINAL Select the input source.
LOCK Set so that the selected signal cannot be deleted when [ALL DELETE] is executed. The 

changes made after LOCK execution cannot be saved.
SKIP Set so that the selected signal will be skipped during auto search.

3.	 Set the above items and select [OK] and press the ENTER button.

NOTE: The input terminal cannot be changed to the currently projected signal.
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Cutting a signal from the Entry List [CUT]

1.	 Press the  or  button to select a signal you wish to delete.

2.	 Press the , , , or  button to select [CUT] and press the ENTER button.

	 The signal will be deleted from the Entry List and the deleted signal will be displayed on the clipboard at the bottom 
of the Entry List.

NOTE:
•	 The currently projected signal cannot be deleted.
•	 When the locked signal is selected, it will be displayed in gray which indicates it is not available.

TIP:
•	 Data on the clipboard can be passed onto the Entry List.
•	 Data on the clipboard will not be lost after the Entry List is closed.

Copying and pasting a signal from the Entry List [COPY] / [PASTE]

1.	 Press the  or  button to select a signal you wish to copy.

2.	 Press the , , , or  button to select [COPY] and press the ENTER button.

	 The copied signal will be displayed on the clipboard at the bottom of the Entry List.

3.	 Press the  or  button to move to the list.

4.	 Press the  or  button to select a signal.

5.	 Press the , , , or  button to select [PASTE] and press the ENTER button.

	 Data on the clipboard will be pasted to the signal.

Deleting all the signals from the Entry List [ALL DELETE]

1.	 Press the , , , or  button to select [ALL DELETE] and press the ENTER button.

	 The confirmation message will be displayed.

2.	 Press the  or  button to select [YES] and press the ENTER button.

NOTE: The locked signal cannot be deleted.
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5 Menu Descriptions & Functions [ADJUST]
[PICTURE]

[MODE]
This function allows you to determine how to save settings for [DETAIL SETTINGS] of [PRESET] for each input.

STANDARD	������������ Saves settings for each item of [PRESET] (Preset 1 through 7)
PROFESSIONAL	����� Saves all the settings of [PICTURE] for each input. 

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta. 
There are six factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set user 
adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values
DICOM SIM.	���������� Recommended for DICOM simulation format.

NOTE: 
•	 The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
•	 DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiol-

ogy (ACR) and the National Electrical Manufacturers Association (NEMA). 
	 The standard specifies how digital image data can be moved from system to system. 

[DETAIL SETTINGS]



110

5. Using On-Screen Menu

[GENERAL]
Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERA-
TURE]. 

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values.
DICOM SIM.	���������� Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

DYNAMIC	�������������� Creates a high-contrast picture.
NATURAL	��������������� Natural reproduction of the picture.
BLACK DETAIL	������� Emphasizes detail in dark areas of the picture.

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

LARGE	������������������� For screen size of 200"
MEDIUM	���������������� For screen size of 150"
SMALL	������������������� For screen size of 100"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: 
•	 When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.
•	 When a color option other than [OFF] is selected for [WALL COLOR], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris.
To increase the contrast ratio, select [ON].
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Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; 
Brightness for each color (RGB) is used to adjust the black level of the screen.

[SATURATION]
Corrects the saturation for all signals.
Adjusts the saturation for the colors red, green, blue, yellow, magenta and cyan.

RED	����������������������� Adjusts the color in red areas, centered around the red.
GREEN	������������������� Adjusts the color in green areas, centered around the green.
BLUE	���������������������� Adjusts the color in blue areas, centered around the blue.
YELLOW	���������������� Adjusts the color in yellow areas, centered around the yellow.
MAGENTA	�������������� Adjusts the color in magenta areas, centered around the magenta.
CYAN	��������������������� Adjusts the color in cyan areas, centered around the cyan.

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/− green to +/− blue. The red level is used as reference.

Input signal CONTRAST BRIGHTNESS SHARPNESS COLOR HUE

COMPUTER/DisplayPort/HDMI (RGB) Yes Yes Yes
No (Yes: SDTV/

HDTV)
No (Yes: SDTV/

HDTV)

COMPUTER/DisplayPort/HDMI 
(COMPONENT)

Yes Yes Yes Yes Yes

VIDEO/S-VIDEO/COMPONENT Yes Yes Yes Yes Yes

VIEWER/NETWORK Yes Yes Yes No No

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; 
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected 
will not be reset.
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[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK	������������������� Use this item to fine tune the computer image or to remove any vertical banding that might appear. This 
function adjusts the clock frequencies that eliminate the horizontal banding in the image.
This adjustment may be necessary when you connect your computer for the first time.

PHASE	������������������� Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is 
evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
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Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

-	 An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.

-	 The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the 
current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, 
its adjustments will be called up and applied.

	 To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] and reset 
the adjustments.

[BLANKING]
Adjusts the display range (blanking) at the top, bottom, left and right edges of the input signal.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (Auto, 0%, 5% and 10%) for signal.

Projected image

Overscaned by 10%

NOTE: 
•	 The [OVERSCAN] item is not available:
	 - �when [NATIVE] is selected for [ASPECT RATIO].
	 - �when [VIEWER] or [NETWORK] is selected for [SOURCE]
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Selecting the Aspect Ratio [ASPECT RATIO]
Use this function to select the screen’s vertical:horizontal aspect ratio.
Select the screen type (4:3 screen, 16:9 screen or 16:10 screen) at the screen setting before setting the aspect ratio. 
(→ page 124)
The projector automatically identifies the signal being input and sets the optimum aspect ratio.

For Computer signal

For Component/Video/S-Video signals

When the screen type is set to 4:3 When the screen type is set to 16:9 or 16:10

Resolution Aspect Ratio
VGA 	 640 × 480 	 4:3
SVGA 	 800 × 600 	 4:3
XGA 	 1024 × 768 	 4:3
WXGA 	 1280 × 768 	 15:9
WXGA 	 1280 × 800 	 16:10
HD(FWXGA) 	 1366 × 768 	 approx. 16:9
WXGA+ 	 1440 × 900 	 16:10
SXGA 	 1280 × 1024 	 5:4
SXGA+ 	 1400 × 1050 	 4:3
WXGA++ 	 1600 × 900 	 16:9
UXGA 	 1600 × 1200 	 4:3
WSXGA+ 	 1680 × 1050 	 16:9
FHD(1080P) 	 1920 × 1080 	 16:9
WUXGA 1920 × 1200 	 16:10

Options Function
AUTO The projector will automatically determine the incoming signal and display it in its aspect ratio. 

The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, 
select the appropriate aspect ratio from the following.

4:3 The image is displayed in 4:3 aspect ratio.
5:4 The image is displayed in 5:4 aspect ratio
16:9 The image is displayed in 16:9 aspect ratio
15:9 The image is displayed in 15:9 aspect ratio
16:10 The image is displayed in 16:10 aspect ratio
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NATIVE The projector displays the current image in its true resolution when the incoming computer signal 
has a lower or higher resolution than the projector’s native resolution. (→ page 2, 223)
When the incoming computer signal has a higher resolution than the projector's native resolution, 
the center of an image will be displayed.

LETTER BOX The image of a letterbox signal (16:9) is stretched equally in the horizontal and vertical directions 
to fit the screen.

WIDE SCREEN The image of a squeeze signal(16:9) is stretched left and right in 16:9.

ZOOM The image of a squeeze signal (16:9) is stretched left and right in 4:3.
Parts of the displayed image are cropped at the left and right edges and therefore not visible.

4:3 FILL The image of a signal(4:3) is stretched left and right in 16:9.

TIP:
•	 Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
•	 The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect 

ratio for a vide source.
	 The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
•	 The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

[RESOLUTION]
This function sets the resolution of a projected image if auto-detect fails to work well.
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[VIDEO]

Using Noise Reduction [NOISE REDUCTION]
This function is used to reduce video noise.

RANDOM NR	��������� Reduces flickering random noise in an image. 
MOSQUITO NR	������ Reduces mosquito noise that appears around the edges of an image during DVD playback.
BLOCK NR	������������� Reduces block noise or mosaic-like patterns by selecting ON.

Selecting Interlaced Progressive Conversion Process Mode [DEINTERLACE]
This function allows you to select an interlaced-to-progressive conversion process for video signals.

AUTO	��������������������� Determines an appropriate interlaced-to-progressive conversion process automatically.
VIDEO	�������������������� Applies a normal interlaced-to-progressive conversion process.
FILM	���������������������� Applies the automatic detection mode for telecine signals. This option is recommended for a movie pic-

ture.

NOTE: This function is not available with RGB signals.

Turning On or Off the 3D Dimensional Separation [3D Y/C SEPARATION]
When projecting an image from a VIDEO input, set to ON to project the highest quality image.

OFF	������������������������ Turns off the 3 dimensional separation feature.
ON	������������������������� Turns on the 3 dimensional separation feature.

NOTE: Only available for NTSC 3.58 video signals.

[DETAIL ENHANCEMENT]
This function enhances the contours of the image when projecting component signals.

NOTE:
This function may not be available depending on the signal or screen setting.

[SIGNAL TYPE]
The projector automatically identifies whether the COMPUTER 1, COMPUTER 2 or COMPUTER 3* input signals are 
RGB or component signals to project the image. If the colors are unnatural, however, try switching the setting.
* For COMPUTER 3, the computer signal and video signal can be selected at SIGNAL SELECT(COMP3).

RGB	����������������������� Switches to the RGB input.
COMPONENT	��������� Switches to the component signal input.



117

5. Using On-Screen Menu

[VIDEO LEVEL]
This function selects video signal level when the projector’s HDMI and DisplayPort input connectors and an external 
device are connected.

AUTO	��������������������� The video level is switched automatically based on the information from the device outputting the signal.
Depending on the connected device, this setting may not be made properly. In this case, switch to “NORMAL” 
or “ENHANCED” from the menu and view with the optimum setting.

NORMAL	���������������� This disables the enhanced mode.
ENHANCED	������������ This improves the image’s contrast, expressing the dark and light sections more dynamically.

Using the Lens Memory Function [LENS MEMORY]

This function serves to store the adjusted values for each input signal when using the LENS SHIFT, ZOOM and FO-
CUS buttons of the projector or the remote control. Adjusted values can be applied to the signal you selected. This 
will eliminate the need to adjust lens shift, focus, and zoom at the time of source selection.

STORE	������������������� Stores the current adjusted values in memory for each input signal.
MOVE	�������������������� Applies the adjusted values to the current signal.
RESET	�������������������� Returns the adjusted values to the last condition.

NOTE:
•	 To store adjusted values common to all the input sources, use the REF. LENS MEMORY function. See page 48, 126.
•	 Lens memory adjustments will be automatically registered the ENTRY LIST. These lens memory adjustments can be loaded from 

the ENTRY LIST. (→ page 107)
	 Note that performing [CUT] or [ALL DELETE] in the ENTRY LIST will delete lens memory adjustments as well as source adjust-

ments. This deletion will not take effect until other adjustments is loaded.
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6 Menu Descriptions & Functions [SETUP]

[BASIC]

Correcting Vertical Keystone Distortion Manually [KEYSTONE]
You can correct vertical distortion manually. (→ page 28)

TIP: When this option is highlighted, pressing the ENTER button will display its slide bar for adjustment.

Selecting Cornerstone Mode [CORNERSTONE]

	

This option allows you to correct trapezoidal distortion.
Selecting this item will display the Cornerstone adjustment screen. (→ page 40)

NOTE: The [CORNERSTONE] item is not available when [KEYSTONE] or [GEOMETRIC CORRECTION] is selected.

Using the PIP/PICTURE BY PICTURE Function [PIP/PICTURE BY PICTURE]
This function allows you to view two different signals simultaneously. (→ page 43)

MODE: 
This option allows you to select two modes: PIP and PICTURE BY PICTURE.
PIP: This option allows you to view a sub picture in the main picture.
PICTURE BY PICTURE: This allows you to view two pictures side by side.

POSITION:
When [PIP] is selected for [MODE], this option allows you to select the position of a sub picture in the main pic-
ture.
The options are: TOP-LEFT, TOP-RIGHT, BOTTOM LEFT, and BOTTOM RIGHT.

NOTE: The [POSITION] cannot be selected when [PICTURE BY PICTURE] is selected.
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SOURCE:
This option allows you to select a sub picture signal.
The options are: OFF, VIDEO and S-VIDEO.
Selecting [OFF] will cancel the PIP/PICTURE BY PICTURE mode and return to the normal screen.

Using the Wall Color Correction [WALL COLOR]

	

This function allows for quick adaptive color correction in applications where the screen material is not white.

[LAMP MODE]
The projector is designed to accept two lamps (dual lamp system). 

This dual lamp system provides prolonged lamp life or high brightness or extra lamp (Extended life lamp). 
The [LAMP MODE] item has 3 options: [ECO MODE], [LAMP SELECT], and [LAMP INTERVAL MODE]. 

NOTE: Be sure to use the same lamp type for both lamp 1 and 2. 

Setting Eco Mode [ECO MODE]
The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO2 emissions. 
Two brightness modes of the lamp can be selected: [OFF] and [ON] modes. 
(→ page 36)
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Selecting the lamp to be used [LAMP SELECT]
This feature allows you to select which lamp to be used. 

NOTE: This option is not displayed in the Basic menu. 

DUAL	��������������������� Select to use the two lamps at the same time to increase brightness. 
SINGLE	������������������ Lights either lamp 1 or 2 whichever was used last. This option also selects Lamp 1 or Lamp 2 according to 

the time preset with Lamp Interval. 
LAMP 1 ONLY	�������� Select to use the Lamp 1 of the two lamps. (Lamp 1 on the right of the rear side)
LAMP 2 ONLY	�������� Select to use the Lamp 2 of the two lamps. (Lamp 2 on the left of the rear side)

TIP:
On Selecting [SINGLE] for [LAMP SELECT]
•	 A lamp has a property that its brightness gradually decreases with age. To keep the brightness of two lamps on the same level as 

much as possible, select [SINGLE] for [LAMP SELECT].
•	 Lamp life will decrease when shorter lamp interval times are set within the on-screen menu. You are recommended to extend the 

lamp interval time.

Setting the lamp interval [LAMP INTERVAL MODE]
This allows you to specify the time for switching between the two lamps alternately. This option is available only when 
[SINGLE] is selected for [LAMP SELECT]. 

OFF	������������������������ Turns off the lamp interval mode setting.
12 HOURS/24 HOURS/1 WEEK
	������������������������������ Select one of these three options for interval time.

NOTE:
•	 This function is available only when [SINGLE] is selected for [LAMP SELECT].
•	 Before setting [LAMP INTERVAL MODE], [LAMP SWITCHING TIME] or [LAMP SWITCHING DAY], make sure that the current date 

and time is set for the projector. To set the date and time for the projector, select [APPLICATION MENU] → [TOOLS] → [DATE 
AND TIME] from the menu. (→ page 162)

Setting the time for changing the lamp [LAMP SWITCHING TIME]
This allows you to set the time for changing the lamp.

Example – When [SINGLE] is selected for [LAMP SELECT] and [24 HOURS] for [LAMP INTERVAL MODE]:

Lamp 1

Lamp 2

24 hours 24 hours

24 hours 24 hours

This indicates the lamp is turned on. 
This indicates the lamp is turned off. 

Current Time Switching Time* Switching Time

(*) After setting the Current Time, if the value between Current Time and Switching Time is less than five (5) minutes, the first 
lamp switching instance does not take place.
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Setting the day for changing the lamp [LAMP SWITCHING DAY]
This allows you to set the day for changing the lamp.
The options are: SUN (Sunday), MON (Monday), TUE (Tuesday), WED (Wednesday), THU (Thursday), FRI (Friday), 
and SAT (Saturday).

NOTE:
•	 This function is available only when [1 WEEK] is selected for [LAMP INTERVAL MODE].

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video 
or S-Video.

OFF	������������������������ This exits the closed caption mode.
CAPTION 1-4	��������� Text is superimposed.
TEXT 1-4	���������������� Text is displayed.

Using Off Timer [OFF TIMER]
1.	 Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.

2.	 Press the ENTER button on the remote control.

3.	 The remaining time starts counting down.

4.	 The projector will turn off after the countdown is complete.

NOTE:
•	 To cancel the preset time, set [OFF] for the preset time or turn off the power.
•	 When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 

MINUTES] message will be displayed on the bottom of the screen.

[TOOLS]
See “APPLICATION MENU” on page 140.

Selecting Menu Language [LANGUAGE] 
You can choose one of 27 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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[MENU]

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as COMPUTER 1, COMPUTER2, COMPUTER3, HDMI, Display-
Port, VIDEO, S-VIDEO, VIEWER, NETWORK to be displayed on the top right of the screen.

Turning messages on and off [MESSAGE DISPLAY]
This option selects whether or not to display projector messages at the bottom of the projected image.
Even when “OFF” is selected, the security lock warning is displayed. The security lock warning turns off when the 
security lock is canceled.

Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY	����������� This option turns on or off the ID number which is displayed when the ID SET button on the remote control 

is pressed. (→ page 127)

Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on. 

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message 
to prompt you to select [ON] for [ECO MODE].

When [ON] is selected for [ECO MODE]

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 
30 seconds.
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When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 36)
To close the message, press the EXIT button.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The 
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is 
[LOGO].

NOTE: 
•	 Even when the background logo is selected, if two pictures are displayed in [PIP/PICTURE BY PICTURE] mode, the blue background 

is displayed without the logo when there is no signal.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean 
the filter when you get the message “PLEASE CLEAN FILTER.” (→ page 180)
Six options are available: OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H]
The default setting is [OFF].

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

[INSTALLATION(1)]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, 
desktop rear projection, and ceiling front projection.

NOTE:
This projector is a tilt-free projector with which it is possible to project images on the ceiling (upward) or floor (downward). When 
changing the projector orientation, also change the [SETTING] option of [FAN MODE] accordingly. (→ page 129)
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DESKTOP FRONT CEILING REAR

DESKTOP REAR CEILING FRONT

Selecting Aspect Ratio and Position for Screen [SCREEN]

Screen type Sets the aspect ratio of the projection screen.

4:3 screen For a screen with a 4:3 aspect ratio

16:9 screen For a screen with a 16:9 aspect ratio

16:10 screen For a screen with a 16:10 aspect ratio

Display position When the screen type is set to 16:9 or 16:10, adjusts the vertical position of the display 
range.

Downward

Upward

NOTE:
•	 After changing the screen type, check the setting of [ASPECT RATIO] in the menu. 
	 (→ page 114)

Using Geometric Correction [GEOMETRIC CORRECTION]
This feature retrieves geometric data registered in the projector memory.
Three presets of geometric data have been registered. To turn off this feature, select [OFF].

NOTE:
•	 The [KEYSTONE] and [CORNERSTONE] adjustments are not available when geometric data is applied.
•	 To clear your geometric data, press the 3D REFORM button for a minimum of 2 seconds.
•	 The [GEOMETRIC CORRECTION] feature can cause an image to be slightly blurred because the correction is made electroni-

cally.
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Using Multi-Screen Compensation [MULTI-SCREEN COMP.]
This feature allows you to match brightness of images projected from multiple projectors.
Before using [MULTI-SCREEN COMP.], you need to match color of images projected from multiple projectors.

MODE	�������������������� OFF: Turns off this function.
ON: Turns on this function. The [BRIGHTNESS] and the [CONTRAST] can be adjusted.

CONTRAST	������������ Adjusts the bright part of the picture.
BRIGHTNESS	��������� Adjusts the dark part of the picture.

Adjusting

1.	 Prepare black and white images so that the images can be displayed on the computer screen.

2.	 Display the black image on the computer screen, and project the image from the projector.

3.	 Select [MULTI-SCREEN COMP.] → [MODE] → [ON].

4.	 Adjust the dark part of the images.

	 Press the H button to select [BRIGHTNESS] and use the  or  to match the black part of another projector.

5.	 Display the white screen on the computer screen.

	 Project the image from two or more projectors.

6.	 Adjust the bright part of the images.

	 Press the H button to select [CONTRAST] and use the  or  to match the white part of another projector.

	 Moving the slide bar toward [+] (plus) can change the white part of the image. Should this happen, move the 
slide bar toward [−] (minus) to adjust the brightness.

TIP:
•	 When you use multiple projectors, you can use the [CONTROL ID] function to operate a single projector or all the projectors from 

the remote control. (→ page 127)
•	 Your setting will not be affected even when [RESET] is done from the menu.

[REF. WHITE BALANCE]
This feature allows you to adjust the white balance for all signals.
The white and black levels of the signal are adjusted for optimum color reproduction.
Uniformity is also adjusted when the redness (R) and blueness (B) of the white color in the screen’s horizontal (left/
right) direction are uneven.

BRIGHTNESS R/BRIGHTNESS G/BRIGHTNESS B
	������������������������������ These adjust the picture’s black color.
CONTRAST R/CONTRAST G/CONTRAST B
	������������������������������ These adjust the picture’s white color.
UNIFORMITY R	������ The further this is set to the + side, the stronger the redness on the left side of the picture (increasing 

towards the left edge) and the weaker the redness on the right side of the picture (decreasing towards the 
right edge).
This is reversed when set to the − side.

UNIFORMITY B	������ The further this is set to the + side, the stronger the blueness on the left side of the picture (increasing 
towards the left edge) and the weaker the blueness on the right side of the picture (decreasing towards the 
right edge).
This is reversed when set to the − side.
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Using the Reference Lens Memory Function [REF. LENS MEMORY]
This function serves to store the adjusted values common to all input sources when using the LENS SHIFT, ZOOM 
and FOCUS buttons of the projector or the remote control. The adjusted values stored in memory can be used as a 
reference to the current.

STORE	������������������� Stores the current adjusted values in memory as a reference.
MOVE	�������������������� Applies the adjusted reference values stored in [STORE] to the current signal.
RESET	�������������������� Returns the adjusted reference values to the factory default setting.
LOAD BY SIGNAL	�� For change to take effect at the time of source selection, select [YES].
FORCED MUTE	������ To turn off the image during lens shift, select [YES].
CALIBRATION	�������� Corrects the adjustable zoom and focus range. 

The adjustable zoom and focus range can vary depending on the lens in use. Be sure to perform [CALIBRA-
TION] after replacement of the lens.

NOTE: 
The following lenses need calibration:
•	 NP26ZL, NP27ZL, NP28ZL, NP29ZL

NOTE:
•	 Adjusted values in [REF.LENS MEMORY] will not be returned to default when performing [CURRENT SIGNAL] or [ALL DATA] for 

[RESET] from the menu.
•	 To store adjusted values for each input source, use the Lens Memory function. (→ page 48, 117)
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[INSTALLATION(2)]

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
•	 This CONTROL PANEL LOCK does not affect the remote control functions.
•	 When the control panel is locked, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will change 

the setting to [OFF].

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [  ] will be displayed at the bottom right of the menu.

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 45)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 115200 bps. 
The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the 
equipment, a lower baud rate may be recommended for long cable runs).

NOTE:
•	 Select [38400bps] or less when using the User Supportware.
•	 Your selected communication speed will not be affected even when [RESET] is done from the menu.

Turning On or Off Remote Sensor [REMOTE SENSOR]
This option determines which remote sensor on the projector is enabled in wireless mode.
The options are: FRONT/BACK, FRONT, and BACK. 
If the remote control system does not function when direct sunlight or strong illumination strikes the remote control 
sensor of the projector, change another option.

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL 
ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together 
using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER	�������Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID	�����������������������Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID set-

ting.
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NOTE: 
•	 When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support 

the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
•	 Your setting will not be affected even when [RESET] is done from the menu.
•	 Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control 

ID.

Assigning or Changing the Control ID
1.	 Turn on the projector.

2.	 Press the ID SET button on the remote control.

	 The CONTROL ID screen will be displayed.

	 If the projector can be operated with the current remote control ID, the [ACTIVE] 
will be displayed. If the projector cannot be operated with the current remote control 
ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the 
control ID used for the projector by using the following procedure (Step 3).

3.	 Press one of numeric keypad buttons while pressing and holding the ID SET 
button on the remote control.

	 Example:

	 To assign “3”, press the “3” button on the remote control.

	 No ID means that all the projectors can be operated together with a single remote 
control. To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.
4.	 Release the ID SET button.

	 The updated CONTROL ID screen will be displayed.

NOTE: 
•	 The IDs can be cleared in a few days after the batteries are run down or removed.
•	 Accidentally pressing any one of the buttons of the remote control will clear currently specified 

ID with batteries removed.
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[OPTIONS(1)]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for 
noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF	������������������������ The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL	���������������� Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE	����������������������� Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NOR-

MAL]is selected.

Selecting Fan Mode [FAN MODE]
Fan Mode is used to set the speed of the internal cooling fan.

MODE	�������������������� Select three modes for fan speed: AUTO, HIGH, and HIGH ALTITUDE.
AUTO: The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH: The built-in fans run at high speed
HIGH ALTITUDE: The built-in fans run at a high speed. Select this option when using the projector at altitudes 
approximately 5500 feet/1600 meters or higher. 

SETTING	���������������� Select one of the four options ([FLOOR], [CEILING], [VERTICAL TILT DOWN], or [VERTICAL TILT UP])
according to the installation angle of the projector. See the drawing below.
NOTE: Be sure to select the [SETTING] option according to the projector’s orientation. Failure to do so may 
cause product malfunction.
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When you wish to cool down the temperature inside the projector quickly, select [HIGH].
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NOTE: 
•	 When [HIGH ALTITUDE] is selected for [FAN MODE], a symbol icon  will be displayed at the bottom of the menu.
•	 It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher.
•	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause 

the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
•	 Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the 

lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
•	 Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of internal parts such as the 

lamp.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Selecting the Signal Format [SIGNAL SELECT(COMP3)]
When an output device is connected to the COMPUTER 3 video input connectors, this sets the input signal.

RGB/COMPONENT	��������RGB and component signals are identified automatically.
VIDEO	���������������������������This switches to the video signal.

NOTE: When a video cable (commercially available) is connected to the COMPUTER 3 video input connectors’ G/Y connector, video 
signals can be projected. In this case, set to “VIDEO”.

[SEAMLESS SWITCHING] 
When the input connector is switched, the image displayed before switching is held to switch to the new image without 
a break due to absence of a signal.

[COLOR SYSTEM]
This feature allows you to select the TV video signal, which differs from country to country (NTSC, PAL, etc.).
This is set to [AUTO] by factory default. Set this if the projector cannot identify the signal automatically.

Setting for the Optional Board [SLOT POWER]
When using the optional board such as SB-01HC installed in the slot, set the following options.

PROJECTOR ON	�����������������This feature will turn on or off the power to the optional board. 

OFF: Forcibly turn off the power to the optional board installed in the slot.
ON (Default): Turn on the power to the optional board installed in the slot.

PROJECTOR STANDBY	�������This feature will automatically enable or disable the optional board installed in the slot 
when the projector is in standby.

DISABLE: Select this option to disable the optional board in the projector standby.
ENABLE (Default): Select this option to enable the optional board in the projector standby.

NOTE:
•	  Select [OFF] when the optional board is not installed into the slot.
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[OPTIONS(2)]

Selecting Power-saving in [STANDBY MODE]
The projector has three standby modes: [NORMAL], [POWER-SAVING] and [NETWORK STANDBY].
The POWER-SAVING mode is the mode that allows you to put the projector in the power-saving condition which 
consumes less power than the NORMAL mode. The projector is preset for NORMAL mode at the factory.

NORMAL	�����������������������������Power indicator: Orange light/STATUS indicator: Green light
POWER-SAVING	�����������������Power indicator: Red light/STATUS indicator: Off

The following connectors, buttons or functions will not work during this mode.
- MONITOR OUT (COMP. 1) connector
- LAN and Mail Alert functions
- Buttons other than POWER button on the cabinet
- Buttons other than POWER ON button on the remote control
- Virtual Remote Tool fucntion
- [AUTO POWER ON (COMP1/3)]
- PC control commands for other than power-on

NETWORK STANDBY	����������When in the standby mode, the POWER indicator will light orange and the STATUS indicator will 
not light. This shows that the projector’s power can be turned on by wired LAN.
When in the standby mode, the following connectors, buttons or functions will not work:
- MONITOR OUT (COMP. 1) connector
- Wireless LAN Unit
- [AUTO POWER ON (COMP1/3)]
- Buttons other than POWER button on the cabinet
- Buttons other than POWER ON button on the remote control
- PC control commands for other than power-on

Important:
•	 When [CONTROL PANEL LOCK] or [CONTROL ID] is turned on, or when [COMPUTER 1] or [COMPUTER 3] is selected for [AUTO 

POWER ON(COMP1/3)], the [STANDBY MODE] setting becomes invalid.
	 This means that the projector is in the same condition when the [NORMAL] is selected for [STANDBY MODE].

NOTE: 
•	 Even when [POWER-SAVING] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
•	 The power consumption in the standby mode will not be included in calculating CO2 emission reduction.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the 
need to always use the POWER button on the remote control or projector cabinet.
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Turning On the Projector By Applying Computer Signal [AUTO POWER ON(COMP1/3)]
When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER1 
IN or COMPUTER3 IN input will power on the projector and simultaneously project the computer’s image.
This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet 
to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE: 
•	 Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in com-

bination of the AUTO POWER OFF function.
•	 This function will not be available under the following conditions:

-	 when a component signal is applied to the COMPUTER1 IN or COMPUTER3 IN connector
-	 when a Sync on Green RGB signal or composite sync signal is applied

•	 When [AUTO POWER ON(COMP1/3] is set, the [STANDBY MODE] setting becomes invalid. This means that the projector is in 
the same condition when the [NORMAL] is selected for [STANDBY MODE].

•	 To enable the AUTO POWER ON (COMP1/3) after turning off the projector, wait 3 seconds and input a computer signal.
	 If a computer signal is still present when the projector is turned off, the AUTO POWER ON (COMP1/3) will not work and the 

projector remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5min., 10min., 
20min., 30min.) if there is no signal received by any input or if no operation is performed.

NOTE:
•	 The [AUTO POWER OFF] function will not work when [VIEWER] or [NETWORK] is selected for [SOURCE].

Selecting Default Source [DEFAULT SOURCE SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST	���������������������� Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO	��������������������� Searches for an active source in order of COMPUTER1 → COMPUTER2 → COMPUTER3 → HDMI → 

DisplayPort → VIDEO → S-VIDEO → VIEWER → COMPUTER1 and displays the first found source.
COMPUTER1	��������� Displays the computer signal from the COMPUTER 1 IN connector every time the projector is turned on.
COMPUTER2	��������� Displays the computer signal from the COMPUTER 2 IN connector every time the projector is turned on.
COMPUTER3	��������� Displays the computer signal from the COMPUTER 3 IN connector every time the projector is turned on.
HDMI	��������������������� Displays the digital source from the HDMI IN connector every time the projector is turned on. 
DisplayPort	������������ Displays the digital source from the DisplayPort every time the projector is turned on. 
VIDEO	�������������������� Displays the Video source from the VIDEO IN connector every time the projector is turned on.
S-VIDEO	���������������� Displays the Video source from the S-VIDEO IN connector every time the projector is turned on.
VIEWER	����������������� Displays slides or plays back movie files from the USB memory device every time the projector is turned 

on.
NETWORK	������������� Displays the data sent from the computer via the LAN port (RJ-45) or the wireless LAN unit (sold separately) 

mounted on the projector is projected.
SLOT	���������������������� Displays a signal from the optional (SB-01HC or other NEC’s optional boards) when it is installed.
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[EDGE BLENDING]
This function adjusts overlapping edges of images projected from each projector to uniform multi-screen images.

Turns on or off the Edge Blending function. [MODE]
Turning on [MODE] will make [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL] available. (Default: OFF).

Selects edge of top, bottom, left, and right of the screen to perform the Edge Blending function. 
[TOP/BOTTOM/LEFT/RIGHT]
Turning on [CONTROL] will make [MARKER], [RANGE], and [POSITION] available. (→ page 52)

CONTROL	�������������� Turns on or off [TOP], [BOTTOM], [LEFT], and [RIGHT].
MARKER	���������������� Turns on or off a marker for the range and position adjustment. Turning on [MARKER] will display a magenta 

marker for [RANGE] and green marker for [POSITION].
RANGE	������������������� Adjusts the Edge Blending range (width).
POSITION	�������������� Adjusts the Edge Blending start position.

Adjusts the brightness level of 9-segmented portions. [BLACK LEVEL]
9-segmented portions are [TOP-LEFT], [TOP-CENTER], [TOP-RIGHT], [CENTER-LEFT], [CENTER], [CENTER-
RIGHT], [BOTTOM-LEFT], [BOTTOM-CENTER], and [BOTTOM-RIGHT]. (→ page 55)
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7 Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has nine pages. The information included is as 
follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP 1 LIFE REMAINING] (%)*
[LAMP 2 LIFE REMAINING] (%)*
[LAMP 1 HOURS USED] (H)
[LAMP 2 HOURS USED] (H)
[FILTER HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)

*	 The progress indicator shows the percentage of remaining bulb life.

	 The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE 
REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.

	 If the remaining lamp time reaches 0 hours, the projector will not turn on.

•	 The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when 
the projector is turned on and when the POWER button on the projector or the remote control is pressed.

	 To dismiss this message, press any button on the projector or the remote control.

Lamp life(H)
Replacement lampECO MODE

OFF ON
2000 2500 NP22LP

NOTE:
Tilting the front of the projector up or down by more than 10° from level could reduce lamp life by up to 20%.

•	 [TOTAL CARBON SAVINGS]

	 This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving cal-
culation is based on the OECD (2008 Edition). (→ page 37)



135

5. Using On-Screen Menu

[SOURCE(1)]

INPUT TERMINAL	 RESOLUTION	
HORIZONTAL FREQUENCY	 VERTICAL FREQUENCY	
SYNC TYPE	 SYNC POLARITY	
SCAN TYPE	 SOURCE NAME	
ENTRY NO.

[SOURCE(2)]

SIGNAL TYPE	 VIDEO TYPE	
BIT DEPTH	 VIDEO LEVEL	
LINK RATE	 LINK LANE

[WIRED LAN]

IP ADDRESS	 SUBNET MASK	
GATEWAY	 MAC ADDRESS
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[WIRELESS LAN(1)]

IP ADDRESS	 SUBNET MASK	
GATEWAY	 MAC ADDRESS

[WIRELESS LAN(2)]

SSID	 NETWORK TYPE	
WEP/WPA	 CHANNEL	
SIGNAL LEVEL

[VERSION(1)]

FIRMWARE	 DATA	
FIRMWARE2
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[VERSION(2)]

FIRMWARE3

[OTHERS]

PROJECTOR NAME	 MODEL NO.	
SERIAL NUMBER	 LAN UNIT TYPE	
CONTROL ID (when [CONTROL ID] is set)
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8 Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except 
the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. 
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], 
[ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [ENTRY LIST], [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SCREEN], 
[GEOMETRIC CORRECTION], [MULTI-SCREEN COMP.], [REF.WHITE BALANCE], [CONTROL PANEL LOCK], 
[SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [SEAMLESS SWITCHING], [STANDBY MODE], 
[FAN MODE], [EDGE BLENDING], [REF. LENS MEMORY], [DATE AND TIME], [LAMP LIFE REMAINING], [LAMP 
HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and [WIRELESS LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

[ALL DATA (INCLUDING ENTRY LIST)]
Reset all the adjustments and settings for all the signals to the factory preset except [LANGUAGE], [BACKGROUND], 
[FILTER MESSAGE], [SCREEN], [MULTI-SCREEN COMP.], [REF. WHITE BALANCE], [CONTROL PANEL LOCK], 
[SEAMLESS SWITCHING], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [FAN MODE], [EDGE BLEND-
ING], [GEOMETIRC CORRECTION], [REF. LENS MEMORY], [DATE AND TIME], [STANDBY MODE], [LAMP LIFE 
REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and 
[WIRELESS LAN].
Also deletes all the signals in the [ENTRY LIST] and returns to the factory preset.

NOTE: Locked signals in Entry List cannot be reset.

Clearing Lamp Hour Meter [CLEAR LAMP 1 HOURS/CLEAR LAMP 2 HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the 
lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the 
HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.
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Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

The [OFF] item is selected for [FILTER MESSAGE] at the time of shipment. When [OFF] is selected, you do not need 
to clear the filter usage hour.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
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❾ Application Menu
When [NETWORK] is selected from the [SOURCE] menu, the application menu [APPLICATION MENU] will be dis-
played.
The application menu allows you to set up the User Supportware, Network Settings (NETWORK SETTINGS) and 
Tools (TOOLS).
The User Supportware can be downloaded from our website.
In [ADMINISTRATOR MODE], either [ADVANCED] menu or [BASIC] menu can be selected. (→ page 158)
The [BASIC] menu contains minimum essentials of menus and commands. 

IMAGE EXPRESS UTILITY
This shows information for projector name, resolution, and network (wired/wireless) which are required to use Image 
Express Utility.
Use this information to set up for your computer.

NETWORK PROJECTOR
This shows information for projector name, resolution, and network (wired/wireless) which are required to use Network 
Projector.
Use this information to set up for your computer.
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REMOTE DESKTOP CONNECTION
This allows you to set up for computer name entry and effects for Remote Desktop.

NOTE:
•	 A USB keyboard is required to set up the Remote Desktop Connection.
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NETWORK SETTINGS

Important:
•	 Consult with your network administrator about these settings.
•	 When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 

173) 

TIP: The network settings you make will not be affected even when [RESET] is done from the menu.

Hints on How to Set Up LAN Connection 

To set up the projector for a LAN connection:
Select [WIRED LAN] or [WIRELESS LAN] → [PROFILES] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for wired or wireless LAN.
Next turn on or off for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY] and select [OK] and press the 
ENTER button. (→ page 143)
To recall LAN settings stored in the profile number:
Select [PROFILE 1] or [PROFILE 2] for wired or wireless LAN, and then select [OK] and press the ENTER button. 
(→ page 143)
To connect a DHCP server:
Turn on [DHCP] for wired or wireless LAN. Select [ON] and press the ENTER button. To specify IP address without 
using the DHCP server, turn off [DHCP]. (→ page 144)
To set only for wireless LAN (NETWORK TYPE and WEP/WPA):
Select [PROFILE 1] or [PROFILE 2] for wireless LAN, and then select [ADVANCED] and [OK] and press the ENTER 
button. The Advanced menu will be displayed. (→ page 145)
To select an SSID:
Select [ADVANCED] → [SITE SURVEY] and press the ENTER button.
Select an SSID and press the > button to select [OK] and press the ENTER button.
If you do not use [SITE SURVEY], type the SSID and select [INFRASTRUCTURE] or [AD HOC]. (→ page 145)
To receive lamp replacement time or error messages via e-mail:
Select [ALERT MAIL], and set [SENDER'S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT'S ADDRESS]. 
Last, select [OK] and press the ENTER button. (→ page 156)
To execute [EASY CONNECTION] using Image Express Utility 2.0 or Image Express Utility 2 for Mac:
The [EASY CONNECTION] is a mode that can abbreviate the troublesome LAN settings when using the Image 
Express Utility and connecting the PC and projector via a wireless LAN.
Image Express Utility 2.0 and Image Express Utility 2 for Mac are contained on the supplied NEC Projector CD-
ROM. 
To use [EASY CONNECTION], select [WIRELESS LAN] → [PROFILES] → [EASY CONNECTION]. 
NOTE: The [EASY CONNECTION] function is available on Windows 7, Windows Vista or Windows XP SP3. 
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WIRED LAN or WIRELESS LAN (ADVANCED menu only)

* To use the wireless LAN functions, connect a separately sold wireless LAN unit to the projector. (→ page 174)

PROFILES •	 Up to two settings for the LAN port or USB wireless LAN unit 
can be stored in memory of the projector. Total of four settings 
can be stored.

	 Five settings can be stored: two for the built-in LAN port, two 
for wireless LAN and one for WPS.

•	 Select [PROFILE 1] or [PROFILE 2] and then do settings for 
[DHCP] and the other options. 

	 After doing this, select [OK] and press the ENTER button. This 
will store your settings in memory.

•	 To recall the settings from memory:
	 After selecting [PROFILE 1] or [PROFILE 2] from the [PRO-

FILES] list.
	 Select [OK] and press the ENTER button. 
•	 To stop emitting radio waves from the USB Wireless LAN Unit, 

select [DISABLE] from the [PROFILES] list.
•	 Selecting [SIMPLE ACCESS POINT] will allow the projector to 

create an infrastructure network.
	 An SSID will be automatically created.
	 When the IP address of the projector is changed, it will auto-

matically take effect in one or two minutes.
	 Select “Obtain an IP Address Automatically” to set the IP ad-

dress of a connected computer.
	 It takes a few seconds for a change of your computer’s IP ad-

dress to come into effect in Windows 7/Windows Vista while it 
takes one or two minutes in Window XP.

	 When you connect with your computer to save your profile 
and select “Automatically connect when within range” from the 
Properties tab of Wireless Network in Windows for your selected 
profile, your wireless LAN will be accessed under the following 
conditions:
•	 at the time of turning on the computer or the projector
•	 when the notebook type is within the range of the projector’s 

wireless LAN can be achieved.
	 Data transmission between wireless LAN and wired LAN is not 

possible.
	 When the [SIMPLE ACCESS POINT] mode is used to send 

images, it is recommended to connect to only one computer.

—
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•	 When selecting [WPS], the network will be connected by using 
settings stored automatically with the WPS function.

	 Selecting [WPS] will allow the projector to access the network 
by using the settings the WPS function automatically stored.

DHCP Place a check mark to automatically assign an IP address to the 
projector from your DHCP server.
Clear this check box to register the IP address or subnet mask 
number obtained from your network administrator.

—

IP ADDRESS Set your IP address of the network connected to the projector 
when [DHCP] is turned off.

Up to 12 numeric 
characters

SUBNET MASK Set your subnet mask number of the network connected to the 
projector when [DHCP] is turned off.

Up to 12 numeric 
characters

GATEWAY Set the default gateway of the network connected to the projector 
when [DHCP] is turned off. 

Up to 12 numeric 
characters

WNS CONFIGURA-
TION

Set the IP address of your WINS server of the network connected 
to the projector when [DHCP] is turned off. 

Up to 12 numeric 
characters

AUTO DNS Place a check mark to automatically assign the IP address of your 
DNS server connected to the projector from your DHCP server.
Clear this check box to set the IP address of your DNS server 
connected to the projector.

Up to 12 numeric 
characters

DNS CONFIGURA-
TION

Set the IP address of your DNS server on the network connected 
to the projector when [AUTO DNS] is cleared.

Up to 12 numeric 
characters

ADVANCED* This menu allows you to set various items for your wireless LAN 
connection (network type, security).

—

RECONNECT Retry to connect the projector to a network. Try this if you have 
changed [PROFILES]. 

—

* The [ADVANCED] setting screen is available for [WIRELESS LAN] only.

NOTE:
•	 If you select [EASY CONNECTION] from [PROFILES], you cannot make settings to DHCP and its following items except [CHAN-

NEL] in [ADVANCED].
 
Advanced Settings (settings only required when using a separately sold wireless LAN unit) 
(ADVANCED menu only)
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SITE SURVEY Displays a list of available SSIDs for wireless LAN on site. Select 
an SSID which you can access.
To select an SSID, highlight [SSID] and use the  to select [OK] 
and press the ENTER button. 

	����������������������� Wireless access point 

	����������������������� Ad Hoc PC 

	����������������������� WEP or WPA enabled

—

SECURITY This will turn on or off the encryption mode for secure transmis-
sion.
To use encryption, specify a WEP key or encryption key. Select 
your security type appropriate for your computer and the wire-
less LAN unit.

DISABLE	���������������� Will not turn on the encryption feature. Your com-
munications may be monitored by someone.

WEP(64bit)	������������ Uses 64-bit datalength for secure transmis-
sion.

WEP(128bit)	���������� Uses 128-bit datalength for secure transmission. 
This option will increase privacy and security 
when compared to use of 64-bit datalength en-
cryption.

WPA-PSK/WPA2-PSK/WPA-EAP/WPA2-EAP
	������������������������������ These options provide stronger security than 

WEP.

NOTE:
•	 The security type, WEP key, and encryption key settings must be the 

same as communication devices such as PC or access point in your 
wireless network.

•	 When you use [SECURITY], your image transmission speed will slow 
down.

•	 [WPA-PSK], [WPA-EAP], [WPA2-PSK] and [WPA2-EAP] are not avail-
able when [AD HOC] is selected from [NETWORK TYPE].

 

—

SSID Enter an identifier (SSID) for wireless LAN. Communication can 
be done only with equipment whose SSID matches SSID for your 
wireless LAN. 

Up to 32 alphanumeric 
characters (case 
sensitive).

NETWORK TYPE Select communication method when using wireless LAN.

INFRASTRUCTURE	���Select this option when communicating with 
one or more equipment connected to the wire-
less or wired LAN network via a wireless access 
point.

AD HOC	��������������������Select this option when using the wireless LAN 
to directly communicate with a computer in 
peer-to-peer mode. 

—

CHANNEL Select a channel. Available channels vary depending on the 
country and region. When you select [INFRASTRUCTURE], make 
sure that the projector and your access point are on the same 
channel; when you select [AD HOC], make sure that the projector 
and your computer are on the same channel.

—
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When [WEP(64bit)] or [WEP(128bit)] is selected for [SECURITY TYPE]

KEY SELECT Selects one WEP key from the four keys below.

KEY1, KEY2, KEY3, 
KEY4

Enter a WEP key.
• Maximum number of characters

Option Alphanumeric (ASCII) Hexadecimal (HEX)

WEP 64bit 5 10

WEP 128bit 13 26

When [WPA-PSK], [WPA-EAP], [WPA2-PSK], or [WPA2-EAP] is selected for [SECURITY TYPE]

ENCRYPTION TYPE Select [TKIP] or [AES].

KEY Enter encryption key. Key length must be 8 or greater and 63 or less.
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[AUTHENTICATION] (required for wireless only)
Setting is required for using WPA-EAP or WPA2-EAP. 

Preparation before setting
Select a wireless LAN compliant WPA-EAP or WPA2-EAP authentication and install a digital certificate on the projec-
tor.

1.	 Set [DATE AND TIME] on the projector. (→ page 162)

2.	 Use a computer to save digital certificates (files) for WPA-EAP or WPA2-EAP setting to your USB memory 
device.

	 After completing saving the file, remove the USB memory device from the computer.

Important:
•	 The file formats of digital certificate that are supported by the projector are DER and PKCS#12 only.
•	 The projector cannot handle any digital certificate whose file size exceeds 8 KB.
•	 CRL (Certificate Relocation List) is not supported.
•	 Client certificate chain is not supported.
 
3.	 Plug the USB memory device into the USB port of the projector.

Setting Procedures
1.	 Select [NETWORK SETTINGS] → [WIRELESS LAN].

2.	 Set items such as PROFILES, DHCP, IP ADDRESS, SUBNET MASK and others as required.

•	 Select [PROFILE 1] or [PROFILE 2] for [PROFILES]. If [EASY CONNECTION] is selected, WPA-PSK, WPA2-
PSK, WPA-EAP, or WPA2-EAP is not available.

3.	 Select [ADVANCED] and press the ENTER button.

	 The [ADVANCED] setting screen will be displayed.
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4.	 Select [SITE SURVEY] and press the ENTER button.

	 The “SSID” list will be displayed.

5.	 Select a connecting SSID, and then select [OK].

	 Finally press the ENTER button.

•	 Select the SSID for which WPA-PSK or WPA2-PSK is set.

•	 Select [INFRASTRUCTURE ( )] for [NETWORK TYPE]. WPA-PSK, WPA2-PSK, WPA-EAP, or WPA2-EAP is 
not available when [AD HOC ( )] is selected.

6.	 Select the [SECURITY] tab.

	 The [SECURITY] page will be displayed.

7.	 Select the [SECURITY TYPE] field and press the ENTER button.

	 The pull-down list will be displayed.

8.	 Select [WPA-EAP] or [WPA2-EAP] and press the ENTER button.

9.	 Select the [TKIP/AES] field and press the ENTER button.

	 The pull-down list will be displayed.

10.	Select [TKIP] or [AES] and press the ENTER button.

	 Select [TKIP] or [AES] according to the setting for your access point.
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11.	Select the [AUTHENTICATION] tab.

	 The [AUTHENTICATION] page will be displayed.

	 Select either [EAP-TLS] or [PEAP-MSCHAPv2] for [EAP TYPE]. The setting items vary depending on the EAP 
type.

	 See the table below.

EAP Type Setting Item Note

EAP-TLS User Name 1 character or more and 32 characters or 
less

Client Certificate PKCS#12 format file

CA Certificate
(Certificate authority’s certificate)

DER format file

PEAP-MSCHAPv2 User Name 1 character or more and 32 characters or 
less

Password 1 character or more and 32 characters or 
less

CA Certificate
(Certificate authority’s certificate)

DER format file

① Selecting [EAP-TLS] for [EAP TYPE]:
	 The following section explains the operation for selecting [EAP-TLS].

	 For selecting [PEAP-MSCHAPv2], go on to Step 12 on page 151.

12.	Select the [USER NAME] field and press the ENTER button.

 

	 The character entry screen (software keyboard) will be displayed. Set a user name.

•	 A user name must be 1 character or more and 32 characters or less.

	 (→ page 153)
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13.	Select [CLIENT CERTIFICATE] and press the ENTER button.

A list of files (thumbnail screen) will be displayed.

•	 For operating the thumbnail screen, see “4. Using the Viewer” in the “User’s Manual” (PDF).

•	 To return to the [AUTHENTICATION] page, press the EXIT button.

NOTE:
Installing a digital certificate
You can install each digital certificate (client certificate and CA certificate) for [PROFILE 1 (or 2)] on a file-by-file basis.
•	 Install a root CA certificate for a CA certificate.
•	 If you install a digital certificate over your existing digital certificate, the existing digital certificate will be overwritten with the new 

digital certificate.
•	 Once a digital certificate has been installed, its information cannot be deleted even if you stop setting WPA-EAP or WPA2-EAP.

14.	On the thumbnail screen, select a digital certificate (PKCS#12 format file) saved in your USB memory device 
and press the ENTER button.

	 The password screen will be displayed. 

15.	Select [PASSWORD] field and press the ENTER button.

 

	 The character entry screen (software keyboard) will be displayed. Set the password of the private key. A password 
must be 1 character or more and 32 characters or less.

	 The selected digital certificate file will be installed on the projector. 

•	 When the root CA certificate is not included in the file that was selected in Step 14, proceed to Step 16. When 
the root certification authority certificate is included, proceed to Step 18. 

16.	Select [CA CERTIFICATE] and press the ENTER button.

	 The drive list screen will be displayed.
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17.	On the thumbnail screen, select a digital certificate (DER format file) saved in your USB memory device 
and press the ENTER button.

•	 Select your root CA certificate here. 

	 The selected digital certificate will be installed on the projector.

18.	After completing required settings, select [OK] and press the ENTER button.

	 The [WIRELESS] page will be returned.

19.	Select [RECONNECT] and press the ENTER button.

20.	Select [OK] and press the ENTER button.

This will complete setting [EAP-TLS] for [EAP TYPE] in [WPA-EAP] or [WPA2-EAP].

TIP:
Clearing the digital certificate that is installed on the projector
To clear the digital certificate installed on the projector, follow the steps below.
By doing the following procedure, all the digital certificates for the currently displayed profile will be cleared.
1.	 Select [CLEAR CERTIFICATES] in the bottom left of the [AD-

VANCED] setting screen and press the ENTER button.

	 A message for confirmation will be displayed.

2.	 Select [YES] and press the ENTER button.

	 The digital certificates will be cleared.

TIP:
•	 The PKCS#12 format digital certificate including a CA certificate will be installed as a root CA certificate.

② Selecting [PEAP-MSCHAPv2] for [EAP TYPE]:

12.	From the [AUTHENTICATION] page, select [EAP TYPE] field and press the ENTER button.

	 The pull-down list will be displayed.

13.	Select [PEAP-MSCHAPv2] and press the ENTER button.

14.	Select [USER NAME] field and press the ENTER button.

	 The character entry screen (software keyboard) will be displayed. Set a user name.

•	 A user name must be 32 characters or less.

	 (→ page 153)
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15.	After completing setting a user name, select the [PASSWORD] field and press the ENTER button.

	 The character entry screen (software keyboard) will be displayed. Set a password.

•	 A password must be 32 characters or less.

16.	After completing setting the password, select [CA CERTIFICATE] field and press the ENTER button.

	 The drive list screen will be displayed.

•	 For operating the thumbnail screen, see “4. Using the Viewer” in the “User’s Manual” (PDF).

•	 To return to the [AUTHENTICATION] page, press the EXIT button.

NOTE:
Installing a digital certificate
You can install each digital certificate (client certificate and CA certificate) for [PROFILE 1 (or 2)] on a file-by-file 
basis.
•	 Install a root CA certificate for a CA certificate.
•	 If you install a digital certificate over your existing digital certificate, the existing digital certificate will be overwritten with the new 

digital certificate.
•	 Once a digital certificate has been installed, its information cannot be deleted even if you stop setting WPA-EAP or WPA2-EAP.

17.	On the thumbnail screen, select a digital certificate (DER format file) saved in your USB memory device 
and press the ENTER button.

•	 Select your root CA certificate here. 

	 The selected digital certificate will be installed on the projector.
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18.	After completing required settings, select [OK] and press the ENTER button.

	 The [WIRELESS] page will be returned.

19.	Select [RECONNECT] and press the ENTER button.

20.	Select [OK] and press the ENTER button.

This will complete setting [PEAP-MSCHAPv2] for [EAP TYPE] in [WPA-EAP] or [WPA2-EAP].

TIP:
Clearing the digital certificate that is installed on the projector
To clear the digital certificate installed on the projector, follow the steps below.
By doing the following procedure, all the digital certificates for the currently displayed profile will be cleared.
1.	 Select [CLEAR CERTIFICATES] in the bottom left of the [AD-

VANCED] setting screen and press the ENTER button.

	 A message for confirmation will be displayed.

2.	 Select [YES] and press the ENTER button.

	 The digital certificates will be cleared.

TIP:
Entering WEP keys (Switching between Alphanumeric characters and hexadecimal)
To enter from [KEY1] to [KEY4], do the following:
1.	 Select one of [KEY 1], [KEY 2], [KEY 3] and [KEY 4] and press the ENTER button. 

	 The character entry screen (software keyboard) will be displayed.

2.	 Use the ▼, ▲, ◀, or ▶ button to select a character and press the ENTER button.

•	 To enter a WEP key or passphrase, use alphanumeric characters (ASCII) or hexadecimal (HEX). To enter a PSK 
key, use alphanumeric characters (ASCII).

•	 Press the [HEX] button to change to [ASCII] to set the key in ASCII digit. You can toggle this button between 
[ASCII] and [HEX].

•	 Enter 0x(numeral and alphabet respectively) right in front of your key code.

•	 Hexadecimal uses 0 to 9 and A to F.

3.	 After entering your WEP key or passphrase, use the ▼, ▲, ◀, or ▶ button to select [OK] and press the ENTER 
button.

	 The character entry screen (software keyboard) will be closed.
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WPS
When the wireless LAN access point connected to the projector supports WPS (Wi-Fi Protected Setup TM), you can 
use PIN method or push button method to set up the wireless LAN for the projector.

PIN TYPE Set a 4-digit or 8 digit-PIN code of WPS for your access point to complete setting for the 
SSID security.

PUSH BUTTON TYPE Press the dedicated button of the access point and the projector’s wireless LAN unit to 
complete setting for the SSID security.

NETWORK INFORMATION
The following information will be displayed when the projector is connected to a network (wired LAN or wireless 
LAN).

PROJECTOR NAME

HOST NAME

DOMAIN

NETWORK INFOR-
MATION (WIRED 
LAN/WIRELESS LAN)

CONNECTION STATUS, IP ADDRESS, SUBNET MASK, GATEWAY, WINS, DNS, MAC 
ADDRESS, SSID, NETWORK TYPE, WEP/WPA, CHANNEL, SIGNAL LEVEL, AU-
THENTICATION, AUTHENTICATION PERIOD

DISPLAY THE INFOR-
MATION IN APPLICA-
TION MENU

Turn on or off the display of the network information.

 The meanings of these status statements are described below.

Statement Authentication status

Authenticated Authentication is done correctly.

Failure Authentication failed.

Authenticating… Authentication is in process.

Expired The digital certificate is expired. Or [DATE, TIME PRESET] is not set correctly.

Time Error The [DATE, TIME PRESET] has been cleared. Set the correct date and time.
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PROJECTOR NAME (ADVANCED menu only)

PROJECTOR NAME Set a unique projector name. Up to 16 alphanu-
meric characters and 
symbols

DOMAIN (ADVANCED menu only)
Set a host name and domain name of the projector.

HOST NAME Set a host name of the projector. Up to 15 alphanumeric 
characters

DOMAIN NAME Set a domain name of the projector. Up to 60 alphanumeric 
characters
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ALERT MAIL (ADVANCED menu only)

ALERT MAIL This option will notify your computer of lamp replace time or error 
messages via e-mail when using wireless or wired LAN. 

Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.

Sample of a message to be sent from the projector:

The lamp and filters are at the end of its usable life. Please 
replace the lamp.
Projector Name: NEC Projector
Lamp 1 Hours Used: xxxx [H]
Lamp 2 Hours Used: xxxx [H]

—

HOST NAME Type in a host name. Up to 15 alphanumeric 
characters

DOMAIN NAME Type in a domain name of the network connected to the projec-
tor.

Up to 60 alphanumeric 
characters

SENDER'S AD-
DRESS

Specify the sender’s address. Up to 60 alphanu-
meric characters and 
symbols

SMTP SERVER 
NAME

Type in the SMTP server name to be connected to the projec-
tor. 

Up to 60 alphanumeric 
characters

RECIPIENT'S AD-
DRESS 1, 2, 3

Type in your recipient’s address. Up to 60 alphanu-
meric characters and 
symbols

TEST MAIL Send a test mail to check if your settings are correct.
NOTE:
•	 If you entered an incorrect address in a test, you may not receive an 

Alert mail. Should this happen, check if the Recipient’s Address is 
correctly set.

•	 Unless any one of the [SENDER'S ADDRESS], [SMTP SERVER'S 
NAME] or [RECIPIENT'S ADDRESS 1-3] is selected, [TEST MAIL] is 
not available.

•	 Be sure to highlight [OK] and press the ENTER button before executing 
[TEST MAIL].

 

—
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NETWORK SERVICE (ADVANCED menu only)

HTTP SERVER Set a password for your HTTP server. Up to 10 alphanumeric 
characters

PJLink This option allows you to set a password when you use the 
PJLink feature.
NOTE: 
•	 Do not forget your password. However, if you forget your password, 

consult with your dealer. 
•	 What is PJLink?
	 PJLink is a standardization of protocol used for controlling projectors 

of different manufacturers. This standard protocol is established by 
Japan Business Machine and Information System Industries Associa-
tion (JBMIA) in 2005.

	 The projector supports all the commands of PJLink Class 1.
•	 Setting of PJLink will not be affected even when [RESET] is done from 

the menu.
 

Up to 32 alphanumeric 
characters

AMX Turn on or off for detection from AMX Device Discovery when 
connecting to the network supported by AMX’s NetLinx control 
system.

TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx 
control system will recognize the device and download the appropriate 
Device Discovery Module from an AMX server.

Placing a checkmark will enable detecting the projector from AMX Device 
Discovery.
Clearing a checkmark will disable detecting the projector from AMX 
Device Discovery. 

—
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TOOLS

ADMINISTRATOR MODE
This allows you to select MENU MODE, save settings, and set a password for the administrator mode.

MENU MODE Select either [BASIC] or [ADVANCED] menu.
(→ page 102)

—

NOT SAVE SETTING 
VALUES

Placing a check mark will not save your projector settings.
Clear this check box to save your projector settings.

—

NEW PASSWORD/
CONFIRM PASS-
WORD

Assign a password for the administrator mode. Up to 10 alphanumeric 
characters

NOTE:
When [LAST] is selected for [DEFAULT SOURCE SELECT], placing a check mark for [NOT SAVE SETTING VALUES] will forcibly 
select NETWORK for source at every power-on time.
To avoid this, select [AUTO] for [DEFAULT SOURCE SELECT] before placing a check mark for [NOT SAVE SETTING VALUES].

TIP:
To return to the ADVANCED menu from the BASIC menu, do the following:
1.	 Use the SOURCE button on the cabinet or press the NETWORK button on the remote control to select 

[NETWORK] to display the APPLICATION MENU.

2.	 Select [TOOLS] → [ADMINISTRATOR MODE] → [MENU MODE] → [ADVANCED MODE].
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PROGRAM TIMER

This option turns on/off the projector and changes video signals, and selects ECO mode automatically at a specified 
time.

NOTE:
•	 Before using [PROGRAM TIMER], make sure that the [DATE AND TIME] feature is set. (→ page 162)
•	 Make sure that the projector is in the stand by condition with the POWER cord connected.
•	 The projector has a built-in clock. The clock will keep working for about two weeks after the main power is turned off. If the main 

power is not supplied to the projector for two weeks or more, the built-in clock stops working.
•	 When [PROGRAM TIMER] is enabled, the [STANDBY MODE] setting becomes invalid.
	 This means that the projector is in the same condition when the [NORMAL] is selected for [STANDBY MODE].

Setting a new program timer
1.	 On the PROGRAM TIMER screen, use the ▲ or ▼ button to select [SETTINGS] and press the ENTER but-

ton.

	 The [PROGRAM LIST] screen will be displayed.

2.	 Select a blank program number and press the ENTER button.

	 The [EDIT] screen will be displayed.

3.	 Make settings for each item as required.

ACTIVE	������������������ Place a check mark to enable the program.
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DAY	������������������������ Select days of the week for the program timer. To execute the program from Monday to Friday, select [MON-
FRI].To execute the program in everyday basis, select [EVERYDAY].

TIME	���������������������� Set the time to execute the program. Enter time in 24-hour format.
FUNCTION	������������� Select a function to be executed. Selecting [POWER] will allow you to turn on or off the projector by setting 

[ADVANCED SETTINGS]. Selecting [SOURCE] will allow you to select a video source by setting [ADVANCED 
SETTINGS]. Selecting [ECO MODE] will allow you to select [ECO MODE] by setting [ADVANCED SET-
TINGS].

ADVANCED SETTINGS
	������������������������������ Select power on/off, a type of video source, or ECO MODE for the selected item in [FUNCTION].
REPEAT	������������������ Place a check mark to repeat the program continuing basis. To use the program this week only, clear the 

check mark.
4.	 Select [OK] and press the ENTER button.

	 This will complete the settings.

	 You will be returned to the [PROGRAM LIST] screen.

5.	 Select [BACK] and press the ENTER button.

	 You will be returned to the [PROGRAM TIMER] screen.

6.	 Select [OK] and press the ENTER button.

	 You will be returned to the [TOOLS] screen.

NOTE:
•	 Up to 30 different timer settings can be programmed.
•	 When [PROGRAM TIMER] is turned on, the [STANDBY MODE] setting is ignored.
•	 The Program Timer is executed on a set time basis, not in a program basis.
•	 Once the program not marked with a check in [REPEAT] has been executed, the check mark in the [ACTIVE] check box will be 

cleared automatically and the program will be disabled.
•	 When the on-time and the off-time set for the same time, the off-time setting will take preference.
•	 Two different sources are set for the same time, the larger program number will take preference. 
•	 The on-time setting will not be executed while the cooling fans are running or an error is occurring.
•	 If the off-time setting is expired under the condition in which the power off is not possible, the off-timer setting will not be executed 

until the power off becomes possible.
•	 Programs not marked with a check mark in [ACTIVE] of the [EDIT] screen will not be executed even if the Program Timer is 

enabled.
•	 When the projector is turned on by using the program timer and if you want to turn off the projector, set the off-time or do it 

manually so as not to leave the projector on for a long period of time.
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Activating the program timer

1.	 Select [ENABLE] on the [PROGRAM TIMER] screen and press the ENTER button.

	 The [ENABLE] will be activated.

2.	 Select [OK] and press the ENTER button.

	 The [PROGRAM TIMER] screen will be changed to the [TOOL] screen.

NOTE:
•	 Clearing [ENABLE] will disable the Program Timer even when a program is marked with a check mark on [PROGRAM LIST] 

screen. 
•	 When [ENABLE] is selected, the [PROGRAM LIST] cannot be edited. To edit the programs, select [ENABLE] to turn off the Program 

Timer.

Changing the programmed settings

1.	 On the [PROGRAM LIST] screen, select a program you want to edit and press the ENTER button.

2.	 Change the settings on the [EDIT] screen.

3.	 Select [OK] and press the ENTER button.

	 The programmed settings will be changed.

	 You will be returned to the [PROGRAM LIST] screen.

Changing the order of programs

1.	 On the [PROGRAM LIST] screen, select a program whose order you want to change and press the ▶ but-
ton.

2.	 Press the ▼ button to select ▲ or ▼.

3.	 Press the ENTER button a few times to select a row to which you wish to move the program.

	 The order of the programs will be changed.

Deleting the programs

1.	 On the [PROGRAM LIST] screen, select a program number you want to delete and press the ▶ button.

2.	 Press the ▼ button to select [DELETE].

3.	 Press the ENTER button.

	 The confirmation screen will be displayed.

4.	 Select [YES] and press the ENTER button.

	 The program will be deleted.

This will complete deleting the program.
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DATE AND TIME

You can set the current time, month, date, and year.
NOTE: The projector has a built-in clock. The clock will keep working for about 2 weeks after the main power is turned off. If the 
main power is off for 2 weeks or more, the built-in clock will cease. If the built-in clock ceases, set the date and time again. The 
built-in clock will not cease while in the standby mode.

TIME ZONE SETTINGS	�������������� Select your time zone.
DATE AND TIME SETTINGS	������ Set your current date (MM/DD/YYYY) and time (HH:MM). 
INTERNET TIME SERVER	��������� If you place a check mark, the projector’s built-in clock will be synchronized with an Internet 

time server in every 24 hours and at the time of projector’s startup.
UPDATE	������������������������������������ Synchronizes the projector’s built-in clock immediately. The UPDATE button is not available 

unless the INTERNET TIME SERVER check box is turned on.
SUMMER TIME SETTINGS	������� If you place a check mark, the clock for daylight saving will be enabled.

MOUSE
This option lets you to change your USB mouse settings. The mouse settings feature is available for USB mouse only. 
Choose the settings you want:

MOUSE BUTTON	���������������������� [RIGHT HAND] or [LEFT HAND]
MOUSE SENSITIVITY	��������������� [FAST], [MEDIUM] or [SLOW]
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 Mounting the Optional Lens

Five separate bayonet style lenses can be used with this projector. The descriptions here are for the NP27ZL lens. 
Mount other lenses in the same manner.

NOTE:
•	 The projector and lenses are made of precision parts. Do not subject them to shock or excessive forces.
•	 Remove the separately sold lens when moving the projector. If not, the lens could be subject to shock while the projector is being 

moved, damaging the lens and the lens shift mechanism.
•	 Turn off the power and wait for the cooling fan to stop and turn off the main power switch before mounting or removing the 

lens.
•	 When dismounting the lens from the projector, return the lens position to the home position before turning off the power. Failure to 

do so may prevent the lens from being mounted or dismounted because of narrow space between the projector and the lens.
•	 Be sure to perform [CALIBRATION] after installation or replacement of the lens. (→ page 17, 126) Calibration corrects the adjust-

able zoom and focus range.
	 The following lenses need calibration:

-	 NP26ZL, NP27ZL, NP28ZL, NP29ZL
•	 Never touch the lens surface while the projector is operating.
•	 Be very careful not to let dirt, grease, etc., on the lens surface and not to scratch the lens surface.
•	 Perform these operations on a flat surface over a piece of cloth, etc., to prevent the lens from getting scratched.
•	 When leaving the lens off the projector for long periods of time, mount the dust cap on the projector to prevent dust or dirt from 

getting inside.
•	 If you have multiple projectors, be careful of the following:

-	 The NP25FL, NP26ZL, NP27ZL, NP28ZL, and NP29ZL lenses are designed exclusively for this model of the projector. These 
lenses are not available on other projector models.

-	 The other NEC optional lenses cannot be used with this model of the projector.

Before mounting the lens:
•	 Prepare a Phillips screwdriver (plus-head)

•	 Remove the dust cap from the projector.

TIP:
•	 The projector comes with the dust cap at the time of shipment

Mounting the lens
1.	 Remove the lens shroud.

(1)	Loosen two screws.

1

Lens release 
lever

Safety lever

Lens shroud
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(2)	Make sure that the lens release lever points upward (RE-
LEASE).

(3)	Make sure that the safety lever is set to the unlocked posi-
tion (UNLOCK) to prevent the lens from falling out.

UNLOCK

LOCK

RELEASE

LOCK

LENS

2

3

2.	 Remove the lens cap on the back of the lens.

•	 The NP27ZL lens is used as an example.

NOTE: Mounting the lens with lens cap on its back to the projector can 
cause malfunction.
 

3.	 Place the guide pin in the correct orientation by aligning 
it with the notch on the lens hood, then insert the lens 
into the projector.

	 Push the lens slowly until it comes to a complete stop.

Guide pin Notch

4.	 Set the safety lever to the right position (LOCK) to lock 
the lens. LOCK

LOCK

LENS

5.	 Slowly turn the lens release lever counterclockwise until 
the lens release lever is facing downward.

•	 If the lens release lever cannot be turned, it means that 
the lens is not fully inserted.

	 Turn back the lens release lever to the unlocked position 
and push the lens into the projector until it comes to a 
complete stop. 
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6.	 Place the lens shroud back onto the lens hood. 

•	 Tighten the two screws to fix the lens shroud

NOTE :
Be sure to perform [CALIBRATION] after installation or replacement of 
the lens. (→ page 17, 126) 
 

Removing the lens

Before removing the lens:

1.	 Turn on the projector. (→ page 16)

2.	 Press and hold the SHUTTER/HOME POSITION button for a minimum of 2 seconds.

	 The lens position will return to the home position. (→ page 24)

3.	 Turn off the main power and unplug the power cord. 

4.	 Wait for the projector to cool sufficiently before removing the lens.

1.	 Remove the lens shroud. 

	 (→ page 163)

2.	 Slowly turn the lens release lever clockwise until it points 
upward.

3.	 Set the safety lever to the left position (UNLOCK).
LOCK

LOCK

LENS

4.	 Slowly remove the lens from the projector by pulling it 
straight out.

•	 After removing the lens, attach the lens cap to both the 
front and back of the lens for proper storage.

5.	 Place the lens shroud back into the lens hood. 

•	 Tighten the two screws to fix the lens shroud.

•	 If the projector is stored without the lens, attach the dust 
cover to the lens hood. 
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COMPUTER 2 IN

COMPUTER 3 IN

COMPUTER 1 IN

Computer cable (VGA) (supplied)
To mini D-Sub 15-pin connector 
on the projector. It is recommend-
ed that you use a commercially 
available distribution amplifier if 
connecting a signal cable longer 
than the cable supplied.

NOTE: For Macintosh, use a commercially available pin adapter (not 
supplied) to connect to your Mac’s video port.

RGB - to - BNC cable (not 
supplied)

 Making Connections
The projector can be connected to a computer using the computer cable, a 5 x BNC cable, HDMI cable or DisplayPort 
cable.
Prepare commercially available cables for connection.

Analog RGB signal connection

•	 Connect the computer cable between the computer’s display output connector (mini D-Sub 15-pin) and the projector’s 
Computer 1 or Computer 2 video input connector.

•	 When connecting the computer’s display output connector (mini D-Sub 15-pin) and the projector’s Computer 3 
video input connector, use a BNC cable (5-core) → mini D-Sub 15-pin converter cable.

•	 To output audio from the computer, use commercially available audio system.

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER 1 COMPUTER 1

COMPUTER 2 IN  COMPUTER 2 COMPUTER 2

COMPUTER 3 IN  COMPUTER 3 COMPUTER 3
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DisplayPort INHDMI IN

Digital RGB signal connection

•	 Connect a commercially available HDMI cable between the computer’s HDMI output connector and the projector’s 
HDMI input connector.

•	 Connect a commercially available DisplayPort cable between the computer’s DisplayPort output connector and 
the projector’s DisplayPort input connector.

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI IN  HDMI HDMI

DisplayPort IN  DisplayPort DisplayPort

NOTE:
•	 Turn off the power of the computer and projector before connecting.
•	 This projector does not support NEC video unit (model ISS-6020) video decoded outputs.
•	 When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and 

rewinding.

TIP
•	 The Computer 1 and Computer 2 video input connectors support Windows Plug and Play. The Computer 3 video input connector 

does not support Windows Plug and Play.
•	 A Macintosh signal adapter (commercially available) may be required to connect a Macintosh computer.
	 To connect a Macintosh computer equipped with a Mini DisplayPort to the projector, use a commercially available Mini DisplayPort 

→ DisplayPort converter cable.

HDMI cable (not supplied) DisplayPort cable (not supplied)
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Cautions when connecting an HDMI cable
•	 Use a certified High Speed HDMI® Cable or High Speed HDMI® Cable with Ethernet.

Cautions when connecting a DisplayPort cable
•	 Use a certified DisplayPort cable.

	

•	 Depending on the computer, some time may be required until the image is displayed.

•	 Some DisplayPort cables (commercially available) have locks.

•	 To disconnect the cable, press the button on the top of the cable’s connector, then pull the cable out.

•	 No power is supplied from the DisplayPort input connector to the connected device.

•	 When signals from a device that uses a signal converter adapter are connected to the DisplayPort input connector, 
in some cases the image may not be displayed.

•	 When the HDMI output of a computer is connected to the DisplayPort input connector, use a converter (commercially 
available).

Cautions when using a DVI signal
•	 When the computer has a DVI output connector, use a commercially available converter cable to connect the 

computer to the projector’s HDMI input connector (only digital video signals can be input). 

	 To connect the computer’s DVI output connector to the projector’s DisplayPort input connector, use a commercially 
available converter.

HDMI IN

NOTE: When Viewing a DVI Digital Signal
•	 Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 stan-

dard. The cable should be within 197"/5 m long.
•	 Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
•	 To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC.
	 Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, 

restart your PC.
•	 Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub connector may 

result in no picture being displayed from the digital output of the graphics card.
•	 Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then 

reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
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Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer 
analog image you’re projecting.

NOTE:
•	 Daisy chain connection is not possible.
•	 The signal only from the COMPUTER 1 IN connector will be output to the MONITOR OUT (COMP1) connector.
•	 When [POWER-SAVING] or [NETWORK STANDBY] is selected for [STANDBY MODE] within the on-screen menu, the signal will 

not be output to the MONITOR OUT (COMP1) connector in standby.
•	 When the signal from the COMPUTER 3 IN connectors is projected, no video signal will be output to the MONITOR OUT (COMP1) 

connector.

Computer cable (VGA) 
(supplied)

Computer cable (VGA) 
(not supplied)
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Connecting Your DVD Player or Other AV Equipment
Connecting Video/S-Video Input

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

VIDEO IN  VIDEO VIDEO

S-VIDEO IN  S-VIDEO S-VIDEO

NOTE: Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

NOTE:
•	 An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via a scan 

converter.
•	 Video signals can be projected when a video cable (commercially available) is connected to the Computer 3 video input connector’s 

G/Y connector.
	 In this case, set the on-screen menu’s SETUP → OPTION(1) → SIGNAL SELECT(COMP3) to [VIDEO] and select Computer 3 for 

the input selection.

Video cable (not supplied)

BNC (male) to RCA (female) 
adapter (not supplied)

S-Video cable (not supplied)

Audio equipment

Audio cable (not supplied)
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Connecting Component Input

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER 1 IN  COMPUTER 1 COMPUTER 1

COMPUTER 2 IN  COMPUTER 2 COMPUTER 2

COMPUTER 3 IN  COMPUTER 3 COMPUTER 3

NOTE:
•	 Normally the computer signal and component signal are identified and switched automatically. If the signal cannot be identified, 

however, select the signal at [ADJUST] → [VIDEO] → [SIGNAL TYPE] on the projector’s on-screen menu. Select “COMPUTER” or 
“VIDEO” for the Computer 3 video input connector at [SETUP] → [OPTION (1)] → [SIGNAL SELECT(COMP3)] (→ page 130).

•	 To connect to a video device with a D connector, use the sold separately D connector converter adapter (model ADP-DT1E).

15-pin - to - RCA (female) × 3 cable adapter  
(ADP-CV1E)

BNC (male) to RCA (female) 
adapter (not supplied)

Component video RCA × 3 cable (not supplied)

DVD player Audio Equipment
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Connecting HDMI Input
You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the 
HDMI IN connector of your projector.
NOTE: The HDMI IN connector supports Plug & Play (DDC2B).

Audio cable (not supplied)

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI IN  HDMI HDMI

TIP: For users of audio video equipment with an HDMI connector:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”.
This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

•	 When connecting the HDMI IN connector of the projector to the DVD player, the projector’s video level can be 
made settings in accordance with the DVD player’s video level. In the menu select [ADJUST] → [VIDEO] → [VIDEO 
LEVEL] and make necessary settings.
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Connecting to a Wired LAN
The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. 
To use a LAN connection, you are required to set the LAN on the projector menu. Select [APPLICATION MENU] → 
[NETWORK SETTINGS] → [WIRED LAN]. (→ page 143).

Example of LAN connection
Example of wired LAN connection

Server

Hub

LAN cable (not supplied)

NOTE: Use a Category 5 or higher LAN cable.
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Connecting to a Wireless LAN (sold separately)
The separately sold wireless LAN unit allows you to use a wireless LAN environment. When using the projector in a 
wireless LAN environment, the IP address and other settings must be made on the projector.

Important:
•	 If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is 

prohibited, remove the USB Wireless LAN Unit from the projector.

•	 Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.
•	 Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Flow of Setting Wireless LAN
Step 1:	 Attach the USB Wireless LAN Unit to the projector. (→ page 175)

Step 2:	 Display [NETWORK SETTINGS] from [APPLICATION MENU]. (→ page 142)

Step 3:	 Select [NETWORK SETTINGS] → [WIRELESS LAN] → [PROFILES] and set [EASY CONNECTION], 
[PROFILE 1], or [PROFILE 2]. (→ page 143)

TIP:
Access the HTTP server function to set [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS] → [EASY CONNECTION] , [PRO-
FILE1], [PROFILE2].

Mounting a wireless LAN unit

NOTE:
•	 The wireless LAN unit has a front and a back and must be mounted in the wireless LAN port in a specific direction. The port is 

designed so that the unit cannot be mounted in the opposite direction, but trying to push it in by force could damage the wireless 
LAN unit port.

•	 To prevent damage due to static electricity, touch a nearby metal object (a door knob, aluminum sash, etc.) before touching the 
wireless LAN unit to eliminate the static electricity from your body.

•	 Turn off the main power before mounting and removing the wireless LAN unit.
	 Mounting and removing the wireless LAN unit while the projector’s power is on could damage the wireless LAN unit or result in 

malfunction on the projector. If the projector should malfunction, turn off the projector’s power, turn off the main power switch, 
and unplug the power cord, then plug the power cord back in. 

•	 Do not connect any USB device other than the wireless LAN unit to the USB (LAN) port. Also, do not connect the wireless LAN 
unit to the USB port in the connector section.
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1.	 Press the  button to set the projector to the standby mode, then 
turn off the main power switch.

2.	 Remove the plate (port cover).

	 Loosen the screw security port cover.

•	 The screw is not removable.

3.	 Slowly insert the wireless LAN unit into the USB (LAN) port 
(   ).

-	 Remove the wireless LAN unit’s cap, set the unit with the front (the 
side with the indicator) facing upwards, hold the back edge and 
insert the unit gently.

	 Next, press the wireless LAN unit in with a finger.

-	 The cap you have removed will be used when the wireless LAN unit 
is removed, so store it in a safe place.

NOTE: If the wireless LAN unit is hard to insert, do not push it in by force.

4.	 Attach the anti-theft cap for wireless LAN unit.

	 Use the screw you removed at Step 2 to secure the anti-theft cap.

 

Plate

Anti-theft cap
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To remove the wireless LAN unit
1.	 Press the  button to set the projector to the standby mode, then 

turn off the main power switch.

2.	 Remove the anti-theft cap.

	 Loosen the screw and remove the anti-theft cap for the Wireless LAN 
Unit.

3.	 Pull out the Wireless LAN Unit from the USB (LAN) port.

NOTE: 
If the wireless LAN unit is not to be used for an extended period of time, put the 
plate back and secure it with the two screws.
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Example of wireless LAN connection
(Network Type → Infrastructure)
(→ page 145)

PC with wireless LAN card 
inserted

PC with built-in wireless LAN 
function

Wired LAN

Wireless access point

USB Wireless LAN Unit

To enable direct communication (i.e., peer-to-peer) between computers and projectors, you need to select the Ad 
Hoc mode. (→ page 145)

PC with wireless LAN card 
inserted

PC with built-in wireless LAN 
function

Example of wireless LAN connection (Network Type → Ad Hoc)

USB Wireless LAN Unit
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Stacking projectors
The projected image brightness can be doubled by gravity stacking up to two projectors without external support. This 
is called “Stacking Projection”.

 CAUTION:
A minimum of two persons are required to carry the projector. Otherwise the projector may tumble or drop, causing 
personal injury.

NOTE:
•	 Projectors with different model numbers cannot be gravity stacked.
	 Optional lenses with the same model numbers must be used for stacking projection.
•	 The stacking projection does not support accuracy for overlaying two images perfectly so that small text and detailed graphics 

can be clearly read or seen.
•	 Use a commercially available distribution amplifier to both the primary (upper) and the secondary (lower) projectors to distribute 

signal to two outputs of the two projectors.
•	 Notes for stacking

-	 Ask your service person for setting up and adjusting projectors.
-	 Set up the projectors in a place or structure in a way with sufficient strength to support the combined weight of the two projec-

tors. The single projector with a lens weighs up to approximately 46 kg/ 101 lbs.
-	 To prevent the projectors from falling, fasten them in a way to withstand earthquakes.
-	 Double stacking will cause room temperature to increase. Ventilate the room well.
-	 Do not attempt to stack projectors on the ceiling. Gravity stacking cannot be done on the ceiling.
-	 Warm up the projectors for one hour before the desired projection is obtained.
-	 Set up the projectors so that the projected image shows as little geometric distortions as possible. The lens is different in 

geometric distortion between wide(+) and tele (−) for zoom.
-	 Adjust the horizontal lens shift to the lens center.

 s
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Part Names and Functions of Stacking Column

Stacking column

Upper projector

To tilt the upper projector horizontally, use the lower projector’s 
horizontal adjustment knob.

Lower projector

Use the lower projector’s horizontal adjustment knob to finely tilt the 
two projectors horizontally.

Security locking pin (with a wire)
After pulling out four security locking pins, put each foot of the upper projector here, and then 
insert the four security locking pins fully so that the feet cannot move.
Each security locking pin can be inserted from either direction.

Foot holder
Place the four feet in their respective foot holder.

Horizontal adjustment knob
Finely tilt the upper projector horizontally. Turn it clockwise to orient the projector to the right; 
turn it counterclockwise to orient the projector to the left.
Maximum rotating angle: +/− 0.4°

Vertical adjustment ring
Tilt the projector vertically. Turn the vertical adjustment ring clockwise to be shortened; turn it 
counterclockwise to be extended. If you cannot turn it manually, use a hexagonal wrench. Do not 
turn the screws inside.
Up to 38 mm (1.5") can be extended.

Foot (4 locations)
Support the projector at the four locations.
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This section describes the simple maintenance procedures you should follow to clean the filters, the lens, the cabinet, 
and to replace the lamp and the filters.

 Cleaning the Filters
The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter 
is dirty or clogged, your projector may overheat.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is 
displayed, clean the filters. The time to clean the filters is set to [OFF] at time of shipment. (→ page 123)
To cancel the message, press any button on the projector cabinet or the remote control.

 CAUTION
•	 Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. 

Failure to do so can result in electric shock or burn injuries.

Preparation: Before cleaning the filters, use a vacuum cleaner to clean the ventilations (inlet).
Two filters are attached on the left side and the front side. Clean both filters. Both filters have the same shape.
When replacing the filters, buy the optional filter NP03FT in advance.

Filter cover

Inlet
(The filter is inside)

Filter cover

Inlet
(The filter is inside.)

Cleaning the filter on the left side

1.	 Remove the filter cover.

(1)	Loosen each of the two knobs by turning them counter-
clockwise.

	 • �The knobs are not removable.

	 • �If the knob is too tight to turn, use a Phillips screw-
driver.

(2)	Remove the filter cover by sliding it to the left and pulling 
it out.

1
2

Filter cover

Notch

Knob

7. Maintenance
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2.	 Remove the filter.

	 Pull the top of the filter outward and remove the filter by lifting 
it up.

Filter

3.	 Use a vacuum cleaner to vacuum all the dust from the 
inside of the filter.

	 Get rid of dust in the accordion filter.

•	 Remove the dust inside the filter cover and the inlet of the 
projector as well. 

NOTE:
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in damage to 

the filter membrane and also cause clogging.
 

 
4.	 Put the filter back into place.

	 Insert the filter with “↓ AIR FLOW ↓” facing the projector.

(1)	�Insert the filter in the flange.

(2)	�Fit the top edge of the filter in the inlet.

1

2

Flange

5.	 Place the filter cover back onto the projector cabinet.

(1)	�Insert the guide pin (4 locations) of the projector into the 
notch (4 locations) of the filter cover.

Notch

Guide pin
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(2)	�Slide the filter cover to the right and tighten each of the 
two knobs by turning them clockwise. 

NOTE:
Be sure to clean both filters (left and front sides) to display the filter 
usage hours as accurate as possible.
 

Cleaning the filter on the front side

1.	 Remove the filter cover.

(1)	Loosen each of the two knobs by turning them counter-
clockwise.

	 • �The knobs are not removable.

	 • �If the knob is too tight to turn, use a Phillips screw-
driver.

(2)	Remove the filter cover by pulling it out.

1

2

Knob

2.	 Remove the filter.

	 Remove the filter by pulling it to the right.

Filter

3.	 Use a vacuum cleaner to vacuum all the dust from the 
inside of the filter.

	 Get rid of dust in the accordion filter.

NOTE:
•	 Whenever you vacuum the filter, use the soft brush attachment to 

vacuum. This is to avoid damage to the filter.
•	 Do not wash the filter with water. Doing so can result in damage to 

the filter membrane and also cause clogging.
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4.	 Put the filter back into place.

	 Insert the filter with “↓ AIR FLOW ↓” facing the projector.

(1)	�Insert the filter in the inlet.

(2)	�Fit the top edge of the filter in the inlet.

Filter

5.	 Place the filter cover back into the projector cabinet.

(1)	�Align the knob (screw) with the screw hole.

(2)	�Tighten each of the two knobs by turning it clockwise.

1

2

Screw hole

Filter cover

6.	 Clear the filter usage hours.

	 Plug the power cord into the wall outlet, turn on the main 
power switch, and then turn on the projector.

	 From the menu, select [RESET] → [CLEAR FILTER HOURS] 
and reset the filter usage hours. (→ page 139)
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2 Cleaning the Lens
•	 Turn off the projector before cleaning.
•	 Use a blower or lens paper to clean the lens, and be careful not to scratch or mar the lens. 

3 Cleaning the Cabinet
Turn off the projector, and unplug the projector before cleaning.
•	 Use a dry soft cloth to wipe dust off the cabinet.

	 If heavily soiled, use a mild detergent. 

•	 Never use strong detergents or solvents such as alcohol or thinner. 

•	 When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum 
cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

•	 Clogged ventilation slits may cause a rise in the internal temperature of the projector, resulting in malfunction.

•	 Do not scratch or hit the cabinet with your fingers or any hard objects

•	 Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product 
in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off. 
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4 Replacing the Lamp and the Filters
When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE LAMP 
HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP 1 (or 2). USE THE SPECIFIED 
LAMP FOR SAFETY AND PERFORMANCE.” will appear (*). Even though the lamp may still be working, replace the 
lamp to maintain the optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. 
(→ page 138)

 CAUTION
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector 

off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

•	 Use the specified lamp for safety and performance.

•	 DO NOT REMOVE ANY SCREWS except two (2) lamp cover screw and three (3) lamp housing screws. You could 
receive an electric shock.

•	 Do not break the glass on the lamp housing.

	 Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause 
an unwanted shadow and poor picture quality.

•	 The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours 
after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use 
the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered 
in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC 
dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
•	 for one minute after the projector has been powered on
•	 when the  (POWER) button on the projector cabinet or the POWER OFF button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:

•	 Phillips screwdriver (plus-head)

•	 Replacement lamp:  
NP22LP

Flow of Replacing the Lamp and the Filters
The following procedure is an example for replacing both lamps.

Step 1.	 Replace the lamp 

Step 2.	 Replace the filters (→ page 188)

Step 3.	 Clear the lamp usage hours and the filter usage hours (→ page 138, 139)
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To replace the lamp: 
1.	 Remove the lamp cover.

(1)	Loosen the two lamp cover screws.

	 • The lamp cover screw is not removable.

(2)	Pull the lamp cover towards you and remove it.

2.	 Remove the lamp housing.

(1)	Loosen the three screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condi-
tion.

	 • The three screws are not removable.

	 • �Do not touch the exhaust fan power connectors.

(2)	Remove the lamp housing by holding it.

 CAUTION:
Make sure that the lamp housing is cool enough to handle before removing it.

Exhaust fan power 
connector

Handle
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3.	 Install a new lamp housing.

(1)	Insert a new lamp housing until the lamp housing is plugged into the socket. 

(2)	Secure it in place with the three screws.

	 • Be sure to tighten the screws.

NOTE:
•	 Be sure to install both Lamp 1 and Lamp 2. The projector will not turn on unless both the lamps are installed.

Alignment hole Guide pin

4.	 Reattach the lamp cover.

(1)	Align the left side of the lamp cover with the left side of the lamp housing and reattach the lamp cover. While 
doing so, place the wire inside the lamp compartment so as not to get it caught under the lamp cover.

(2)	Tighten the two screws to secure the lamp cover.

	 • Be sure to tighten the screws.

Wire

This completes the lamp replacement.
Go on to the filter replacement.

NOTE: When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, both LAMP 1 
and LAMP 2 indicators will light red and the projector cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out. When only one lamp is replaced, select [RESET] from the 
menu to reset the lamp hour used. Do not press the HELP button.
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 Replacing the Filters
It is recommended that the filters are cleaned after every 5000 hours of use and replaced after every 10000 hours of 
use. These hours can vary depending on your usage environment.
There are two filters, one located at the front of the projector and one on the side.
Optional filters (two filter) are available.
Small one for the front
Large one for the left side

NOTE:
•	 Replace both filters with the new ones at the same time.
•	 Before replacing the filters, use a vacuum cleaner to vacuum dust and dirt from the vents (inlet) of the projector and use a dry 

soft cloth to wipe dust off the cabinet.
•	 The projector contains high-precision parts. Keep out dust and dirt during filter replacement.
•	 Do not wash the filter with water. Water will damage the filter membrane.
•	 Attach the filter in the correct orientation. Failure to do so may cause dust and dirt to enter inside the projector, resulting in projec-

tor malfunction.

Filter cover

Inlet
(The filter is inside)

Filter cover

Inlet
(The filter is inside.)

Replacing the filter on the left side

1.	 Remove the filter cover.

(1)	Loosen each of the two knobs by turning them counter-
clockwise.

	 • �The knobs are not removable.

	 • �If the knob is too tight to turn, use a Phillips screw-
driver.

(2)	Remove the filter cover by sliding it to the left and pulling 
it out.

1
2

Filter cover

Notch

Knob
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2.	 Remove the filter.

	 Pull the top of the filter outward and remove the filter by lifting 
it up.

Filter

3.	 Install the new filter.

	 Insert the filter with “↓ AIR FLOW ↓” facing the projector.

(1)	�Insert the filter in the flange.

(2)	�Fit the top edge of the filter in the inlet.

1

2

Flange

4.	 Place the filter cover back onto the projector cabinet.

(1)	�Insert the guide pin (4 locations) of the projector into the 
notch (4 locations) of the filter cover.

Notch

Guide pin

(2)	�Slide the filter cover to the right and tighten each of the 
two knobs by turning them clockwise. 

NOTE:
Be sure to clean both filters (left and front sides) to display the filter 
usage hours as accurate as possible.
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Replacing the filter on the front side

1.	 Remove the filter cover.

(1)	Loosen each of the two knobs by turning them counter-
clockwise.

	 • �The knobs are not removable.

	 • �If the knob is too tight to turn, use a Phillips screw-
driver.

(2)	Remove the filter cover by pulling it out.

1

2

Knob

2.	 Remove the filter.

	 Remove the filter by pulling it to the right.

Filter

3.	 Install the new filter.

	 Insert the filter with “↓ AIR FLOW ↓” facing the projector.

(1)	�Insert the filter in the inlet.

(2)	�Fit the top edge of the filter in the inlet.

Filter

4.	 Place the filter cover back into the projector cabinet.

(1)	�Align the knob (screw) with the screw hole.

(2)	�Tighten each of the two knobs by turning it clockwise.

1

2

Screw hole

Filter cover

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.
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To clear the lamp usage hours and the filter usage hours:
1.	 Place the projector where you use it.

2.	 Plug the power cord into the wall outlet, and then turn on the projector.

3.	 Clear the lamp usage hours and the filter usage hours.

1.	 From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours. (→ page 138)

2.	 Select [CLEAR FILTER HOURS] and reset the filter usage hours. (→ page 139)
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 Installing Software Program

Installation for Windows software
The software programs except Image Express Utility 2 for Mac support Windows 7, Windows Vista, and Windows 
XP.

1.	 Download the updated software program from our web site (http://www.nec-display.com/dl/en/index.
html)

NOTE:
•	 To install or uninstall each software program, the Windows user account must have “Administrator” privilege (Windows 7, Win-

dows Vista) or “Computer Administrator” privilege (Windows XP).
•	 Exit all running programs before installation. If another program is running, the installation may not be completed.
•	 To run Virtual Remote Tool or PC Control Utility Pro 4 on Windows XP Home Edition and Windows XP Professional, “Microsoft 

.NET Framework Version 2.0 or later” is required. The Microsoft .NET Framework Version 2.0 or later is available from Microsoft’s 
web page. Download and install it on your computer

 
1.	 Connect your computer to the internet and visit our website (http://www.nec-display.com/dl/en/index.

html).

2.	 Download the supported software programs from “Download” and save an “.exe” file to your computer.

	 File name is different depending on the version of the software program.

3.	 Click the “.exe” file.

	 The installation will start.

	 Follow the instructions on the installer screens to complete the installation.

TIP:

Uninstalling a Software Program
Preparation:
Exit the software program before uninstalling. To uninstall the software program, the Windows user account must have 
“Administrator” privilege (Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 7/Windows Vista
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Click “Uninstall a program” under “Programs”

	 The “Programs and Features” window will be displayed.

3	 Select the software program and click it.

4	 Click “Uninstall/Change” or “Uninstall”.

	 • When the “User Account Control” windows is displayed, click “Continue”.

	 Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Double-click “Add / Remove Programs”.

	 The Add / Remove Programs window will be displayed.

3	 Click the software program from the list and then click “Remove”.

	 Follow the instructions on the screens to complete the uninstallation.
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Installation for Macintosh software
Image Express Utility 2 for Mac supports Mac OS X.

1.	 Connect your Macintosh computer to the internet and visit our website (http://www.nec-display.com/dl/en/
index.html).

2.	 Download “Image Express Utility 2 for Mac OS(Intel)” or “Image Express Utility 2 for Mac OS(PowerPC)” 
from “Download” and save an “.exe” file to your computer. 

	 File name is different depending on the version of the software program.

3.	 Move the “Image Express Utility 2” folder to “Applications” folder using a drag-and-drop operation. 

TIP:

• Uninstalling a software program
1.	 Put the “Image Express Utility 2” folder to the Trash icon.

2.	 Put the configuration file of Image Express Utility 2 to the Trash icon.

•	 The configuration file of Image Express Utility 2 is located in “/user/your user name/library/Preferences/jp.co.
nec.nevt. ImageExpressUtility.plist”.
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 Projecting Images or Videos from the Projector over a LAN 
(Image Express Utility 2.0)

What you can do with Image Express Utility 2.0

•	 Using Image Express Utility 2.0 allows you to send the screens of your computers to the projector via wired/wire-
less LAN.

	 The projected images can be sent from a computer to not only one projector but also to two or more projectors at 
the same time.

	 When “Meeting Mode” is used, projected images can be sent and received between two or more computers.

•	 High-speed, high-quality image transmissions based on NEC’s original compression algorithm

	 NEC’s original compression algorithm allows high-quality images to be sent over the network at high speed, from 
your computer to the projector.

•	 Simultaneous projection by multiple projectors

	 Images can be sent from a computer to not only one projector but also to two or more projectors at the same 
time.

•	 “Easy Connection” function for connecting wireless LAN

	 By using “Easy Connection” function*1, the complicated setting of wireless LAN can be simplified.

*1	 This function can be used when Windows XP is used as the OS and when you have a “Computer Adminis-
trator” privilege. If the OS is Windows 7/Windows Vista, input of logon password as “Administrator” may be 
prompted. 
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•	 Projected images can be transferred and saved to computers.

	 When “Meeting Mode” is used, projected images can be sent to the computers of all the participants (attendants) 
of a “Meeting”. The received images can be saved to your computer with a memo (text data) attached.

Presenter

Attendant

Attendant

Attendant

•	 1-click switching of presenter

	 When switching to another presenter during the conference, the participants (attendants) can simply click a button 
to switch over to the new presenter.

•	 Central management of the projecting computer

	 Using the Training Mode allows you to use a single computer (Manager) to manage which computer (Attendant) 
projects. Possible operation includes switching projecting computers to project from, as well as temporarily termi-
nating communication with the projector.

Mr. D, please start your 
presentation.

Manager

Attendant CAttendant B

Attendant D
(presenter)

Attendant A

NOTE:
The Training Mode is not installed via the “Typical” installation option when Image Express Utility 2.0 is installed.
To use Training Mode, select “Extension” installation option on the install selection screen that is displayed while Image Express 
Utility 2.0 installation is in progress, and select “Training Mode (Attendant)” or “Training Mode (Manager)”.

Connecting the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 173), “Con-
necting to a Wireless LAN” (→ page 174) and “9 Application Menus - NETWORK SETTINGS” (→ page 142)
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Basic Operation of Image Express Utility 2.0
This section explains the following three cases as examples of operating Image Express Utility 2.0.

(1)	Transferring images to the projector

(2)	Holding a conference

(3)	Participating in a conference

Sending Images to Projector
• Connecting projector
1	 Turn on the power to the projector for which LAN has been set.

2	 Click Windows [Start] → [All Programs] → [NEC Projector User Supportware] → [Image Express Utility 2.0] 
→ [Image Express Utility 2.0 ], in that order.

	 The “Selection Of Network Connections” window will be displayed.

	 A list of the network equipment connected to your computer will be displayed.

IMPORTANT:
A screen like the one below is displayed when the software is started on a PC installed with Windows XP Service Pack 2 (SP2) (or 
later).
Click “Unblock” if this is displayed. 

3	 Select the network equipment that is to be used and click [OK].

	 Select the network device displaying “Easy Connection” if the product LAN setting is for “Easy Connection.” This 
will call up the “Projector List” window.
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4	 Check( ) the projector to connect and click [Connect].

	 If the name of the projector to connect is not on the list or if it is hidden, click [Update].

4-1

4-2

Click

Click

	 The screen of your computer will be projected from the projector.

	 At this time, the input signal of the projector will automatically change to “NETWORK”.

NOTE:
•	 When the projector is found, “1280 × 800” will be displayed in the resolution field.

• Transferring images
When your computer is connected to the projector, the screen of the computer is projected from the projector as is. To 
make your presentation by using a PowerPoint file, open the PowerPoint file and start your presentation.
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• Stopping or resuming the transmission of images
The transmission of the screen of the computer to the projector can be temporarily stopped and then resumed.

1	 Click the projector icon ( ) on the Windows taskbar.

	 A pop-up menu will be displayed.

2	 Click [Stop Sending].

	 The projector icon on the taskbar will change (  → ).

NOTE:
Even if the screen of the computer is changed in this status, the image projected from the projector does not change.
To manipulate the screen that should not be disclosed (projected from the projector), stop transmission.

3	 Click the projector icon ( ) on the Windows taskbar.

	 A pop-up menu will be displayed.

4	 Click [Start Sending].

	 The projector icon on the taskbar will change (  → ).

	 The transmission of the screen for the computer will be resumed, and the current screen of the computer will be 
projected from the projector.

• End the transmission of images
Exit Image Express Utility 2.0.

1	 Click the projector icon ( ) on the Windows taskbar.

	 A pop-up menu will be displayed.

2	 Click [Exit].
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Holding Conferences
• Holding conferences
1	 Follow steps 1 through 4 in “Connecting projector” of “Sending Images to Projector” (→ page 196).

	 The screen of your computer will be projected from the projector.

• Disclose a file to the participants of the conference.

NOTE:
To disclose a file to the participants, selection can be made only in folder units.
Therefore, a folder only having files that can be disclosed to the participants must be created in advance.

1	 Click the projector icon ( ) on the Windows taskbar.

	 A pop-up menu will be displayed.

2	 Before clicking [Send to PC and Projector], check that there is a “ • ” mark applied.

3	 Click the [Image Express Utility 2.0] button on the taskbar.

	 The presenter window will be opened.

4	 Click [Select Folder].

4 Click
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5	 Select a folder saving the file to be disclosed to the participants, and click [OK].

	 The file in the selected folder will be displayed in the list of files to transfer.

6	 Click [Download].

	 The file will be shown to the participants.

NOTE:
When the computer is connected to the projector, the computer screen that is in of being progress is also projected from the projec-
tor. To manipulate a screen that should not be shown (not projected), temporarily stop the transmission (→ page 198).

• Ending conference
1	 Click [File] in the presenter window, and click [Exit].

	 You can also end the conference by clicking [×] at the upper right of the presenter window.

Participating in Conference
• Participating in conferences
1	 Click Windows [Start] → [All Programs] → [NEC Projector User Supportware] → [Image Express Utility 2.0] 

→ [Image Express Utility 2.0 ], in that order.

	 The “Selection Of Network Connections” window will be displayed.

	 A list of the network equipment connected to your computer will be displayed.

IMPORTANT:
A screen like the one below is displayed when the software is started on a PC installed with Windows XP Service Pack 2 (SP2) (or 
later).
Click “Unblock” if this is displayed. 

2	 Select the network equipment that is to be used and click [OK].

	 Select the network device displaying “Easy Connection” if the product LAN setting is for “Easy Connection.” This 
will call up the “ Meeting List” window.



201

8. User Supportware

3	 Click the Meeting Name to participate, and click [Connect].

3 Click

	 The computer will be connected to the selected conference and the attendant window will be displayed.

	 If the presenter selects “Send to PC And Projector”, the image projected from the projector is displayed in the at-
tendant window.
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• Saving received images
1	 Click [Memo] in the attendant window.

	 A memo pane will be displayed.

2

1

Click

Memo pane

Click

2	 Click [Save Image] in the attendant window.

	 The image displayed in the attendant window will be saved.

•	 The saved image is added to the memo list and a thumbnail is displayed.

•	 A memo can be attached to the saved image.

REFERENCE:
•	 In case of Windows XP, a created file is saved to “My Documents\ImageExpress\” under the default settings. In case of Windows 

7/Windows Vista, “Document\ImageExpress\” is the default folder to save a created file.
•	 A folder is created below the default folder based on the time and date of the conference, and the image is saved to a file in the 

created folder.
	 For example, if a conference is held at 11:20 on May 14, 2009, the default folder name on Windows XP will be “My Documents\

ImageExpress\2009-05-14_11-20_Meeting Records”. 
	 In this folder, an HTML file named “Meeting Records” is created.
	 The saved image is saved in “Images” folder.
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• Downloading disclosed file
1	 Click [File Transfer] in the attendant window.

	 The “File Transfer” window will be opened.

1 Click

2	 Select a file to download, and click [Download].

	 Downloading will begin.

	 The progress of the downloading is displayed at the lower left of the window.

3	 When downloading is complete, click [File] in the “File Transfer” window, and click [Exit].

	 The “File Transfer” window will be closed.

REFERENCE:
•	 If “Open After Downloading” is checked, the file is opened by specified Windows application software after downloading is com-

plete.
•	 In case of Windows XP, a created file is saved to “My Documents\ImageExpress\” under the default settings. In case of Windows 

7/Windows Vista, “Document\ImageExpress\” is the default folder to save a created file. 
•	 A folder is created below the default folder based on the time and date of the conference, and the image is saved to a file in the 

created folder.
	 For example, if a conference is held at 11:20 on May 14, 2009, the default folder name on Windows XP will be “My Documents\

ImageExpress\2009-05-14_11-20_Meeting Records”. 
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• Changing presenter
Three types of settings may be made to change the presenter: “Not Approved”, “Approved”, and “Changing Prohibited” 
(these can be selected only by the presenter).
In the following example, “Not Approved” is selected.
•	 Click [Become A Presenter] in the attendant window.

	 You will change from a participant to a presenter.

1 Click

• Leaving conference
Leave the conference and exit Image Express Utility 2.0.
•	 Click [File] in the attendant window, and click [Exit].

	 You can also leave the conference by clicking [×] at the upper right of the attendant window.
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 Controlling the Projector over a LAN (PC Control Utility Pro 4)
Using the utility software “PC Control Utility Pro 4”, the projector can be controlled from a computer over a LAN.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4. For information on how to use PC 
Control Utility Pro 4, see Help of PC Control Utility Pro 4.

TIP:
•	 PC Control Utility Pro 4 can be used with a serial connection.

Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 173), “Con-
necting to a Wireless LAN (sold separately)” (→ page 174) and “9 Application Menus - NETWORK SETTINGS” (→ 
page 142)

Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4”.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/

sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the 
scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer 
to sleep” → “Never”. 
NOTE: 
•	 When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network 

(wired LAN/wireless LAN) connection.
	 When [NETWORK STANDBY] is selected for [STANDBY MODE], the projector cannot be turned on via wireless LAN connection.

TIP:

Viewing the Help of PC Control Utility Pro 4
•	 Displaying the Help file of PC Control Utility Pro 4 while it is running.

	 Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

	 The pop-up menu will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4 Help”.

	 The Help screen will be displayed.
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 Projecting Your Mac’s Screen Image from the Projector over 
a LAN (Image Express Utility 2 for Mac)

Using Image Express Utility 2 for Mac contained allows you to send the Mac’s screen image to the projector over a 
network (wired or wireless LAN).
Image Express Utility 2 for Mac runs on Mac OS X 10.2.8 or later.
It runs on both Mac OS X (PowerPC) and Mac OS X (Intel).
Hereafter, “Image Express Utility 2 for Mac” is abbreviated as “Image Express Utility 2”.

What you can do with Image Express Utility 2

•	 Via the network images on the screen of your Mac can be sent to the projector and projected on the screen.

•	 One computer can send images to more than one projector.

Operating environment

Supported OS
Mac OS X 10.2.8 or later required
Mac OS X 10.3.0 or later recommended

Processor (CPU)
PowerPC G3 600 MHz processor required
PowerPC G4 800 MHz or higher recommended
or
Intel Core Solo 1.5 GHz or higher required

Memory
256 MB or higher required

Network environment
Wired or wireless LAN required that supports TCP/IP
Only the AirPort and AirPort Extreme wireless LAN cards are guaranteed to work with Image Express Utility 2.
“Easy Connection” supports only AirPort and AirPort Extreme.

Supported resolution
VGA (640 × 480) or higher required
XGA (1024 × 768) recommended
(1024 × 768 - 1280 × 800 recommended)

Supported screen colors
32 thousands of colors, 16.7 million colors required
* 256 or fewer colors are not supported.

Connecting the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 173), “Con-
necting to a Wireless LAN” (→ page 174) and “9 Application Menus - NETWORK SETTINGS” (→ page 142)
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Using Image Express Utility 2

Connecting to a projector
1	 Confirm that the projector has been turned on.

2	 Click the AirPort status (  ) on the Macintosh menu bar, and click “Turn AirPort On”.

	 The AirPort status is changed to “  ” or “  ”.

•	 AirPort status types and meanings

	 ...AirPort : Off

	 ...AirPort : On ( in infrastructure connection )

	 ...AirPort : On ( in adhoc connection )

REFERENCE:

When the AirPort status (  /  /  ) is not displayed on the menu bar:
1	 Click Apple Menu (  ) and [System Preferences...]. 

	 The “System Preferences” window will be displayed.

2	 Click [Network].

	 The Network configuration window will be displayed.

3	 Select [AirPort] in [Show].

4	 Click [AirPort] tab.

	 The AirPort configuration item will be displayed.

5	 Check the “Show AirPort status in menu bar” check box at the bottom configuration item.

	 The AirPort status (  /  /  ) will be displayed on the menu bar. 

6	 Click the [  ] button at the upper left on the Network configuration window.

	 The Network configuration window will be closed.
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3	 Double-click the “Image Express Utility 2” icon in the “Image Express Utility 2” folder.

•	 At the initial start, the “License Agreement” window is displayed. 

	 Thoroughly read the agreement shown on the screen, and click “I accept the terms in the license agreement” 
and the [OK] button.

	 Next, the “Authenticate” window will be displayed.

4	 Enter the administrator name and password of your Macintosh computer, and click the [OK] button.

	 The [Projector Selection] window will be displayed.

5	 Check the (  ) check box to the left of the projector name to connect and click [Connect].

	 The Macintosh computer and the projector are connected via wireless LAN, and images on the Macintosh screen 
are projected from the projector.
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Stopping/Restarting Image Transmission
• Stopping image transmission
1	 Click [Tools] on the menu bar, and click [Stop Sending].

	 Image transmission is temporarily stopped.

• Restarting image transmission
1	 Click [Tools] on the menu bar, and click [Start Sending].

	 Image transmission is started again.

Exiting Image Express Utility 2
1	 Click [Image Express Utility 2] on the menu bar, and click [Quit Image Express Utility 2].

	 Image Express Utility 2 is exited.
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 Operating the Projector Via the LAN (Virtual Remote Tool)
Using the software program “Virtual Remote Tool” that you can download from our web site, Virtual Remote screen 
(or toolbar) can be displayed on your computer screen.
This will help you perform operations such as projector’s power on or off and signal selection via a LAN connection. It 
is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you 
can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, Logo transfer to the projector, and remote control op-
eration on your PC.

Virtual Remote screen

Remote Control Window Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 212)

NOTE:
•	 Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:

-	 File size: 256 KB or less 
-	 Image size (resolution): the native resolution of the projector
-	 File format: JPEG

•	 The logo data that is sent with Virtual Remote Tool will be displayed at the center of the screen. Its surrounding will be painted 
out in black.

•	 Once you have changed the background selection from the default “NEC logo” to another selection, you cannot return the logo to 
the default “NEC logo” even after using [RESET]. To put the default “NEC logo” back in the background logo, you need to register 
it as the background logo by using the image file (\Logo\NEC_logo_black_WUXGA.jpg) included on the supplied NEC Projector 
CD-ROM.

TIP:
•	 Virtual Remote Tool can be used also with a serial connection.
•	 To download or update Virtual Remote Tool, visit our website: http://www.nec-display.com/dl/en/index.html

Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 173), “Con-
necting to a Wireless LAN (sold separately)” (→ page 174) and “9 Application Menus - NETWORK SETTINGS” (→ 
page 142)
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Start Virtual Remote Tool

Start using the shortcut icon
•	 Double-click the shortcut icon  on the Windows Desktop.

Start from the Start menu
•	 Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] 

→ [Virtual Remote Tool].

	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

	 The “Easy Setup” feature is not available on this model. Click “Close Easy Setup”.

	 Closing the “Easy Setup” window will display the “Projector List” window.

	 Select your projector you wish to connect. This will display the Virtual Remote screen.

TIP:
•	 The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
	 To do so, click to place a check mark for “  Do not use Easy Setup next time” on the screen.

NOTE:
•	 When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network 

(wired LAN/wireless LAN) connection. When [NETWORK STANDBY] is selected for [STANDBY MODE], the projector cannot be 
turned on via wireless LAN connection.
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Exiting Virtual Remote Tool
1	 Click the Virtual Remote Tool icon  on the Taskbar.

	 The pop-up menu will be displayed.

2	 Click “Exit”.

	 The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool
• Displaying the help file using the taskbar
1	 Click the Virtual Remote Tool icon  on the taskbar when Virtual Remote Tool is running.

	 The pop-up menu will be displayed.

2.	 Click “Help”.

	 The Help screen will be displayed.

• Displaying the help file using the Start Menu.
1.	 Click “Start”. “All programs” or “Programs”. “NEC Projector User Supportware”. “Virtual Remote Tool”. and 

then “Virtual Remote Tool Help” in this order.

	 The Help screen will be displayed.
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 Converting PowerPoint files to Slides (Viewer PPT Converter 
3.0)

Using Viewer PPT Converter 3.0 allows you to convert PowerPoint files into JPEG files. Converted JPEG files and 
Index files (.idx) can be saved to a USB memory. When the USB memory inserted into the projector, these JPEG files 
and Index files (.idx) can be displayed with the viewer function of the projector without connecting a computer.

NOTE:
When Viewer PPT Converter 3.0 has been installed, once start Viewer PPT Converter 3.0 once with the privilege used for installation. 
Then exit from Viewer PPT Converter 3.0 without doing anything.
• Starting
Click Window’s [Start] → [All Programs] → [NEC Projector User Supportware] → [Viewer PPT Converter 3.0] → [Viewer PPT 
Converter 3.0], in that order.

NOTE:
•	 When installing Viewer PPT Converter 3.0 onto a computer that has PowerPoint installed, Viewer PPT Converter 3.0 is automati-

cally registered as a Power-Point add-in.
It is necessary to cancel Viewer PPT Converter 3.0 add-in before uninstalling Viewer PPT Converter 3.0.
Refer to Viewer PPT Converter 3.0 Help to unregister the add-in.

•	 The projector does not support the add-in's “Run Slide Show”.

Converting PowerPoint files and saving them to a USB memory
1.	 Insert the USB memory into the USB port of the computer.

2.	 On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Viewer PPT Converter 
3.0” → “Viewer PPT Converter 3.0”.

	 Viewer PPT Converter 3.0 will start.

3.	 Click “Brows...” and select a PowerPoint file you wish to convert, and then click “Open”.

4. 	Click “Next”.
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5.	 Select the USB memory drive for “Card Drive” and type in “Index name”.

	 Index name must be eight alphanumeric characters or less. 2-byte character and file with a long filename cannot 
be used.

6.	 Click “Export”.

	 A confirmation message will be displayed.

7.	 Click “OK”.

	 Exporting a file will start.

8.	 Click “OK”.

9.	 Click “Exit”.

	 Viewer PPT Converter 3.0 will exit.

10. Remove the USB memory from the computer.

NOTE:
•	 Before removing the USB memory from the USB port of the computer, click the “Safe to Remove Hardware” icon on the task-

bar.
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 Throw distance and screen size
Five separate bayonet style lenses can be used on this projector. Refer to the information on this page and use a 
lens suited for the installation environment (screen size and throw distance). For instructions on mounting the lens, 
see page 163.
Each number provided in the table below means the throw distance between the lens surface and the screen.

Lens types and throw distance
unit = m

Screen size Lens model name
NP25FL NP26ZL NP27ZL NP28ZL NP29ZL

80" 1.1  —  —  —  — 
100" 1.4 2.9 – 4.0 4.0 – 5.5 9.0 12.0 – 15.0
120" 1.7 3.5 – 4.8 4.8 – 6.6 9.0 – 10.8 12.0 – 18.0
150" 2.2 4.4 – 6.0 6.0 – 8.2 9.0 – 13.5 13.5 – 22.4
200" 3.0 5.9 – 8.0 8.0 – 11.0 11.1 – 17.9 17.9 – 29.8
240" — 7.1 – 9.6 9.6 – 13.2 13.3 – 21.4 21.4 – 35.7
300" — 8.9 – 12.0 12.1 – 16.6 16.5 – 26.8 26.7 – 44.5
400" — 11.9 – 16.1 16.1 – 22.1 22.0 – 35.6 35.5 – 59.3
500" — 14.9 – 20.1 20.2 – 24.0 27.4 – 44.5 44.3 – 74.0

TIP
•	 Calculation of the throw distance from the screen size
	 NP25FL lens throw distance (m) = H × 0.67 : 1.1 m (min.) to 3.2 m (max.) 
	 NP26ZL lens throw distance (m) = H × 1.35 to H × 1.84 : 2.8 m (min.) to 24.0 m (max.) 
	 NP27ZL lens throw distance (m) = H × 1.84 to H × 2.54 : 4.0 m (min.) to 24.0 m (max.) 
	 NP28ZL lens throw distance (m) = H × 2.62 to H × 4.20 : 9.0 m (min.) to 45.0 m (max.) 
	 NP29ZL lens throw distance (m) = H × 4.21 to H × 6.96 : 12.0 m (min.) to 80.0 m (max.) 
	 “H” (Horizontal) refers to the screen width.
	 * Figures differ by several % with the table above because the calculation is approximate.
	 Ex.: Throw distance when projecting on a 150" screen using the NP27ZL lens:
	 According to the “Screen Size (for reference)” table (→ page 217), H (screen width) = 323.1 cm.
	 The throw distance is 323.1 cm × 1.7 to 323.1 cm × 2.3 = 549.3 cm to 743.13 cm (because of the zoom lens).
•	 Using the NP28ZL lens will slightly change the image size. When using the NP28ZL lens to adjust the image size, adjust the focus 

and then the zoom.
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Projection range for the different lenses

80-200" 100-500"

100-500" 100-500" 100-500"

NP25FL : 1.1–3.2 m

NP26ZL : 2.8–24.0 m

NP27ZL : 4.0–24.0 m

NP28ZL : 9.0–45.0 m

NP29ZL : 12.0–80.0 m
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Tables of screen sizes and dimensions

Screen 
height

Screen width

16:10 screen size  
(diagonal)

Size (inches) Screen width Screen height

(inches) (cm) (inches) (cm)

50 42.4 107.7 26.5 67.3
60 50.9 129.2 31.8 80.8
80 67.8 172.3 42.4 107.7

100 84.8 215.4 53.0 134.6
120 101.8 258.5 63.6 161.5
150 127.2 323.1 79.5 201.9
200 169.6 430.8 106.0 269.2
240 203.5 516.9 127.2 323.1
300 254.4 646.2 159.0 403.9
350 296.8 753.9 185.5 471.2
400 339.2 861.6 212.0 538.5
450 381.6 969.3 238.5 605.8
500 424.0 1077.0 265.0 673.1
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Lens shifting range
This projector is equipped with a lens shift function for adjusting the position of the projected image by using the LENS 
SHIFT ▼▲◀▶ buttons. The lens can be shifted within the range shown below.
Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the 
projected image).

NOTE: The lens shift function cannot be used when the NP25FL lens is used.

Desk/front projection

1V

1H0.2H 0.2H

0.55V

0.4V

Height of projected image

Width of projected image

Ceiling/front projector

1V

1H0.2H 0.2H

0.55V

0.4V

Height of projected image

Width of projected image

Ex.: When projecting on a 150" screen
According to the tables of screen sizes and dimensions for 16:10 (→ page 217), H = 323.1 cm, V = 201.9 cm.
Adjustment range in the vertical direction: The projected image can be moved upwards 0.55 × 201.9 cm ≈ 111 cm, 
(when the lens is at the center position). For a ceiling/front installation, the above figures are inverted.
Adjustment range in the horizontal direction: The projected image can be moved to the left 0.2 × 323.1 cm ≈ 64.6 cm, 
to the right 0.2 × 323.1 cm ≈ 64.6 cm.
* Figures differ by several % because the calculation is approximate.
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❷ Mounting the Optional Board (sold separately)
CAUTION
Before mounting or removing the optional board, be sure to turn off the projector, wait for the fans to stop and turn 
off the main power switch.

Tool needed: Phillips screwdriver (plus-head)
The SB-01HC board is used as an example.
1.	 Turn off the main power switch of the projector.

2.	 Loosen the two screws on the slot cover of the terminal panel.

	 Remove the two screws and the slot cover.

NOTE: Keep the two screws and the slot cover.

3.	 Insert the optional board into the slot.

	 Make sure that the board is inserted into the slot in the correct orientation.

	 Incorrect orientation may cause miscommunication between the optional board and projector.
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4.	 Tighten the two screws on both sides of the slot.

•	 Be sure to tighten the screws.

	 This will complete installation of the optional board.

	 Refer to the user’s manual included with the board for source selection.

NOTE:
•	 Mounting the optional board may cause the fans to run in the standby mode for the purpose of cooling depending on the optional 

board. The fan speed may also increase in order to cool the projector properly. Both of these instances are considered normal 
and not a malfunction of the projector.
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 Compatible Input Signal List
Analog RGB

Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )
VGA 640 × 480 4 : 3 60/72/75/85/iMac
SVGA 800 × 600 4 : 3 56/60/72/75/85/iMac
XGA 1024 × 768 4 : 3 60/70/75/85/iMac
XGA+ 1152 × 864 4 : 3 60/70/75/85
WXGA 1280 × 768 15 : 9 60

1280 × 800 16 : 10 60
1360 × 768 *1 16 : 9 60
1366 × 768 *1 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60/75/85
SXGA 1280 × 1024 5 : 4 60/75/85
SXGA+ 1400 × 1050 4 : 3 60/75
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
UXGA 1600 × 1200 4 : 3 60/65/70/75
WSXGA+ 1680 × 1050 16 : 10 60
WUXGA 1920 × 1200 16 : 10 60 (Reduced Blanking)
HD 1280 × 720 16 : 9 60
Full HD 1920 × 1080 16 : 9 60
MAC 13" 640 × 480 4 : 3 67
MAC 16" 832 × 624 4 : 3 75
MAC 19" 1024 × 768 4 : 3 75
MAC 21" 1152 × 870 *2 4 : 3 75
MAC 23" 1280 × 1024 5 : 4 65

HDMI

Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )
VGA 640 × 480 4 : 3 60
SVGA 800 × 600 4 : 3 60
XGA 1024 × 768 4 : 3 60
HD 1280 × 720 16 : 9 60
WXGA 1280 × 768 15 : 9 60

1280 × 800 16 : 10 60
1366 × 768 *1 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60
SXGA 1280 × 1024 5 : 4 60
SXGA+ 1400 × 1050 4 : 3 60
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
WSXGA+ 1680 × 1050 16 : 10 60
UXGA 1600 × 1200 4 : 3 60
Full HD 1920 × 1080 16 : 9 60
WUXGA 1920 × 1200 16 : 10 60 (Reduced Blanking)
HDTV(1080p) 1920 × 1080 16 : 9 50/60
HDTV(1080i) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480p) 720 × 480 4:3 / 16:9 60
SDTV (576p) 720 × 576 4:3 / 16:9 50
SDTV(480i) 1440 × 480 4:3 / 16:9 60
SDTV(576i) 1440 × 576 4:3 / 16:9 50
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DisplayPort

Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )
VGA 640 × 480 4 : 3 60
SVGA 800 × 600 4 : 3 60
XGA 1024 × 768 4 : 3 60
HD 1280 × 720 16 : 9 60
WXGA 1280 × 768 15 : 9 60

1280 × 800 16 : 10 60
1366 × 768 *1 16 : 9 60

Quad-VGA 1280 × 960 4 : 3 60
SXGA 1280 × 1024 5 : 4 60
SXGA+ 1400 × 1050 4 : 3 60
WXGA+ 1440 × 900 16 : 10 60
WXGA++ 1600 × 900 16 : 9 60
WSXGA+ 1680 × 1050 16 : 10 60
UXGA 1600 × 1200 4 : 3 60
Full HD 1920 × 1080 16 : 9 60
WUXGA 1920 × 1200 16 : 10 60 (Reduced Blanking)
HDTV(1080p) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480p) 720 × 480 4:3 / 16:9 60
SDTV (576p) 720 × 576 4:3 / 16:9 50

Component

Signal Resolution ( dots ) Aspect Ratio Refresh Rate ( Hz )
HDTV(1080p) 1920 × 1080 16 : 9 50/60
HDTV(1080i) 1920 × 1080 16 : 9 50/60
HDTV (720p) 1280 × 720 16 : 9 50/60
SDTV (480p) 720 × 480 4:3 / 16:9 60
SDTV (576p) 720 × 576 4:3 / 16:9 50
SDTV(480i) 720 × 480 4:3 / 16:9 60
SDTV(576i) 720 × 576 4:3 / 16:9 50

Composite Video/S-Video

Signal Aspect Ratio Refresh Rate ( Hz )
NTSC 4 : 3 60
PAL 4 : 3 50
PAL60 4 : 3 60
SECAM 4 : 3 50

*1	The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].
*2	The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [4:3] for [ASPECT RATIO].

•	 Signals exceeding the projector’s resolution are handled with scaling technology.

•	 With scaling technology, the size of characters and ruled lines may be uneven and colors may be blurred.

•	 Upon shipment, the projector is set for signals with standard display resolutions and frequencies, but adjustments 
may be required depending on the type of computer.
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 Specifications
This section provides technical information about projector’s performance.

Optical

Model Name PH1000U
Projection System DMD™ 0.96" × 3 (aspect 16:10)
Resolution*1 1920 × 1200 pixels (WUXGA)
Lens Option (see page 225)

NP25FL
NP26ZL
NP27ZL
NP28ZL
NP29ZL

Power Lens Shift
(NP26ZL, NP27ZL, NP28ZL, NP29ZL)

−0.4V to +0.55V, +/−0.2H

Lamp 400W AC (320W in ECO)
Light Output*2 *3 11000 lumens

ECO: 75%
Contrast Ratio*3

(full white: full black)
2000:1 with DYNAMIC CONTRAST ON

Image Size (Diagonal) 100 - 500" (depending on the lens → page 216)
80 - 200" on NP25FL

Projection Distance (Min.-Max.) (depending on the lens → page 215)

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

Electrical

Model Name PH1000U
Inputs 2 × RGB/Component (mini D-Sub 15P), 5 × BNC, 

1 × HDMI Type A (HDMI® Connector) HDCP supported*4,
1 × DisplayPort (20pin connecter) HDCP supported*4,
1 × S-Video (DIN 4P), 1 × Video (BNC)
1 × Option Slot

Outputs 1 × RGB (D-Sub 15P)
PC Control 1 × PC Control Port (D-Sub 9P)
Wired Remote 1 × Stereo mini Jack
Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)
Wireless LAN Port (Optional) IEEE 802.11 b/g/n (optional Wireless LAN Unit [NP02LM Series] required)
USB Port 1 × Type A
Color Reproduction 10-bit signal processing (1.07 billion colors) (VIEWER, NETWORK: Colors, 16.7 million 

colors)
Compatible Signals*5 Analog: VGA/SVGA/XGA/XGA+/WXGA/WXGA+/SXGA/SXGA+/UXGA/WUXGA/480i/480

p/576i/576p/720p/1080i/1080p
HDMI: VGA/SVGA/XGA/WXGA/SXGA/SXGA+/UXGA/WUXGA/480p/576p/720p/1080i/10
80p (Refresh rate: 60 Hz only)

Video Bandwidth RGB: 165 MHz (Max.)
Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60

300 TV lines: SECAM
Scan Rate Horizontal: 15 kHz to 108 kHz (RGB: 24 kHz or over)

Vertical: 48 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)
Sync Compatibility Separate Sync / Composite Sync / Sync on Green
Power Requirement 100-240V AC, 50/60 Hz
Input Current 11.2 A (100-130V), 5.4 A (200-240V)
Power Con-
sumption

ECO MODE OFF Dual lamp: 1100W (100V)/1050W(240V)
Single lamp: 600W (100V)/580W(240V)

ECO MODE ON Dual lamp: 880W (100V)/840W(240V)
Single lamp: 500W (100V)/490W(240V)

STANDBY (NORMAL) 90W
NETWORK STANDBY 60W
STANDBY (POWER-
SAVING)

0.5W
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*4	 HDMI® (Deep Color)/DisplayPort with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system 

for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).
	 If you are unable to view material via the HDMI and DisplayPort input, this does not necessarily mean the projector is not function-

ing properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might 
not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

*5	 An image with higher or lower resolution than the projector’s native resolution (1920 × 1200) will be displayed with scaling tech-
nology.

Mechanical

Model Name PH1000U
Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 22.0" (W) × 22.8" (H) × 9.3" (D) /558 mm (W) × 578 mm (H) × 235 mm (D)
(not including protrusions)

Weight 87.1 lbs/39.5 kg (without lens)
Environmental
Considerations

Operational Temperatures: 32° to 104°F (0° to 40°C) *6,
20% to 80% humidity (non-condensing) at sea level
Storage Temperatures: 14° to 122°F (−10° to 60°C),
20% to 80% humidity (non-condensing)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class A requirements
Meets FCC Class A requirements
Meets AS/NZS CISPR.22 Class A
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TUV GS Approved)

*6	 95 to 104°F (35 to 40ºC) - “Forced eco mode”

For additional information visit:
US : http://www.necdisplay.com/
Europe : http://www.nec-display-solutions.com/
Global : http://www.nec-display.com/global/index.html
For information on our optional accessories, visit our website or see our brochure.
The specifications are subject to change without notice.
 

http://www.necdisplay.com/
http://www.nec-display-solutions.com/
http://www.nec-display.com/global/index.html
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Option lens

NP25FL Manual focus
throw ratio 0.67:1, F1.85, f=11.2 mm
Image Size (Diagonal): 80 – 200 inches / 1.27 – 5.08 m
Projection Distance(Min.-Max.): 1.1 – 3.0 m

NP26ZL Power zoom and focus
throw ratio 1.39-1.87:1, F1.85-2.5, f=18.7-26.5 mm
Image Size (Diagonal): 100 – 500 inches / 1.27 – 7.62 m
Projection Distance(Min.-Max.): 2.9 – 20.1 m

NP27ZL Power zoom and focus
throw ratio 1.87-2.56:1, F1.64-1.86, f=25.7-33.7 mm
Image Size (Diagonal): 100 – 500 inches / 1.27 – 7.62 m
Projection Distance(Min.-Max.): 4.0 – 24.0 m

NP28ZL Power zoom and focus
throw ratio 2.56-4.16:1, F1.86-2.48, f=32.91-54.23 mm
Image Size (Diagonal): 100 – 500 inches / 1.27 – 7.62 m
Projection Distance(Min.-Max.): 9.0 – 44.5 m

NP29ZL Power zoom and focus
throw ratio 4.16-6.96:1, F1.85-2.41, f=52.8-79.1 mm
Image Size (Diagonal): 100 – 500 inches / 1.27 – 7.62 m
Projection Distance(Min.-Max.): 12.0 – 74.0 m

•	 These specifications and the product’s design are subject to change without notice.

Power Cord
If the supplied power cord cannot be used or in your area the voltage condition is different from the supplied power 
cord, use power cords that are suitable for the electrical specifications, types of power cords and regulations of the 
country of installation, as shown in the following table as shown below. For more information, contact your dealer.
Power Cord Electrical Specifications 

Power supply Power cord electrical specs
AC 100 - 130V 125V 15A or higher 

250V 16A or higher
AC 200 - 240V 250V 16A or higher

Type of power cord

plug

connector

cord

Plug and cord
Your plug must comply with your country’s safety requirements and your outlet type.
Connector
Dimensions of the connector of the power cord are shown below

7+0.5
−0

13±0.2

20 min2.5+0.5
−0

8±0.2

2.5+0.5
−0 R3.5 min

6.0+0.5
−0

28+0
−0.9 20+0

−0.7

Unit: mm
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 Cabinet Dimensions

Lens center

Lens center

Unit: mm (inch)
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 Pin Assignments of D-Sub COMPUTER Input Connector
Mini D-Sub 15 Pin Connector

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

51 42 3
10

11 12 13 14 15
6 97 8

Pin No. RGB Signal (Analog) YCbCr Signal
1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 No Connection
10 Sync Signal Ground
11 No Connection
12 Bi-directional DATA (SDA)
13 Horizontal Sync or Composite 

Sync
14 Vertical Sync
15 Data Clock
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 Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.

Indicator Messages

POWER Indicator

Indicator display Projector status Procedure
Off Power is off. –
Flashing Blue (short flashes) Preparing to turn power on Wait a while.

Blue (long flashes) Off timer (enabled)
Program timer (off time enabled)

–

Orange (short flashes) Projector cooling Wait a while.
Orange (long flashes) Program timer (on time enabled)

Lit Blue Power on –
Orange Standby mode (NORMAL or NETWORK 

STANDBY)
–

Red Standby mode (POWER-SAVING) –

STATUS Indicator

Indicator display Projector status Procedure
Off No problem, or standby 

mode (POWER-SAVING 
or NETWORK STANDBY)

–

Flashing Red (cycles of 1) Cover problem The lamp cover is not properly mounted. Mount it properly. (→ Page 
187)

Red (cycles of 4) Fan problem The cooling fan has stopped turning. Contact an NEC projector cus-
tomer support center for repairs.

Flashing Orange Network conflict It is not possible to connect the projector’s built-in LAN and wireless 
LAN simultaneously to the same network. To connect the projector’s 
built-in LAN and wireless LAN simultaneously, connect them to differ-
ent networks.

Lit Green Standby mode (NOR-
MAL)

–

Orange Button has been pressed 
while projector is in key 
lock mode

The projector’s keys are locked. The setting must be canceled to oper-
ate the projector. (→ Page 127)

Projector’s ID number 
and remote control’s ID 
number do not match

Check the control IDs. (→ Pages 127 and 128)

LAMP 1/LAMP 2 Indicator

Indicator display Projector status Procedure
Off The lamp is turned off. –
Flashing Green Preparing to relight lamp after 

lighting has failed
Wait a while.

Red Lamp replacement grace period The lamp has reached the end of its service life and is now in 
the replacement grace period (100 hours). Replace the lamp 
as soon as possible. (→ page 185)

Red (cycles of 6) Lamp does not light The lamp has not turned on. Wait at least 1 minute, then turn 
the power back on. If the lamp still does not light, contact an 
NEC projector customer support center.

Lit Red Lamp usage time exceeded The lamp has exceeded its usage time. The projector’s power 
cannot be turned on until the lamp is replaced. (→ page 185)

Green Lamp lit –
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Temp. Indicator

Indicator display Projector status Procedure
Off No problem
Flashing Red Temperature problem The temperature protector has been activated. If the room 

temperature is high, move the projector to a cool place. If the 
TEMP. indicator still be flashing when the projector is used at 
operating temperatures, contact an NEC projector customer 
support center.

Orange Warming up The usage environment temperature is lower than the 
projector’s operating temperature (0°C). In that case, raise 
the usage environment temperature to a 0°C or higher and 
turn on the projector. If the projector is turned on at around 
0°C, it may take 5 minutes to warm up the projector. During 
this warm-up period the TEMP. indicator will flash. When the 
warm-up is completed, the TEMP. indicator will go off.

SHUTTER Indicator

Indicator display Projector status Procedure
Off Light –
Flashing Green Lens calibration is in process. –
On Green Light shuttered –

If the temperature protector is activated
If the projector’s internal temperature rises abnormally, the lamp turns off and the temperature indicator flashes 
(repeatedly in cycles of 2).
It may happen that the projector’s temperature protector is simultaneously activated and the projector’s power turns 
off.
If this happens, do the following:

-	 Unplug the power cord from the power outlet.

-	 If using in a place where the surrounding temperature is high, move the projector to a different, cool place.

-	 If there is dust in the ventilation holes, clean. (→ pages 180 and 184)

-	 Wait as such about 1 hour for the projector’s internal temperature to lower.
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Common Problems & Solutions
(→ “Power/Status/Lamp Indicator” on page 228.)

Problem Check These Items

Does not turn on or 
shut down

•	 Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control 
is on. (→ pages 13, 14, 17)

•	 Ensure that the lamp cover is installed correctly. (→ page 187)
•	 Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room 

where you are presenting is particularly warm, move the projector to a cooler location.
•	 Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its 

life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 138)
•	 The lamp may fail to light. Wait a full minute and then turn on the power again.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters 

or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH 
ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple 
minutes and turn on the projector. (→ page 129)

	 If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for 
some time and then the projector will display the image. Wait for a moment.

Will turn off •	 Ensure that the [OFF TIMER], [AUTO POWER OFF] or [PROGRAM TIMER] is off. (→ page 121, 132, 159)

No picture •	 Check if the appropriate input is selected. (→ page 20) If there is still no picture, press the SOURCE button or one 
of the input buttons again.

•	 Ensure your cables are connected properly.
•	 Use menus to adjust the brightness and contrast. (→ page 111)
•	 Ensure that the lens cover is open. (→ page 16)
•	 Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 138)
•	 Enter your registered keyword if the Security function is enabled. (→ page 45)
•	 If the HDMI input or the DisplayPort signal cannot be displayed, try the following.

-	 Reinstall your driver for the graphics card built in your computer, or use the updated driver.
	 For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics 

card, or contact the support center for your computer manufacturer.
	 Install the updated driver or OS on your own responsibility.
	 We are not liable for any trouble and failure caused by this installation.

•	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 
the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 
being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver 

or power management software.
•	 See also the page 232.

Picture suddenly 
becomes dark

•	 Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, 
lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 129)

Color tone or hue is 
unusual

•	 Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 119)
•	 Adjust [HUE] in [PICTURE]. (→ page 111)

Image isn’t square to 
the screen

•	 Reposition the projector to improve its angle to the screen. (→ page 21)
•	 Use the Keystone correction function to correct the trapezoid distortion. (→ page 28)

Picture is blurred •	 Adjust the focus. (→ page 26)
•	 Reposition the projector to improve its angle to the screen. (→ page 21)
•	 Ensure that the distance between the projector and screen is within the adjustment range of the lens. 

(→ page 215)
•	 Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 218)
•	 Is the lens inserted until it comes to a complete stop? (→ page 163)
•	 Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. 

Should this happen, let the projector stand until there is no condensation on the lens.

Flicker appears on 
screen

•	 Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 
feet/1600 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1600 meters and 
setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to 
[AUTO]. (→ page 129)
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Image is scrolling 
vertically, horizontally 
or both

•	 Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported 
by the projector. (→ page 221)

•	 Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 113)

Remote control does 
not work

•	 Install new batteries.(→ page 9)
•	 Make sure there are no obstacles between you and the projector.
•	 Stand within 22 feet (7 m) of the projector. (→ page 9)
•	 To perform computer mouse operations using the projector’s remote control, connect the optional mouse receiver 

to the computer. (→ page 38)

Indicator is lit or 
blinking

•	 See the POWER/STATUS/LAMP Indicator. (→ page 228)

Cross color in RGB 
mode

•	 Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 30)
•	 Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 112)

For more information contact your dealer.



232

9. Appendix

If there is no picture, or the picture is not displayed correctly.

•	 Power on process for the projector and the PC.

	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 
the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 
being powered up.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, 
this means there is no signal being output from the computer. (→ page 135 or go to next step)

•	 Enabling the computer’s external display.

	 Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. 
When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usu-
ally, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

•	 Non-standard signal output from the computer

	 If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed 
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each 
notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. 
Refer to your computer’s documentation for detailed information.

•	 Image displayed is incorrect when using a Macintosh

	 When using a Macintosh with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) 
according to your resolution. After setting, restart your Macintosh for the changes to take affect.

	 For setting display modes other than those supported by your Macintosh and the projector, changing the DIP switch 
on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch 
to the 13" fixed mode and then restart your Macintosh. After that, restore the DIP switches to a displayable mode 
and then restart the Macintosh again.

NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub 
15-pin connector.

•	 Mirroring on a PowerBook

*	 When using the projector with a Macintosh PowerBook, output may not be set to 1024 × 768 unless “mirroring” 
is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

•	 Folders or icons are hidden on the Macintosh screen

	 Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple 
menu and arrange icons.
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 PC Control Codes and Cable Connection
PC Control Codes

Function	 Code Data

POWER ON	 02H	 00H	 00H	 00H	 00H	 02H

POWER OFF	 02H	 01H	 00H	 00H	 00H	 03H

INPUT SELECT COMPUTER 1	 02H	 03H	 00H	 00H	 02H	 01H	 01H	 09H

INPUT SELECT COMPUTER 2	 02H	 03H	 00H	 00H	 02H	 01H	 02H	 0AH

INPUT SELECT COMPUTER 3	 02H	 03H	 00H	 00H	 02H	 01H	 03H	 0BH

INPUT SELECT HDMI	 02H	 03H	 00H	 00H	 02H	 01H	 1AH	 22H

INPUT SELECT DisplayPort	 02H	 03H	 00H	 00H	 02H	 01H	 1BH	 23H

INPUT SELECT VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 06H	 0EH

INPUT SELECT S-VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 0BH	 13H

INPUT SELECT VIEWER	 02H	 03H	 00H	 00H	 02H	 01H	 1FH	 27H

INPUT SELECT NETWORK	 02H	 03H	 00H	 00H	 02H	 01H	 20H	 28H

PICTURE MUTE ON	 02H	 10H	 00H	 00H	 00H	 12H

PICTURE MUTE OFF	 02H	 11H	 00H	 00H	 00H	 13H

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection
Communication Protocol

Baud rate	�����������������������������������������38400 bps
Data length	��������������������������������������8 bits
Parity	�����������������������������������������������No parity
Stop bit	��������������������������������������������One bit
X on/off	��������������������������������������������None
Communications procedure..............Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (D-SUB 9P)

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.

1 52 43

6 7 98

To GND of PC

To RxD of PC

To TxD of PC

To RTS of PC

To CTS of PC
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No image is displayed from your PC or video equipment to the 
projector.

Still no image even though you connect the projector to the PC 
first, then start the PC.
Enabling your notebook PC’s signal output to the projector.
•	 A combination of function keys will enable/disable the exter-

nal display. Usually, the combination of the “Fn” key along 
with one of the 12 function keys turns the external display 
on or off. 

No image (blue or black background, no display).
Still no image even though you press the AUTO ADJUST 
button.
Still no image even though you carry out [RESET] in the 
projector’s menu.
Signal cable’s plug is fully inserted into the input connector
A message appears on the screen.
( _____________________________________________ )
The source connected to the projector is active and available.
Still no image even though you adjust the brightness and/or 
the contrast.
Input source’s resolution and frequency are supported by the 
projector.

 Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by 
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem 
more efficiently.
* Print this page and the next page for your check.

Frequency of occurrence   always   sometimes (How often?_____________________)   other (__________________)
Power

No power (POWER indicator does not light blue)  See also “Status 
Indicator (STATUS)”.

Power cord’s plug is fully inserted into the wall outlet.
Main power switch is pressed to the ON position.
Lamp cover is installed correctly.
Lamp Hours Used (lamp operation hours) was cleared after 
lamp replacement.
No power even though you press and hold the POWER button 
for 1 second.

Shut down during operation.
Power cord’s plug is fully inserted into the wall outlet.
Lamp cover is installed correctly.
[AUTO POWER OFF] is turned off (only models with the [AUTO 
POWER OFF] function).
[OFF TIMER] is turned off (only models with the [OFF TIMER] 
function).

Video and Audio

Image is too dark.
Remains unchanged even though you adjust the brightness 
and/or the contrast.

Image is distorted.
Image appears to be trapezoidal (unchanged even though you 
carry out the [KEYSTONE] adjustment).

Parts of the image are lost.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.

Image is shifted in the vertical or horizontal direction.
Horizontal and vertical positions are correctly adjusted on a 
computer signal.
Input source’s resolution and frequency are supported by the 
projector.
Some pixels are lost.

Image is flickering.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.
Image shows flickering or color drift on a computer signal.
Still unchanged even though you change [FAN MODE] from 
[HIGH ALTITUDE] to [AUTO].

Image appears blurry or out of focus.
Still unchanged even though you checked the signal’s resolution 
on PC and changed it to projector’s native resolution.
Still unchanged even though you adjusted the focus.

Other
Remote control does not work.

No obstacles between the sensor of the projector and the 
remote control.
Projector is placed near a fluorescent light that can disturb the 
infrared remote controls.
Batteries are new and are not reversed in installation. 

Buttons on the projector cabinet do not work (only models with the 
[CONTROL PANEL LOCK] function)

[CONTROL PANEL LOCK] is not turned on or is disabled in 
the menu.
Still unchanged even though you press and hold the EXIT button 
for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Eco Mode:	  OFF   ON
Information on input signal:

Horizontal synch frequency	 [      ] kHz
Vertical synch frequency	 [      ] Hz
Synch polarity	 H  (+)   (−)
	 V  (+)   (−)
Synch type	  Separate   Composite

	  Sync on Green
STATUS Indicator:

Steady light	  Orange   Green
Flashing light	 [      ] cycles

Remote control model number:

Signal cable

NEC standard or other manufacturer’s cable?
Model number:            Length:        inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Projector PC

DVD player

Installation environment

Screen size:			   inch
Screen type:	  White matte   Beads   Polarization
	  Wide angle   High contrast
 Throw distance:		  feet/inch/m
 Orientation:	  Ceiling mount   Desktop
Power outlet connection:

	 Connected directly to wall outlet
	 Connected to power cord extender or other (the 

number of connected equipment______________)
	 Connected to a power cord reel or other (the number 

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC  / Desktop 

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:
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9. Appendix

 REGISTER YOUR PROJECTOR! (for residents in the United 
States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare 
service program.
Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form 
online.
Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable 
warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.



© NEC Display Solutions, Ltd. 2011–2012 7N951663
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